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Chapter 1

Introducing the Munsys Management Console User Manual

Introduction

The Munsys Management Console is a standalone application that allows users with relevant
privileges to manipulate objects and components within a Munsys schema in a structured and
user-friendly way.

The Munsys Management Console can be activated by any authorized database user, but the
functionality that will be available to a user is dependent on the roles that have been assigned
to the user.

The following components can be managed from the Munsys Management Console:

The Munsys Schema — creating, dropping, exporting, importing and validating a schema
(including importing demo data).

Applications — used to manage Munsys application settings

Locks — used to maintain record/object locking

Query Categories — used to maintain query categories and query privileges

Security — used to manage users and roles

Privilege — used to assign roles to tables and views

Tables/Views — maintenance of Munsys-related spatial tables, lookup tables and indexes

Lineage — used primarily to implement triggers in the Oracle database to track and archive
changes made to records in spatial tables

Scheduled Tasks — Used to manage and optimize Scheduled Tasks



What’s in this manual

The Munsys Management Console User Manual consists of the following chapters:

Chapter 1 — Welcome to the Munsys Management Console User Manual gives an overview of this
manual, and provides the typographical conventions used throughout the Munsys documentation
set.

Chapter 2 — Getting acquainted with the Munsys Management Console gives an overview of the
concepts of the application.

Chapter 3 — Managing the Munsys Schema discusses the various schema management options in
the Munsys Management console.

Chapter 4 — Import Demo Data shows the administrator how to add modify or delete Munsys demo
data within the Munsys Management Console.

Chapter 5 — Working With Munsys Applications shows the administrator how to add modify or
delete Application settings within the Munsys Management Console.

Chapter 6 — Record locking describes record locking management in the Munsys Management
Console.

Chapter 7 — Query Categories describes the concept of query categories and query category
management in the Munsys Management Console.

Chapter 8 — Security in the Munsys Management Console describes the creation and maintenance
of database users and roles.

Chapter 9 — Privilege describes the maintenance of all Munsys spatial and lookup tables, as well as
indexing.

Chapter 10 — Working With tables and indexes describes the maintenance of all Munsys spatial,
lookup and attribute tables as well as indexing,.

Chapter 11 — Munsys Lineage describes the creation and maintenance of lineage.

Chapter 12 — Scheduled Tasks describes the creation and maintenance of database scheduled tasks.

Conventions in this manual

The following table lists the typographical conventions used in this manual.

Text element ‘ Example

Keys you press on the keyboard CTRL, ENTER, DEL

Screen buttons Click Close.

Folder paths C:\Program Files\Open Spatial
Menu paths choose File > Validate Schema.
Hypertext links to more information http://www.openspatial.com

Dialog box/screen names The New Query Category dialog box
Application functions The Validate Schema function

Table 1 Munsys typographical conventions
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Finding the information you need
To get help on

general issues, select Help from the Munsys Management Console menu bar.
an operation in progress, click the Help button on the dialog box.

the latest support options, visit http://www.openspatial.com

Introducing the Munsys Management Console User Manual


http://www.openspatial.com

Chapter 2

I?ﬁ:tting acquainted with the Munsys Management Console

Introduction

This chapter provides an introduction to the Munsys Management Console interface, as well
as the way that the Console is structured. You will also be shown how to start the Munsys
Management console and connect to the database.



Munsys Management Console structure

The Munsys Management Console consists of a window divided into two panes: the Tree Pane
and the Content Pane.

The left pane (the tree pane) shows the main components supported by the MMC.

File  Action Help

ﬁ Munsys Management Console (MCITY14INT)

E Applications
Locks

5 Query Categories

s Security

Privilege

TablesNViews
\.__} Scheduled Tasks

Lineage

4@5 General Settings
{8 CFS - Cable Fiber
2-fgl CMS - Cadastral
7-{38 CRS - Cable Route
7-{38 DMS - Drainage
o-ggl EMS - Blectricity

o-;gl QRY - Query

7-{3# RMS - Roads
j—-ﬁ' SDM - Spatial Data Manager
0-pgl SMS - Sewer
-3l WMS - Water

[
[
£
B
[
-8 MBK - Map Books
[
£
B
[
[

Figure 1 Munsys Management Console: Tree Pane

The Munsys Management Console content pane contains the following components:
Applications
Locks
Query Categories
Security
Privilege
Tables/Views
Lineage

Scheduled tasks

Getting acquainted with the Munsys Management Console



The right pane (the content pane) contains the content of the function that has been selected
in the tree pane.

Bl Munsys Management Console (MCITY14INT) - O X

File Action  Help

@ Applications =25 <«<Lineage Queres=> s
-3 Locks - G=| MUNSYS_ADMIN
- Query Categories MUNSYS_ALL_EDIT
3 Query Categ _ALL
.8 Categories -5=| MUNSYS_ALL_QUERY Contents of the
B Queries =| MUNSYS_POWER selected function
| Roles MUNSYS_SDM_EDIT
-y Securty MUNSYS_SDM_QUERY
b2y Priviege <¢lncategorized Queres s
- TablesNiews MUMNSYS_ADMIN
- Lineage

MUMNSYS_ALL_EDIT
43 Scheduled Tasks

= MUNSYS_ALL_QUERY
MUNSYS_POWER
MUNSYS_SDM_EDIT
-G MUNSYS_SDM_QUERY
[=-%= Cable Fibers
G| MUNSYS_ADMIN
G| MUNSYS_CFS_EDIT
MUNSYS_CF5S_QUERY
- G| MUNSYS_POWER
[=1-85 Cabls Routes

G| MUNSYS_ADMIN

-G=| MUNSYS_ALL_EDIT
MUNSYS_ALL_QUERY
MUNSYS_CRS_EDIT
MUNSYS_CRS_QUERY
--G=l MUNSYS POWER N

Figure 2 Munsys Management Console: Content Pane

Both the content pane and the tree pane allow context-sensitive menus to be activated on
selected items.
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File Action  Help

ﬁ Munsys Management Console (MCITY14INT)

@ Applications
-0 Locks
25 Query Categories
Sy Categories
B Queries
G4=| Roles
i Security

y, Privilege

Tables Views

il Lineage

‘9 Scheduled Tasks

=35 <«lineage Queres>>

=[ MUNSYS_ADMIN
MUNSYS_ALL_EDIT
MUNSYS_ALL QUERY
MUNSYS_POWER
-G MUNSYS_SOM_EDIT
--G=) MUNSYS_SOM_QUERY
<<lncategorized Queries>s

Collapse All
Expand All

=| MUNSYS_SDI_GUERT

-85 Cable Fibers

----- = MUNSYS_ADMIN
MUNSYS_CFS_EDIT
MUNSYS_CFS_QUERY
=| MUNSYS_POWER

[=-85 Cable Routes

----- 52| MUNSYS_ADMIN
-z MUNSYS_ALL_EDIT
MUNSYS_ALL_QUERY
--g=| MUNSYS_CRS_EDIT
--g=| MUNSYS_CRS_QUERY

----- 4=l MUNSYS POWER

Context-sensitive
(right-click) menu

Figure 3 Munsys Management Console: Context-sensitive menu

The same items that appear on the context-sensitive menu will also appear on the main
menu under the Action menu. The Action menu is therefore not static, but varies according
to the context-sensitive items related to the function that has been selected.

13 Scheduled Tasks

MUNSYS_ALL_EDIT

=| MUNSYS_ALL_QUERY
MUNSYS_POWER
MUNSYS_SDM_EDIT

=| MUNSY5_SDM_QUERY
[=-85 Cable Fibers

----- G=| MUNSYS_ADMIN
MUNSYS_CFS_EDIT
MUNSYS_CFS_QUERY
=| MUNSYS_POWER
-85 Cable Routes

&=| MUNSYS_ADMIN
MUNSYS_ALL_EDIT

----- MUNSYS_ALL_GQUERY

Figure 4 Munsys Management Console: Action menu

Bl Munsys Management Console (MCITY14INT) - O X

Refresh -85 <«<lineage Queries:>

MUNSYS_ADMIN
Rename MUNSYS_ALL_EDIT
Delete =| MUNSYS_ALL_QUERY

MUNSYS_POWER
Collapse All MUNSYS_SDM_EDIT
Expand Al MUNSYS_SDM_QUERY

= ncategorized Queries>>

Privileges MUNSYS_ADMIN

Getting acquainted with the Munsys Management Console




»  The File menu contains the functionality that is used to maintain and manipulate the
database and schema. Some functionality may be disabled depending on your login
authentication.

H Munsys Management Console (I

File Action  Help

New Schema...

Drop Schema...
Export Schema...

Validate Schema...
Schema Data Models..,

Schema Properties...
Import Demo Data...

Disconnect

Change Password...

Exit

Figure 5 Munsys Management Console: File menu

Logging in to the Munsys Management Console

To start the Munsys Management Console, do the following:

1 Choose Start > Programs > Open Spatial > Munsys 14.2 > Munsys Management Console 14.2

2 or Double-click the Munsys Management Console 14.2 icon on the Windows desktop.

Munsys
Management
Consaleld.2

The Connect to Database dialog box is displayed.

A Connect to Database X

UserMName: || |

Password: | |

Schema: | |

Database: | |

Figure 6 The Connect to Database dialog box
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3  Enter the following information:

User Name and Password (users who are working with an Oracle 11g version database or
higher should note that the user name and password are case sensitive)

Schema

Database

User Name: [MCITYTAINT |

FPassword:

[r— |

Schema: [MCITYT4INT |

Database: |DFH:L |

Ok Cancel Help

Figure 7 The Connect to Database dialog box

Tip Use the Disconnect menu item on the File menu to change schema, database and user information if you
are already logged in to Munsys Management Console and you want to log in with different credentials.

4 Ifyoulog in to the Munsys Management Console without specifying a schema name, only limited
functionality will be available on the File menu, and none of the other functionality will be available.
This is normally the case when you want to create a new schema.

Note The opening position of the Munsys Management Console application window is recorded in the registry
settings. The screen position, height and width parameters, as well as the with of the content pane, are
applied when opening the application.

Changing your password

1 You can change the password used to connect to the Munsys Management Console with the
File > Change Password menu item.

Change Password *
Specify your new logon credentials below, when you are done,
click OK.

User Name: [MCITY14INT
Old Password: |

|
|
New Paszswaord: | |
Confirm Password: | |

| Cancel | | Help |

Figure 8 The Change Password dialog box

2 Change the password as required, and then click OK.

Getting acquainted with the Munsys Management Console



Chapter 3

Schema management

Introduction

Using the Munsys Management Console, the database administrator can perform the

following schema management functions:

create a new schema

drop an existing schema

export a schema

validate a schema

install available data models in a schema

change properties of a schema

10



Creating a new Munsys Schema

Note

To be able to create a new schema, you will need to have the following roles assigned:
Munsys role: MUNSYS_ADMIN

Database privileges: CREATE USER, CREATE TABLESPACE, GRANT ANY ROLE,
GRANT ANY PRIVILEGE

You will need to log in as SYSTEM with DBA privileges.
A Munsys schema is created by following five steps:

Specifying a schema name and password. The schema name is the owner or default user that is used
to connect and manipulate the contents of the schema.

Specifying the database extents and coordinate tolerances. The database extents provide an area of
coverage for the data that is expected to be captured in the schema. Coordinate tolerances are set to
enforce expected data accuracy.

Specifying regional information: The locale, units, AutoCAD Map coordinate system and Oracle
coordinate system (SRID). Regional information provides the system with information as to which
part of the world the data represents. Locality provides information that is used when the data models
are created, as various locations have different data expectations. The AutoCAD Map coordinate
system code identifies the relevant coordinate projection system to use when referring to the data in
the schema in an AutoCAD Map environment. The code represents the coordinate system that is
associated with the geometry stored throughout the schema. The Oracle SRID is used when new or
modified objects are posted to the database.

Installing the relevant data models.

Creating the necessary Tablespaces in the database.

Schemamanagement
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To create a new Munsys Schema

1  Choose File > New Schema...

The Create New Schema — Step 1 of 5 dialog box is displayed:

Create New Schema - Step 1 of 5 X

Schema Info

Creating a new Munsys schema requires various parameters. The Schema
Name is also the owner {or default user) one would use to connect and
manipulate the content within the schema.

Schema Name: |

Schema Password: l

Confirm Password: |

e

Figure 1 Create new Schema — Step 1 of 5: Schema Name

2 Enter a name for the schema with a maximum of 30 (thirty) characters.

3  Enter and confirm a password for the schema. The maximum length for the password is 30 (thirty)
characters.

4  Click Next to continue to the second step of the schema creation process. (The Next button remains
unavailable until all the required fields have been completed.)

Schemamanagement 12



In the second step of the schema creation process, the database extents and tolerances are

specified:

Create New Schema - Step 2 of 5 X

Extents & Tolerances

Database extents provide an area of coverage for the data that is expected to
be captured in the schema. Set coordinate tolerances to enforce expected

data accuracy.
Database Extents
Minimum X: 0.000 &
Minimum Y- 0.000 5
Maximum X: 0.000 2]
Maximum Y: 0.000 &

Coordinate Tolerances

SDO Precision: 0.001000000

4

Snap Tolerance:  |0.001000000

ik

< Back Next > Cancel Help

Figure 2 Create New Schema — Step 2 of 5: Extents and Tolerances

In the Database Extents group, specify the minimum and maximum X and Y values.

Next, specify the SDO Precision and Snap Tolerance values.

Click Next to continue to the third step of the schema creation process.

Schemamanagement

13



Note

10

In the third step of the schema creation process, the regional info for the schema is specified.
The regional info provides the system with information about which part of the world the data
represents. The locality part of the regional info is used when the data models are created, as
different locations have different data expectations.

Create New Schema - Step 3 of 5 X

Regional Info

Select the region and relevant coordinate system that applies to the spatial
data that will be stored in this schema

Locality
Locale: Int w
Units: Meters v

AutoCAD Map Coordinate System

Coordinate System Code:

Oracle Coordinate System (SRID)
[[] Enable SRID

< Back Next > Cancel Help

Figure 3 Create New Schema — Step 3 of 5: Regional Information

In the Locality group, select the Locale and Units. The default values are United States and Feet.

Next, enter the AutoCAD Map Coordinate System Code. This is the code that identifies the
relevant coordinate projection system to use when referring to the data in the schema in an AutoCAD
Map environment. This code represents which coordinate system is associated with the geometry
stored throughout the schema. The coordinate system is especially important in an environment
where multiple projections systems are used, so that if necessary data may be transformed between
various systems.

Select the Enable SRID check box if you want to you want to see the existing Oracle SRIDs in the
database, and then enter the appropriate code. Click the button next to the Code field to display the
existing SRIDs in the Oracle database.

The Oracle SRID is not currently used by the Munsys system; however, other systems require an SRID
stored as part of the geometry. The SRID value is used when posting new objects or updating others to the
database from the AutoCAD environment, where every geometry record includes the SRID as one of the
elements. The SRID is obtained from the Oracle list.

Schemamanagement
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11 Click Next to continue to the fourth step of the schema creation process, in which the data models
for the new schema are specified:

Create New Schema - Step 4 of 5 X

Data Models

Various data models are supported but require many database objects.
Select the ones you are most likely to use in the schema.

[] Include All Data Models

Cadastral Data Model (CMS)
[[] Cable Route Data Mode! {CRS)
[[] Cable Fiber Data Model (CFS)
[[] Drainage Data Model (DMS)
[] Bectricity Data Model (EMS)
] Mapbooks Data Model (MBK)
[C] Roads Data Model (RMS)
[[] Sewer Data Model (SMS)
[] Water Data Model (WMS)

cock | [Not> || Caoel || Hop

Figure 4 Create New Schema — Step 4 of 5: Data Models

12 Select the data models that you want to install. To install all the available data models, select the
Include All Data Models option. The Cadastral data model is installed by default.

Schemamanagement
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Click Next to continue to the fifth and last step of the schema creation process, in which the
necessary tablespaces for the new schema are created:

Create New Schema - Step 5 of 5 X

Tablespaces

The Temporary tablespace can be renamed from the default TEMP. The
MUNDATA and MUNINDEX tablespaces are created by default.

Tablespace Creation Details

The following tablespaces will be created (size in brackets):
MUNDATA (500MB)
MUNINDEX (250MB)

Note: AUTOEXTEND will be set ON
Temporary Tablespace

Tablespace Name:
TEMP ]

Datafile Location
Folder Location:
DAAPPAORACLENORADATAVORCL

< Back Create Cancel Help

Figure 5 Create New Schema — Step 5 of 5: Data Models

The Tablespace Creation Details information area shows the tablespaces that will be created. The
respective tablespace sizes are displayed next to the tablespace names.

Enter a name for the temporary tablespace (the default temporary tablespace name is TEMP).

The Datafile Location field displays the location of the data files that will be used by the schema.

The location cannot be changed.
Click Create to create the new schema.

The Schema Create Progress dialog box is displayed.

Create Schema X

Creating Munsys System Tables

.
ot || e

Figure 6 The Schema Create Progress dialog box

Schemamanagement
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Tip Click the More Details button to expand the dialog box and display details of the schema creation process.
Click the Abort button if you want to abort the schema creation process at any stage. If the schema
creation process is aborted before it has been completed, the items created up to the point of the abort will
be left in the schema.

When the schema has been created, the following dialog box is displayed:

Creation Complete X

Creation process completed.

Verify the content of the output and check for any warning
messages.

Figure 7 Schema Creation Complete

Schemamanagement 17



Dropping an existing schema

3

In order to drop a schema from the database, you will need to have the MUNSYS_ADMIN
role assigned, as well as the DROP USER and DROP TABLESPACE database privileges. A list
of all the schemas in the database is displayed on the Drop Schema dialog box, from where you
can select the schema that you want to drop. If you are logged on as a schema owner, the name
of that schema will not be displayed in the list of schemas that can be dropped, as an owner
cannot drop their own schema.

To drop a schema from the database, do the following:

Choose File > Drop Schema.
The Drop Schema dialog box is displayed.

Drop Schema d

Existing Schemas

Select schema to drop: | MCITY14INT ~

Drop Cloze Help

Figure 8 The Drop Schema dialog box

Select the schema that you want to drop, and then click the Drop button.

The following message is displayed:

Drop Schema

Are you sure you want to drop the "MCITY14INT' schema from
the database?

This will permanently remove all the database structures
owned by this schema.

Figure 9 Drop Schema confirmation message

Click Yes to drop the schema from the database.

Schemamanagement
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The following confirmation message is displayed when the schema has been dropped successtully:

Schema Dropped *

Schema 'MCITY14INT" was dropped successfully from the
database.

Figure 10 Schema Dropped

Exporting a schema

This function is used to export the contents of a schema to a dump file. To be able to export a
schema, you will need to have the MUNSYS_ADMIN role assigned, as well as the
EXP_FULL_DATABASE database privilege.

To export a schema, do the following:
1  Choose File > Export Schema...

2 The Export Schema dialog box is displayed.

Export Schema *
Export Settings

Database Directory:

Dump Filename
[MCITY14INT_dp dmp

Export Grants
Export Table Data

Export Close Help

Figure 11 The Export Schema dialog box

3  Enter a name for the dump file that you are going to export the schema to, and the click Browse... to
specify the destination folder for the file.

The Dump File field is populated with the destination information of the schema.
4  Select or clear the following check boxes to specify export options:
Export Grants — select this option to include the grants when exporting the schema

Export Table Data — select this option to include the table contents when exporting the schema

Compress Extents — select this option to compress the data in the schema when it is exported

5  Click the Export button to export the schema to the file that you specified.
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6

The Export Schema: Progress Log dialog box is displayed, showing details of the export process.

X

Export Schema
Progress Log
.. exported "MCITYT4INT" "MUNSYS_QUERY" 48.82 KB 146rows A
.. exported "MCITY14INT"."MUNSYS_QUERY_CAT" 6.851 KB 14 rows
.. exported "MCITY14INT" "MUNSYS_SP_TABLES" 9507KB  B3rows
. exported "MCITY14INT" "MUNSYS_USAGE_LOG" 6570KB  Brows
.. exported "MCITY14INT" "MUNSYS_USER_LOG" 6.867KB  1rows
. exported "MCITY14INT" "AT_AD_CRTDUCT" 0KB  Drows
.. exported "MCITY14INT" "AT_CABLEDUCT" OKB  Drows
.. exported "MCITY 14INT" "AT_FIBERCABLE" OKB  Drows
.. exported "MCITY14INT" "GEN_DWGCAT" 0KB  Orows
. exported "MCITY14INT" "LU_CF5_FIBSYM" OKB  ODrows
.. exported "MCITY14INT" "LU_EMS_EBBRDDESC" OKB  Drows
.. exported "MCITY14INT"."LU_EMS_EHMSLDESC" OKB  Orows
.. exported "MCITY14INT" "LU_EMS_EHWJUNCDESC" 0KB Drows
. exported "MCITY14INT" "LU_EMS_EHVSWITCHDESC" DKB  Drows
.. exported "MCITY14INT" "LU_EMS_ELVJUNCDESC" OKB  Drows
.. exported "MCITY 14INT" "LU_EMS_EPCLEDESC" 0KB Drows
.. exported "MCITY14INT" "LU_EMS_EPYLONDESC" OKB  Orows
. exported "MCITY14INT" "LU_EMS_ESLDESC" OKB  Drows
.. exported "MCITY14INT"."LU_EMS_ESLIUNCDESC" OKB  ODrows
.. exported "MCITY14INT" "LU_EMS_ESLPOLEDESC" OKB  Drows
. exported "MCITY14INT" "LU_EMS_ESSTADESC" OKB Drows
.. exported "MCITY14INT" "LU_RMS_DWGNO" OKB  Drows
.. exported "MCITY14INT" "MBK_PROCESS" OKB  Drows
.. exported "MCITY14INT" "MDXT_176315" ODKBE  Drows
.. exported "MCITY14INT" "MDXT_176385" DKB  Drows
.. exported "MCITYT4INT"."MDXT _176485" DKB  Drows
.. exported "MCITY14INT" "MUNSYS_INTEG_RESULTS" OKB  Orows
.. exported "MCITY14INT" "MUNSYS_LINEAGE_COLUMNS" OKB  Orows
.. exported "MCITY14INT" "MUNSYS_LINEAGE_CONFIG" OKB  Drows
.. exported "MCITY 14INT" "MUNSYS_LOCKED_CBJECTS" OKB  Drows
. exported "MCITY14INT" "MUNSYS_MONITOR_LOG" OKB  Drows
.. exported "MCITYT4INT" "MUNSYS_RELATE" ODKB  Drows
.. exported "MCITY 14INT" "MUNSYS_SCHEDULED_TASKS" 0KB Drows
Master table "MCITY 14INT" YS_EXPORT_SCHEMA_D1" successfully loaded/unloaded
Dump file set for MCITY14INT.SYS_EXPORT_SCHEMA_01 is:
CAORACLENADMINAORCL12C\DPDUMPAMCITY 14INT_DP_16112020.DMP
Job "MCITY14INT"."SYS_EXPORT_SCHEMA_D1" successfully completed at Mon Nov 16 15:20:02 2020 elapsed 0 00:01:22
v

Figure 12 Export Schema: Progress Log

Click Close when the schema export has been completed successfully.

Schemamanagement

20



Validating a schema

The schema validation function validates the Munsys system model tables against rules defined
to ensure the integrity of Munsys system tables. You need to have the MUNSYS_ADMIN role
assigned and be logged in as the schema owner to be able to validate a schema. The results of
the validation are shown on the Validation Results dialog box.

To validate a schema, do the following:
1  Choose File > Validate Schema...

The Validation Results dialog box is displayed. This dialog box consists of the following three
tabs:

= Summary — this tab lists the main category of the tests that were performed, and whether
the entire category failed or passed the schema validation test:

Validation Results X
Summary Emors Validation Log
Summary of validation:

Validation Test Result

¢ Munsys Spatial Tables Passed
q’ Munsys Geometry Metadata Passed
' Munsys Columns Passed
v Munsys System Queries Passed
o Munsys Link Tables Passed
0 Munsys Lookup Tables Failed

v Munsys GSCs Passed
v Munsys Aftribute Templates Passed
q' Munsys Spatial Indexes Passed
’ Munsys Sequences Passed
v Munsys Integrity Passed
q’ Munsys Geometry Types Passed
e Munsys Lookup Values Failed

w Munsys Null Values Passed
' Munsys GID Unique Values kipped
e Invalid Schema Objects Failed

q’ Munsys Lineage Passed

Close Help

Figure 13 Validation Results dialog box: Summary tab

= Errors — this tab contains a list of all the errors that were encountered during the schema
validation. The results are grouped under the validation category that was performed, as
seen in the following example:

Schemamanagement
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Validation Results

£

Invalid Schema Objects
<Object Name: ALL_MUNSYS_SP_TAB...
<Object Name: ALL_MUNSYS_APPLICA...

Summary Emors  Validation Log
Validation results:

Error Description

<Table: SP_WATPIPE> <PIPE_DIA: 0> ... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 32>... Value found in spatial table does not exist in lookup table.
<Table; SP_WATPIPE> <PIPE_DIA: 40>... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 50>... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 63>.. Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 75>... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 80>... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 205... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 225... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 230... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE> <PIPE_DIA: 255... Value found in spatial table does not exist in lookup table.
<Table: SP_WATPIPE: <PIPE_DIA: 305... Value found in spatial table does not exist in lookup table.

Invalid Schema Object found.
Invalid Schema Object found.

Figure 14

Validation Results dialog box: Errors tab

= Validation Log — this tab contains a list of the tests that were performed, as well as a
detailed account of the outcome. The validation log can be saved as a text file.

Schemamanagement
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Validation Results

Summary Emors Validation Log
Validation log:

 Test Successful

*** Category: Munsys Geometry Metadata ***
Test #1: Validating metadata of Munsys spatial tables
Test Successful

“** Category: Munsys Columns ***
Test #1: Verifying existence of Spatial tables found in MUNSYS_SP_COLUMNS
Test Successful

Test #2: Verifying existence of columns in MUNSYS_SP_COLUMNS
Test Successful

Test #3: Validating column descriptions in MUNSYS_SP_COLUMNS
Test Successful

Close

Save Log... '

Figure 15  Validation Results dialog box: Validation Log tab

Click the Save Log... button to save the validation results as a text file, and then click Close to exit

the Validation Results dialog box.

Schemamanagement

23



Installing additional data models in a schema

With this function, you can install additional data models in a Munsys schema. You will need
the following roles/privileges assigned to be able to execute this function:

Munsys: MUNSYS_ADMIN

Database Privileges: CREATE ANY TABLE, ANY VIEW, ANY SEQUENCE and
CREATE TABLE, CREATE VIEW and CREATE SEQUENCE

To install additional data models, do the following:
1  Choose File > Schema Data Models...

The Data Models dialog box is displayed, showing a list of the data models that are available for
installation.

2 Select the data models that you want to install, and then click Install.

Data Models X

Data Models

Data models available for installation:
("] Drainage Data Model

[ | Blectricity Data Model
[] Mapbooks Data Model

(] Cable Route Data Model
[[] Cable Fiber Data Model

Cancel Help

Figure 16  The Data Models dialog box

The Schema Create Progress dialog box is displayed, and the schema is updated with the new data
models.

Schemamanagement
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Create Schema

Creating Spatial Indexes

=

Figure 17 Importing Data Models dialog box

You can do the following on this dialog box:

= Click the More Details button to expand the dialog box and show details of the data model

installation process.

= Click Abort to abort the installation of the data models if required.

Once the data models have been installed successfully, the following message is displayed:

Update Complete X

Data Model process completed.

Verify the content of the output and check for any warning
messages

Figure 18  Update Complete: data models installed

Schemamanagement
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Changing the properties of a Munsys schema

1

With this function, you can change basic properties of a Munsys schema, which are generally
stored in the MUNSYS DB _SETTINGS table. You will need the MUNSYS_ADMIN role

assigned to be able to change schema properties.

To change the properties of a schema, do the following:

Choose File > Schema Properties...

The Schema Properties dialog box is displayed. This dialog box consists of three tabs: General,

Schema and Lineage.

The General Tab

On the General tab, you can change database settings such as the Snap Tolerance, SDO Precision
and the Database Coordinate System. Once changes have been made, the OK button becomes

available.

Properties

General Schema Lineage Scheduled Tasks

Schema Information

Schema Name: MCITY14INT
Version: 14.0

Locale: INT

Units: Meters

Database Settings

SD0 Precision: 0.01

Database Coordinate System: RSALOZS

Cancel

Help

Figure 19  Schema Properties: General

The Schema Tab

On the Schema tab, you can change the Database Extents and the Oracle SRID.

Schemamanagement
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General Schema lineage Scheduled Tasks

Any changes on this tab will require the spatial indexes to be rebuilt.

Database Extents

Minimum X: -84000.0 Maximum X: -64200.0

Mirimum " -2855000.0 Maximum : -28753000.0

Cracle Coordinate System (SRID)
Enable SRID SRID Code:

Spatial Index
(OR O vz Rebuild Spatial Indexes

Cancel Help

Figure 20 Schema Properties: Schema

Note Changes that are made on the Schema tab (the database extents and the Oracle coordinate system) have a
direct effect on spatial indexing, and therefore the indexes will have to be rebuilt if you make any changes
on this tab. The OK button remains unavailable until you have rebuilt the spatial indexes.

Oracle has made significant improvements to the partitioning methods which allows for
enhanced performances and allows for spatial indexes to be system-managed.

Spatial Indexes V1 and V2

The main benefit of using V2 Spatial Indexing is because of the simplified spatial index
management. Effective with Oracle Release 12.2 and all subsequent versions, spatial indexes can
be system-managed by specifying INDEXTYPE=MDSYS.SPATIAL_INDEX_V2 at index
creation. You are strongly encouraged to use the V2 index type for all new spatial indexes you
create, regardless of whether the spatial table or the spatial index is partitioned, and you may
also want to use it if you decide to re-create legacy spatial indexes.

The old INDEXTYPE=MDSYS.SPATIAL_INDEX (V1) is still available for use, It may
provide slightly better index creation performance, especially with small data sets and no
partitioning involved. You might also want to use the old type if you need to drop a legacy
spatial index and then want to re-create it in exactly the same form as it was before.

We recommend that you consult the Oracle documentation before deciding which method of
spatial indexing is more suited to your requirements.

hteps://docs.oracle.com/en/database/oracle/oracle-database/18/spatl/indexing-querying-
spatial-data. heml#GUID-6BBF58C4-10D0-4993-8 DF2-60C3157412D7
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Rebuilding Spatial Indexes after updating Database Extents

If you have only made changes to any of the Database Extents X and Y parameters on the Schema
tab, you are required to Rebuild Spatial Indexes, however, the SRID will not be updated.

The following confirmation message is displayed:

Rebuild All Spatial Indexes

Are you sure you want to rebuild all spatial indexes?

This step is mandatory when changing any property on the
'Schema’ tab, but you should be aware that this may take
several minutes to complete.

Figure 21 Rebuild All Spatial Indexes

Click Yes to rebuild the spatial indexes.
The Spatial Index Rebuild Progress dialog box is displayed.

Spatial Index Rebuild Progress X
All indexes rebuilt.
Close Help

Figure 22 Spatial Index Rebuild Progress

Select the More Details button to display more information.

Note the SRID update was skipped.

Creating Spatial Indexes

Detailed Results:

(Creating Spatial Indexes

Executing: sqlplus -5 /NOLOG @5QL_Init sql MCITY 14INT/*****"@XE mun_spidx sql SKIP_SRID

oo e

Figure 23 More Details when Rebuilding Spatial Index

The buttons on the dialog box allow you to save the results as a text file, display details of the index
rebuilding process or abort the process.

When the indexes have been rebuilt successfully a confirmation message is displayed:

Schemamanagement
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Rebuild Complete e

o Index Rebuild process completed.

Verify the content of the output and check for any warning
messages.

Figure 24 Rebuild complete

Click OK to return to the Properties dialog box.

Once you have made all the necessary changes to the schema, click OK.

Rebuilding Spatial Indexes after updating SRID

If you made changes to the Use SRID check box, or updated the SRID Code, you are also required
to Rebuild Spatial Indexes, and will result in Lineage updates for all geometries if Lineage is
enabled. You will need to disable the Lineage Triggers if you do not want the Lineage updates for
all geometries.

The following confirmation message is displayed:

Are you sure you want to rebuild all spatial indexes and
update SRID values? This will result in lineage updates for all
geometries if lineage is enabled on spatial tables. If you do
not want this update to affect lineage then disable lineage
triggers first before rebuilding indexes.

This step is mandatory when changing any property on the
‘Schema’ tab, but you should be aware that this may take
several minutes to complete,

Yes Mo

Click Yes to rebuild the spatial indexes.

The Spatial Index Rebuild Progress dialog box is displayed.

Spatial Index Rebuild Progress e
All indexes rebuilt.
Close Help

Figure 25  Spatial Index Rebuild Progress

Select the More Details button to display more information.

Note the SRID update was run.
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Creating Spatial Indexes

Detailed Results:

Creating Spatial Indexes
Executing: sqlplus -5 /NOLOG @SQL_lnit sgl MCITY14INT,/***** @XE mun_spidx.sgl RUN_SRID

Abort Help
Figure 26 More Details when Rebuilding Spatial Index

The buttons on the dialog box allow you to save the results as a text file, display details of the index
rebuilding process or abort the process.

When the indexes have been rebuilt successfully a confirmation message is displayed:

Rebuild Complete e

Index Rebuild process completed.

Verify the content of the output and check for any warning
messages.

Figure 27 Rebuild complete

Click OK to return to the Properties dialog box.

Once you have made all the necessary changes to the schema, click OK.

The Lineage Tab

On the Lineage tab, you can enable/ disable Lineage functionality and select Lineage editing
behavior for the logged in schema.

Filling out the Lineage tab in the schema Properties dialog box is the is the first essential step in
setting up Munsys Lineage.
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Properties X

General Schema Lineage Scheduled Tasks

Munsys Lineage
[] Enable Lineage

Editing Behaviour:

The "Prompt’' behaviour setting will prompt the user to either post all
pending edits to the database or continue the breakjoin
operation.

OK Cancel Help

Figure 28  Schema Properties: Lineage

Select Enable Lineage, and click OK.
Select the Editing Behavior of Lineage

Editing behavior affects how Munsys Lineage will respond to multiple break

or join operations on line objects. In the available drop down, the following options can be selected:

Continue Editing: This setting will continue the break/join operation without posting any
pending edits to the database. Note that, if more than one split is made and changes are not
posted to the database in between splits, the splits will all be linked to the same Lineage
parent ID of the line that was broken.

Automatic Posting: This setting will post all pending edits to the database and then
continue the break/join operation.

Prompt: This setting will prompt the user to either Post all pending edits to the database
or Continue the break/join operation. Note that, if the same line object is broken more
than once and changes ARE posted to the database in between breaks, each line segment
will be linked to the Lineage parent of the last line that was broken.

| Lineage Implication: Continue editing or post current changes |

e Continue

Post

Figure 29 Lineage Implication prompt message displayed in Munsys Applications.

Click OK, or continue making changes in the schema Properties dialog box.
To continue setting up Lineage refer to the chapter Munsys Lineage.

The Scheduled Tasks Tab
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Note

On the Scheduled Tasks tab, you can enable/ disable the Scheduled Tasks functionality and select
Scheduled Tasks process time to run Scheduled Tasks on the schema.

Filling out the Scheduled Task tab in the schema Properties dialog box is the is the first essential

step in setting up Munsys Scheduled Tasks.

Properties

General Schema Lineage Scheduled Tasks
Munsys Scheduled Tasks
[[] Enable Scheduled Tasks

Set Process Time:

0K Cancel Help

Figure 30 Schema Properties: Scheduled Tasks

You will need the ‘Create Job’ Privilege to enable Munsys Scheduled Tasks.

Select Enable Scheduled Tasks.

Select the preferred Process Time when you want the Scheduled Task to run, and click OK.

To continue setting up Scheduled Tasks refer to the chapter Munsys Scheduled Tasks.
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Chapter 4
Import Demo Data

Introduction

The demo data included in Munsys contains more than 14000 land parcels with associated
data complementary to each application. The data contained within the demo data has been
specifically captured to represent typical practical requirements. New users can make use of the
demo data for training and to familiarise themselves with the Munsys applications. Existing
users can experiment with new features and enhancements. The demo data will assist in
testing/training or presenting Munsys to users and clients without actually having to capture
data. Be aware that the demo data contains errors for testing purposes.

The Munsys Demo Data is installed along with the Munsys Management Console. There are
two demo schemas for the United Sates (MCITY14US) and International (MCITY14INT)
locales.

The MCITY14 schema has spatial and attribute data that can be used for training purposes to
familiarise the users with the concepts of Munsys, or it can be used to test functionality before
running on the live database.

Munsys Demo Data contains data for all the Munsys applications. Once the database
administrator has imported the demo data, users will be able to retrieve the data from the
database.
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Importing Munsys Demo Data

Be aware that the demo data schema will automatically be created in the import demo data
process. To recreate an existing demo data schema, the schema will first need to be dropped
before the import can begin.

1  Open the Munsys Management Console
2 Complete the ‘Connect to the Database’ dialog that appears.

The database administrator must login as SYSTEM with DBA privileges and specify the database to
which the demo data will be imported. Leave the Schema field blank. Click OK.

3 On the menu, select File > Import Demo Data.

The Import Demo Data dialog box will appear.

Import Demo Data X

Demo Data
Locality
® Intemational (INT)

(O United States (US)

Database Directory:

Cancel Help

Figure 1 Import Demo Data dialog box

4 In the Import Demo Data dialog box, select the appropriate Locality: International (INT) or
United States (US).

5 Select an Database Directory to import the Demo Data.
By default oracle should have a directory already called DATA_ PUMP_DIR. To dis-

cover where this directory is located on the server, you will need to run the following
sql statement on the database that will be hosting the Munsys demo data:

SELECT DIRECTORY_NAME,DIRECTORY_PATH FROM DBA_DIRECTORIES
WHERE DIRECTORY_NAME="DATA_PUMP_DIR’;

To create a new directory you will need to run an sql statement similar to the one
below:

CREATE DIRECTORY “NAME OFTHE DATA DIRECTORY” AS ‘/ust/apps/data-
files’;

This path must exist and be accessible on the Oracle server. You will need to copy the data
pump files located on the Munsys install directory:

(E.g. Copy the files MCITY14INT_DP.dmp and MCITY14US_DP.dmp from C:\Pro-
gram Files\Open Spatial\MunConsole14.2\DumpFiles) to the directory path on the
Oracle server.
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If you log on to the Oracle database with a user other than the one that will be used

to create the Munsys schema you will need to grant permissions to the directory using
an sql statement similar to the one below:

GRANT READ,WRITE ON DIRECTORY “NAME OF THE DATA DIRECTORY”
TO “THE USER NAME”;

To see the new directory, repeat steps 1-4 and you should see the new directory in the
‘Database Directory’ drop down of the Import Demo Data dialog.

6  Click Proceed.

7  The Import Demo Data Progress dialog will appear:

Import Demo Data Progress X

Intiate Data Pump

Mot | | heb

Figure 2 Import Demo Data Progress

The required tablespaces and demo data schema are created. Munsys imports the Oracle dump
file that populates the schema with the demo data.

8  When the Import Demo Data Progress is done a confirmation message will be displayed.
Click OK to go back to the Import Demo Data Progress dialog.

Import Complete X

o Import process completed.

Verify the content of the output and check for any warning
messages.

Figure 3 Import Complete

When the import process is completed, verify the content of the output and check for any
warning messages in the More Details tab of the Import Demo Data Progress dialog.
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Log on defaults

Note

During the import process of the demo data, the user will be notified of the schema name that
will be created. This information will be required to log on to Munsys Applications and Munsys
Management Console. The user logs on to Munsys using the following default log on detail:

US locale
Username MCITY14US
Password MCITY14US
Schema MCITY14US
Database Database name configured with Oracle client

International locale

Username MCITY14INT
Password MCITY14INT
Schema MCITYI4INT
Database Database name configured with Oracle client

Once a schema is created for the demo data, the database administrator should change the
password from its default value. The database administrator should use Munsys Management

Console to create users and grant the required roles.

Passwords are case sensitive when connecting to an Oracle database.

Import Demo Data
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Chapter 5
Working with Munsys Application Settings

Introduction

Each Munsys application has its own default capture settings that are set by the database
administrator in the Munsys Management Console. In the Munsys Management Console, the
Applications tree contains a list of all the available Munsys applications and their respective
application settings.

This chapter provides information about application setting management in the Munsys

Management Console. The following functions can be performed from the Applications tree:

Creating a new Application Setting

Modifying an existing Application Setting
Deleting an Application Setting

Adding a new Integrity Setting

Modifying an new Integrity Setting

Deleting an existing Integrity Setting

Creating a new Network Check Notification
Editing an existing Network Check Notification
Deleting an existing Network Check Notification
Creating a new Network Node Integrity
Editing an existing Network Node Integrity
Deleting an existing Network Node Integrity
Creating a new Object Attribute Integrity
Editing an existing Object Attribute Integrity

Deleting an existing Object Attribute Integrity
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The Applications tree: overview

The Applications main tree consists of list of all the Munsys application with their respective

application settings.

Using the Action menu or context-sensitive (right-click) menu that is activated when an item
is selected, settings for the various applications are created and maintained.

Q;u Scheduled Tasks

Township

Bl Munsys Management Cansole (MCITY14INT) = O X
File  Action Help
E‘ﬁ Applications Variable Value Description 63
'{95 General Settings .
47 CFS - Cable Fiber Building
&3P CMS - Cadastral #*CMS_BUILDING _TYPE* RESIDENTIAL  Building Type
£ Density
i %g e e 4 "CMS_DENSITY_TYPE* 1P1000 Density Type
[-{3? DMS - Drainage Easement
&-{3? EMS - Blectricity & *CMS_EASEMENT_TSIZE* 5 Easement Tag Height
E1-{39 MBK - Map Books 4 *CMS_EASEMENT_OFFSET* 2 Easement Offset distance
iz-£38 QRY - Query &% CMS_EASEMENT_TYPE® GENERAL Essement Type
E-{3? RMS - Roads
(3P SOM - Spatial Data Manager Integrity
E-{g8 SMS - Sewer 4 *CMS_SHORT_OBJECTS® 1 Short Objects
E-(30 WMS - Water ¢ CMS_SRCH® 5 Cadastral Search Tolerance
B B Locks Land Use
i i Records
-5 Query Categories 4% *CMS_LANDUSE_TYPE* UNKNOWN Land Use Type
-85 Categories Mote
¢ CMS_NOTE_TSIZE® 5 Note Tag Height
Parcel
4% *CMS_PARCEL_WSTATUS® C Parcel Work Status
& *CMS_PARCEL_LSTATUS® R Parcel Legal Status
: 4% *CMS_PARCEL_TYPE* P Parcel Type
B Table/Views &#°CMS_PARCEL_TSIZE* 5 Parcel Tag Height
&=| Roles
El% Tables\iews Street Text
£y Spatial Tables <@5'CI‘\I'lS_S'I'HNMI‘\I‘lE_TSIZE’ 7 Street Name Tag Height
iy Attribute Tables ¢ *CMS_STRADDR_TSIZE* 3 Strest Address Tag Height
[y Lookup Tables 4% *CMS_STR_FNT* ROMANS Street Text Font
'y Indexes
Triggers Suburb
- {f) Lineage & *CMS_SUBURB_TSIZE" 15 Suburb Tag Height

Figure 1

Munsys Management Console: Applications tree
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Creating a new application setting

Each Munsys application has its own default settings that are used when data is captured, for
example the snap tolerance, tag and symbol scale, node types, etc. Application settings are
stored in the MUNSYS_AP_SETTINGS table. When a new setting is created, it inherits the
category from the current application and a new record is inserted in the
MUNSYS_AP_SETTINGS table. You will need the MUNSYS_POWER or
MUNSYS_ADMIN roles assigned to be able to create a new application setting.

To create a new application setting, do the following:

1  Select the Settings item below the application that you want to create the setting for in the
Applications tree, and then select the New Setting... option on the Action menu or the context-
sensitive (right-click) menu.

=-{F Applications
- General Settings
CMS5 - Cadastral

& _
X Intearity | Mew Setting...
@ Emg:g::: Collapse All
¢ (3 MBK- Map B Expand All

Figure 2 Selecting Application Settings

The New Application Setting dialog box is displayed.

New Application Setting - Cadastral X

Application Setting - CMS

Descriptive
Name:

Display Group:
Short Description:

Long Description:

Value
Data Type: Initial Value:

W

[] Use Lookup Table for Value
Lookup Table: Initial Value from Lookup:

] Alow Session Edting

Cancel Help

Figure 3 The New Application Setting dialog box
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1  Enter the following Descriptive information:

Name — enter a descriptive alpha-numeric name (containing no spaces) of no longer than
30 characters

Display group — from the list, select the group within the set of application settings that this
setting will belong to. You can select an existing group, or specify a new group for the new
setting.

Short description — enter a short, descriptive setting that give the user an indication of what
the setting will be used for (maximum length 40 characters)

Long description — enter a longer description for the setting (maximum length 250
characters)

2 Enter the following Value information:

Data type — select the data type of the value that will be stored.

Initial value — select one of the following values:
Character : allows for string type values
Integer : whole numbers
Float : decimal numbers
Boolean : only allows the values T (true) or F (false)
Angle : stores a decimal number, but uses AutoCAD formatting to display the angle value

3 Select the Use lookup table for value check box if you want the value to be selected from a lookup
table. The LCODE value from the lookup table will be stored as the Initial Value once it has been
selected.

If the Use Lookup table for Value option has been selected, use this list to select the appropriate
table.

4  Select the appropriate initial value from the list of lookup tables.

5  Select the Allow Session Editing option to allow the user to select this from the same lookup table
specified when the user gets to change a value in the Munsys application. The lookup table has the
fixed structure of LCODE, b — where LCODE is the value that is stored in the value of the setting,
but LVALUE is the description that is displayed in the drop-down entry.

6  Click OK to create the new application setting.
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Modifying an existing application setting

2

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to

change the properties of an application setting. Application settings are changed using the

Modify Application Setting dialog box.

To modify an existing application setting, do the following:

Select the application setting that you want to modify, and then select the Properties... option on the
Action menu or the context-sensitive (right-click) menu.

File  Action Help

=-(3® Applications

{} General Settings

@ CMS - Cadastral
g5 Settings

‘x Integrity

Variable

Building

Density |

43CMs_ =

(&P DMS - Drainage Properties...

(mP EMS - Flectrici

Value

RESIDENTIAL

1P1000

Description

Building Type

Density Type

Figure 4

Selecting Application Setting to modify

The Modify Application Setting dialog box is displayed.

Modify Application Setting - Cadastral

Application Setting - CMS

Descriptive
Name:
"CMS_BUILDING_TYPE" |

Display Group:

|Building v]
Short Description:

|Building Type

Long Description:

This is the default type assigned when capturing a new
building.

Value
Data Type:

Character (strings) v

Initial Value:
RESIDENTIAL

[¥] Use Lookup Table for Value
Lookup Table: Initial Value from Lookup:
LU_CMS_BLDTYPE v

Allow Session Editing

Cancel Help

Residential v

Figure 5

Modify Application Setting dialog box

Change the properties as required, and then click OK.
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Deleting an application setting

You can delete an application setting from a Munsys application. Each Munsys application has
its own default settings that are used when data is captured, for example the snap tolerance, tag

and symbol scale, node types, etc. Application settings are stored in the
MUNSYS_AP_SETTINGS table.

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to
delete an application setting.

To delete an application setting, do the following:

1  Select the application setting that you want to delete, and then select the Delete option on the Action
menu or the context-sensitive (right-click) menu.

The following message is displayed:

Delete Setting

0 Are you sure you want to delete the application setting?

You have selected to delete the "*CMS_BUILDING_TYPE*'
application setting.

ST

Figure 6 Delete application setting

2 Click Yes to delete the application setting from the application.
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Integrity Validations

Note

The Munsys Integrity Validation Tools and checks are extremely powerful and allows
administrators to manage the integrity of their organization’s spatial data to a high degree of
sophistication with relative ease.

The Integrity Validation Tools can be divided into three groups of tools:
Network Check Notifications
Network Node Integrity
Object Attribute Integrity

For more information on Munsys compound validations please refer to the Munsys Administrators
Reference Guide (Munsys14 2 AdminReferenceGuide.pdf) or the Munsys Concepts User Manual
(Munsys14 2 ConceptsUserManual.pdf) for more details.

Network Check Notifications

The Network Check Notification Integrity tools are available only for Applications that have
Network-able Feature objects. These include Drainage, Electricity, Roads, Sewer and Water.
Since the networks in each of these have their own characteristics, the Network Check
Notification Integrity tools are application specific. These configurations can be used to
monitor changes in the topological relationships of the network.These serve as notifications to
rerun network integrity validations. These settings must be in line with the Network integrity
test routines for each of the applications.

When any of the items that have been configured for notification are changed, the user will be
notified to rerun the network integrity through which the network relationships are then
validated.

Network Integrity Warning X

Object integrity complete.
Changes have been detected that may influence network integrity.

It is recommended that network integrity is validated before changes
are posted to the database.

Figure 7 Network Integrity Warning
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Creating a new Network Check Notification

Each Munsys application has its own Network Check Notification settings that are used when

the network is validated.Network Check Notification settings are stored in the
MUNSYS_INTEG_OBJECTS table. When a new notification is created, it inherits the
category from the current application and a new record is inserted in the

MUNSYS_INTEG_OBJECTS table.

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to

create a new network check notification setting.

1  Select Network Check Notification in the tree under the application that you want to create the

Notification for.

3P CMS - Cadastral
37 CRS -Cable Route

3P DMS - Drainage Xer

B3 Intearty
K Network Check Nc
K Network Node Inte
K Object Attribite Ints
38 EMS - Bectricity
38 MBK - Map Books
38 GRY - Query
3? RMS - Roads
3? SDM - Spatial Data Manag
3P SMS - Sewer
3 WMS - Water
() Locks
&} Records
35 Query Categories
55 Categories
B Queries
5=/ Roles
iy Security
& Users
= Roles
- Priviege
B, Table/Views
2| Roles
-3y Tables/Views

Spatial Tables
Attribute Tables
Lookup Tables

Al Munsys Management Console (MCITY14INT) - ul X
File  Action Help
- Q;D‘(‘;aﬁ“"!i s A || Mun 1D Table Name Is Metwork Object ~ Network Object Type Network Columns
2 Cigaj;ﬁb‘e I;::' o P SNODE = T JDDEEMD)ICIDE,F‘IF‘EJD

SP_SWCHANNEL True
SP_SWCULVERT True

LINK START_NODE END_NODE
LINK START_NODE END_NODE

Figure 8

2 Select the New Network Check Notification... Option on the Action menu or the context-sensitive

(right-click) menu.

Munsys Management Console: Network Check Notification
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The following dialog is displayed:

New Network Check Notification - Drainage X

Network Check Notification

Spatial Table: ~
Object Type
® Link O Node (O Service Connection
Columns
Available Columns: Notification Columns:

L

Cancel Help

Figure 9 New Network Check Notification

3  Select the Spatial Table for which you want to add a Notification.Note that only those objects are
listed that are a part of the Application under which you have made the selection. Once selected, you
will notice that the columns from the selected table are now listed in the Available Columns list.

4  Next select what role the selected table plays within the network.You have three options:

Link — these must be linear objects that act as topological links (polylines) within the
network.

Node — these must be point type objects that act as topological nodes within the network.

Service Connection — these must be linear type objects that act as topological connections
between the network and the service delivery endpoint, usually a polygon type entity such

as a property.

5  Next, select the columns from the Available Columns list that must be used to notify users to rerun
Network Integrity.

6  Click OK to save your changes to the database.
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Editing an existing Network Check Notification

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to edit
an existing network check notification setting.

To edit an existing network check notification, do the following:

1  Select Network Check Notification in the tree under the application where you want to edit an
existing notification.

ﬂ IMunsys Management Console (MCITY14INT) — ] *

File  Action Help

= Ti Applications Mun ID  Table Name |s Network Object Network Object Type Network Columns

& g S;;”::f et X563  SP_SWNODE  Tre NODE NODE_ID
i53-¢37 CMS - Cadastral X65 SP_SWPIPE True LINK START_NODE END_NODE PIPE_ID
,;‘ 7 CRS - Cable Route 66  SP_SWCHANNEL True LINK START_NODE END_NODE
B- 1il DMS - Drainage X667 SP_SWCULVERT True LINK START_NODE.END_NODE
: 4y Settings
E \x htegnty
XE
4 Network Node \ntegity
- Object Attribute Integrity
- ﬁ.l EMS - Blectricity
(-¢g? MBK - Map Bocks
[-¢a® QRY - Query
[+-¢8 RMS - Roads
(-¢g? SDM - Spatial Data Manager
[#)-(g? SMS - Sewer
-8 WMS - Water
Locks
Query Categories
7, Security
Privilege
Tables/Views
Lineage
) Scheduled Tasks < s

Figure 10 Select Network Check Notification

2 Select the Existing Notification record in the right hand notifications lists.

E Munsys Management Console (MCITY14IMT) — O X

File  Action Help

= {3 Applications Al MuniD  Table Name Is Network Object  Network Object Type  Network Columns

i g e K63 SP_SWNODE  True NODE NODE_ID
: START_NODE.END_NODE

[s-¢38 CMS - Cadastral =
- @ CRS - Cable Route _SWCULVERT  True )( Delete START_NODE.END_NODE
E ui' DMS - Drainage [ Properties.. |
: ‘{} Settings
- Integrity
; K. Network Check Notificatior
K Network Node Integrity
- Object Attribute Integrity
® 1il EMS - Blectricity v
< > < >

Edit Properties of Integrity Network Check Notification

Figure 11 Selecting Network Check Notification Properties
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3 Select the Properties Option on the Action menu or the context-sensitive (right-click) menu.

The following dialogue is displayed:

Modify Network Check Notification - Drainage

MNetwork Check Notification

Spatial Table: | SP_SWCHANNEL

Object Type

Columns

Available Columns:

CHNL_GRADIENT ~
CHNL_ID

CHNL_MATRL

CHNL_TWIDTH

CHNL_TYPE

COMMENTS

DATA_QUALITY

DATA_SOURCE

END_GL

END_IL

GEOM_LENGTH

GEOMETRY

GID

START_GL

START_IL

TAG_ANGLE

TAG_JUST v

® Link O Node (O Service Connection

=2

<<

Notification Columns:

END_NODE
START_NODE

Figure 12 Modify Network Check Notification

4 Edit the Notification Properties as needed.

5  Click OK to post the changes to the database.
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Deleting an existing Network Check Notification

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to delete
network check notification setting.

To delete an application setting, do the following:

1  Select Network Check Notification in the tree under the application where you want to edit an
existing notification.

2 Select an Existing Notification record in the right-hand notifications lists.

3  Select the Delete Option from the Action menu or the context-sensitive (right-click) menu.

ﬁ IMunsys Management Console (MCITY14INT) - [} x

File  Action Help

B Ti :PDL'?"“"”T — Al MunID  Table Name Is Network Object ~ Network Object Ty... Network Columns
Lo
i gl 63 SP SWNODE  Tne NODE NODE_ID
- a¥ CMS - Cadosirad 66  SP_SWCHANNEL Trud3¢ Delete START_NODE.END_NODE
é @ CRS - Cable Route XGT SP_SWCULVERT True Properties... START_NODE,END_NODE
=-(3# DMS - Drainage
| 4y Settings
=X Integrty

x Network Check Motffication
XK Network Node Integrity
: - X Object Attribute Integrity
@-(§P EMS - Blectrcty Vi<« :

Delete Integrity Network Check Notification

The following message is displayed:

Delete Network Check Notification

Are you sure you want to delete the network check
notification?

You have selected to delete the "SP_SWCHANNEL' network
check notification.

Figure 13 Delete Network Check Notification record

4 Click Yes to delete the Network Check Notification record.
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Network Node Integrity

The Network Node Integrity tools are available only for Applications that have Network-able
Feature objects. These include Drainage, Roads, Sewer and Water.Since the networks in each of
these have their own characteristics, the Network Node Integrity tools are application
specific. These configurations can be used to configure different Network characteristics.

The Network Node Integrity tools can be used to determine how specific node types should
behave in the network.Two rule types are supported:

The INTERMEDIATE rule allows a node to be inserted between the start and end nodes
of a link object.

The LINKLIMITS rule specifies a minimum and a maximum number of links allowable
for the node type.

Creating a new Network Node Integrity Record

Each Munsys application has its own Network Node Integrity settings that are used when the
network is validated.Network Node Integrity settings are stored in the
MUNSYS_INTEG_NODES table.You will need the MUNSYS_POWER or
MUNSYS_ADMIN roles assigned to be able to create a new network node integrity setting.

To create a new network node integrity setting, do the following:

1  Select Network Node Integrity in the tree under the application that you want to create the Node
Integrity record for.

ﬁ Munsys Management Console (MCITY14INT) — 0 ¥

Eile Action  Help

o @ f:opllcations _ A || Mun ID Table Name Symbol Name Rule Type Parameters

& 1% g X631  SP_SWNODE _SW_DI LINKLIMITS 13

&1 gg? CMS - Cadasiral X 63 SP_SWNODE  _SW_JUNC LINKLIMITS 24
-gg? CRS - Cable Route X 63 SP_SWNODE _SW_PMP_PVT LINKLMITS 1.2
&-(38 DMS - Drainage X3 SP_SWNODE  _SW_CAP LINKLIMITS 1.1
4y Seftings 63 SP_SWNODE _SW_PMP_PUB LINKLIMITS 22

- X Integrty X3 SP_SWNODE  _SW_Ww LINKLIMITS 1.1

- X Network Check Notfication X 63 SP_SWNODE  _SW_MH LINKLMITS 14

K Xe63 SP_SWNODE  _SW_KI LINKLIMITS 1.4
; . ) Object Attrbute Integrity
({3 EMS - Bectricity
[&-{3 MBK - Map Books
[+-{3? QRY - Query
[#-Za® RMS - Roads
(g SDM - Spatial Data Manager
[tl-{38 SMS - Sewer
[-fg® WMS - Water
(5 Lecks vil< >

Figure 14 ~ Munsys Management Console: Network Node Integrity

2 Select the New Network Node Integrity... Option on the Action menu or the context-sensitive
(right-click) menu.
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The following dialog is displayed:

New Network Node Integrity - Drainage X

Network Node Integrity

Spatial Table: v
Symbol Name:
Rule Type
® Link Limit O Intermediate

Minimum Link : 1
Maximum Link: 1

oK Cancel Help

Figure 15  New Network Node Integrity

3  Select the Node table for which you want to add Network Node Integrity.

4  Enter the name of the Node Type (Munsys SYM_NAME) for which node integrity needs to be
added.

5  Select the Rule type for the Node Integrity. There are two options:

Link Limit — This option allows you to specify the range of links that are allowed for one
node of the given type. The Minimum Link setting will test for a minimum number of links
while the Maximum Link setting will test for a maximum number of connected links.
Examples:

A reducer in a water network must have an incoming AND an outgoing link but no
more. The minimum and maximum must therefore both be set to “2”.

An Endcap in most networks must always be limited to one link only. The minimum and
maximum must therefore both be set to “17.

A pre-cast storm water manhole must have at least ONE incoming and one outgoing link,
but it could have multiple incoming links, depending on its design. The minimum should
therefore be set to “2” while the maximum should be in line with its specifications but
would usually be three or more...

Intermediate — This node type does not break a pipe but is merely snapped onto the
pipe.Example:

some organizations require that nodes such as Hydrants do not break pipes but sit inter-
mediately between the start and end nodes.

6  Click OK to update the database and save your new settings.
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Editing an existing Network Node Integrity

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to edit an

existing network node integrity setting.

To edit an existing network node integrity setting, do the following:

1  Select Network Node Integrity in the tree under the application where you want to edit an

existing Node Integrity record.

ﬁ [Munsys Management Console (MCITY14INT) — O b4
File Action Help
7 T? Applications . A 1| Mun D Table Name Symbol Name Rule Type Parameters
' Mg g X631  SP_SWNODE _SW_DI LINKLIMITS 13
-gg? CMS - Cadastral X 63 SP_SWNODE  _SW_JUNC LINKLMITS 24
| i| {37 CRS - Cable Route X3 SP_SWNODE  _SW_PMP_PVT LINKLUMITS 12
& fﬂ DMS - Drainage X63 SP_SWNODE  _SW_CAP LINKLIMITS 1.1
|14 Seftings X63 SP_SWNODE  _SW_PMP_PUB LINKLIMITS 22
=X Integrty Xe63 SP_SWNODE  _SW_WW LINKLIMITS 1.1
] Netwolk Check Notfication X63 SP_SWNODE  _SW_MH LINKLIMITS 1.4
: X63 SP_SWNODE  _SW_KI LINKLIMITS 1.4
ObJed Attribute Integrity
|+| ﬁ! EMS - Blectricity
({3} MBK - Map Books
[-{3? QRY - Query
|+|1‘j! RMS - Roads
@3 SDM - Spatial Data Manager
G- (8 SMS - Sewer
z [-(g8 WMS - Water
-G Locks v« >

Figure 16  Select Network Node Integrity

2 Select the existing network node integrity record in the right-hand panel, and then select the
Properties option on the Action menu or the context-sensitive (right-click) menu.

-g# CRS - Cable Route
B ]f DMS - Drainage
| 4y Settings

- X Integrty X63
X Network Check Notification X63
X Network Node Integrty X 63

Y Object Attribute Integrity
l ﬁ! EMS - Blectricity vil<c

Edrt Properties of Integrity Network Node Integrity

ﬁ IMunsys Management Console (MCITY14INT) | - O x
File  Action Help
= E g:?h:': . || MunID Table Name Symbol Name Rule Type Parameters
i pngjnonl X63  SP_SWNODE _SW_DI LINKLIMITS 1.3
-3 CMS - Cadastral Xe3 SP_SWNODE ___SW_JUNC LINKLIMITS 24

LINKLIMITS
LINKLIMITS

[PMP_PUB  LINKLIMITS 22

—SW-WW LINKLIMITS 1.1

SP_SWNODE  _SW_MH LINKLIMITS 14
SP_SWNODE _SW_KI LINKLIMITS 14

Figure 17

Selecting Network Node Integrity Properties
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3

4

The following dialog is displayed:

Modify Network Node Integrity - Drainage
Network Node Integrity

Spatial Table: SP_SWNODE

Symbol Name: | Y010

Rule Type

@) Link Limit O Intermediate

Minimum Link: I:I
Maodmum Link:

oK Cancel Help

Figure 18  Modify Network Node Integrity

Make any changes to the values on the dialog as needed.

Click OK to update the existing Network Node Integrity record.
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Delete an existing network Node Integrity

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to edit
an existing network node integrity setting.

To edit an existing network node integrity setting, do the following;:

Select Network Node Integrity in the tree under the application where you want to delete an
existing Node Integrity record from.

Select the existing network node integrity record in the right-hand panel, and then select the Delete
option on the Action menu or the context-sensitive (right-click) menu.

B Munsys Management Censele (MCITY14INT) . | X
File  Action Help
'fj ;‘;plicatims _ A1 MunID Table Name Symbol Name Rule Type Parameters
&2 General Settings 63 co_cwmaonc___ow D) LINKLIMITS 1.3
[#]-gM CFS - Cable Fiber ¥ Delet
: 63 € _JUNC LINKLIMITS 24
- CMS - Cadastral
(3P CRS - Cable Route X63 Properties... | PMP_PVT  LINKLIMITS 1.2
©-g31 DMS - Drainage X 63 SPTSWODE™"SW_CAP LUNKLIMITS 1.1
" L4y Settings Xe3 SP_SWNODE _SW_PMP_PUB LINKLIMITS 22
&) Integrty X3 SP_SWNODE  _SW_WW LINKLIMITS 1.1
- XK Network Check Notification 63 SP_SWNODE  _SW_MH LINKLIMITS 14
x Network Node Integrity XB3 SP_SWNODE  _SW_KI LINKLIMITS 14
- Object Attribute Integrity
. @-{gh EMS - Blecticty vl < >
Delete Integrity Network Node Integrity

Figure 19  Select Delete Network Node Integrity

The following message is displayed:

Delete Network Node Integrity

o Are you sure you want to delete the network node integrity?

You have selected to delete the 'SP_SWNODE - _SW_DI'
network node integrity.

Figure 20  Delete Network Node Integrity Notification

Click Yes to delete the existing Network Node Integrity
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Object Attribute Integrity

Note

The Object Attribute Integrity Rules refer to integrity rules allows administrators to set up a
range of integrity rules for any of the attributes of a data object.

NOTE: Multiple rules can be set for a specific attribute on any table.

When multiple checks are specified, the Rule order will determine in what order rules will be
run to validate the Object’s Integrity. The following rule types can be set:

w  Compare Check — This rule will allow users to check the relationship between two attribute
fields of the same table.

m  Not Null — This forces attributes to have values.

= Range — Valid for NUMERICAL attributes only — the attribute must fall within a range
defined as a Minimum and Maximum range: [Not] greater than or equal to x and less than
or equal toy.

m  Substring — This rule can be applied multiple times for the same attribute and allows
validation of parts or substrings of the attribute value: The substring function returns a
portion of string, beginning at a specified position in the string

®  Value Check — This rule allows users to check the value of an attribute.

Creating an new Object Attribute Integrity

It is possible to set up Object Attribute Integrity rules for each Munsys object class. Object
Attribute Integrity rules are stored in the MUNSYS_INTEG_ATTR table. You will need the

MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to create new object
attribute integrity rules.

To create a new object attribute integrity rule, do the following:

Select Object Attribute Integrity in the tree under the application under which the object falls for
which you want to create an object attribute integrity rule.

ﬁ IMunsys Management Console (MCITY14INT) — 0 %
File  Action Help
1? ;'E\pl:-g:aﬁons . A || MuniD  Table Name Column Name Rule Order  Description e
4 | i
iy e kit X1  SPTOWN  TOWNCODE 1 Town Code
T Setings X3 SP_PARCEL  PRCL_KEY 1 Parcel Key
53X teatty X3 SP_PARCEL  PRCL_KEY 2 Parcel Key Portion
XTI || X3 SPPARCEL  TAGVALLE 1 Parcel Tag
-¢5 DMS - Drainage X5  SPSUBURB SUBCODE 1 Suburb Code
ci1-cgP EMS - Blecticity 7 SP_WARD TAG_VALUE 1 Ward Tag
f-fgP MBK - Map Books Xs SP_STRTXT  TAG_VALUE 1 Street Text Tag
& £3? GRY - Query )Ks SP_STRADDR STR_CODE 1 Street Address Code
@-(3® RMS - Roads v X3  SP_STRADDR STR_NAME 1 Street Address Name v
< > < >

Figure 21  Munsys Management Console: Object Attribute Integrity
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2 Select the New Object Attribute Integrity... option on the Action menu or the context-sensitive
(right-click) menu.

ﬂ Munsys Management Console (MCITY14INT) — O 4

File  Action Help

|:_'|.1? gss;grainage A || MuniD Table Name Column Name Ak
=3 4 |rlteg'rtymgs X 63 SP_SWNODE NODE_ID 1

X Network Check Notfication X68 SP_RIVERLINE  TAG_VALUE 2

= 4 Network Node Integrty

X Y —
(3 EMS - Bectricty r New Object Attribute Integrity...
(3 MBK - Map Books

Collapse All

@-g? QRY - Query S it
@-(3® RMS - Roads Expand All
[-{3? SDM - Spatial Data Manager
& @ SMS - Sewer vile 5

New Object Attribute Integrity

Figure 22 Create new Object Attribute Integrity

The following dialog is displayed:

New Object Attribute Integrity - Drainage X

Object Attribute Integrity
Spatial Table: v

Column: v

Description: |

Rule Info

Rule Order:

Rule Type: v

Ok Cancel Help

Figure 23 New Object Attribute Integrity

3 Select the Spatial table for which you want to add an object integrity rule.
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Note

Select the Column on which you want to add the rule.
Add a Description for the rule.It is sensible to add concise, but clear descriptions.

The system will automatically provide a Rule order number which is incremental based on existing
rules.This value is not editable when first creating the rule.(To change the rule order, edit the rule
afterwards).

Select a Rule type.Munsys Integrity offers five rule types, each with different parameters. These are:

Compare Check — This rule will allow users to check the relationship between two attribute
fields of the same table.Use this rule to perform Compound Validations. The Rule takes two
parameters: An Operator and a Column name. Example - use this rule to ensure that the
start invert level of a pipe is shallower (has a bigger value) than the end invert level.

Not Null — This forces attributes to have values.

When setting a column to being Mandatory in Munsys Management Console, an Application Object
Attribute Integrity rule with a rule type of NOT NULL is automatically created. When objects are checked
using the Object Integrity checks within the Munsys Application, if a NOT NULL rule type is found, the
Attribute Marker will record the following error:

[Column_name] may not be NULL, New Object - [Table Name]

Range — Valid for NUMERICAL attributes only — the attribute must fall within a range
defined as a Minimum and Maximum range.Example: use this rule to check that service
connections are longer than 1 meter but shorter than 50 meters.And note that the dialogue
states that these values are inclusive.

Substring — This Rule allows users to validate substrings and can be applied multiple times
for the same attribute. This is similar to “Mask” integrity rules available in other
applications.Example: If you want to ensure that the Plan number for a property is valid,
you may include two rules, the first stating that the first two characters must be alpha
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New Object Attribute Integrity - Cadastral X

Object Attribute Integrity
Spatial Table: | SP_PARCEL ~
Column: | PRCL_KEY v

Description: Plan Number
Rule Info

Rule Order: 3
Rule Type: Substring v

Substring Parameters

Start Position: | 1 I

String Length | 2]

Operator: Not Equal
Value to Search:

[ Alpha Only Numeric Only
[~] Match Case

OK Cancel Help

Figure 24 Substring Alpha Only rule

and the remainder of the string must be numeric

New Object Attribute Integrity - Cadastral e
Object Attribute Integrity
Spatial Table: | SP_PARCEL v

Column: | PRCL_KEY A

Description: Plan Number
Rule Info

Rule Order: 4
Rule Type: Substring v

Substring Parameters

Start Position | JI

String Length: | 20|

Operator: Not Equal
Value to Search:

Alpha Only (4] Numeric Only
] Match Case

Figure 25  Substring Numeric Only rule
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®  Value Check — This rule allows users to check the value of an attribute against a single pre-
set value using these operators.

New Object Attribute Integrity - Cadastral X
Object Attribute Integrity
Spatial Table: | SP_PARCEL bt

Column: PRCL_KEY v

Description: Plan Number
Rule Info
Rule Order: 4

Rule Type: Substring v

Substring Parameters

Start Position | JI

String Length: | 20|

o ]

Less Than or Equal to
[ Apha Only |Greater Than
Greater Than or Equal to

Cancel Help

Figure 26 Substring Operator value selection
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Edit an existing Object Attribute Integrity

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to edit
an existing object integrity rule.

To edit an existing object integrity rule, do the following:

1  Select Object Attribute Integrity in the tree under the application under which the object falls, for
which you want to edit an object attribute integrity rule.

ﬁ Munsys Management Consale (MCITY14INT) — O X
File Action Help
'1? gﬂmﬁm . Al MinID TableName  ColumnName  RuleOrder Description ~
o gt X1 SPTOWN  TOWNCODE 1 Town Code
"4y Settings X3 SP_PARCEL  PRCL_KEY 1 Parcel Key
= X tegrty X3 SP_PARCEL  PRCL_KEY 2 Parcel Key Portion
| XE X3 SP_PARCEL  TAG_VALUE 1 Parcel Tag
G- ﬁ_l DMS - Drainage X5 SP_SUBURB  SUB_CODE 1 Suburb Code
@-(3@ EMS - Blecticty X7 SP_WARD TAG_VALUE 1 Ward Tag
f-¢a? MBK - Map Books X8  SPSTRTXT  TAGVALUE 1 Street Text Tag
@-(3 QRY -Query X9 SP_STRADDR STR_CODE 1 Street Address Code
-(3® RMS - Roads v|| X9 SP_STRADDR STR_NAME 1 Street Address Name v
< > < >

Figure 27 Select Object Attribute Integrity

2 Select the existing Object Attribute Integrity Rule in right-hand panel.

3  Select the Properties option on the Action menu or the context-sensitive (right-click) menu.

ﬁ Munsys Management Console (MCITY14INT) | — Oa *

File  Action Help

{3 Applications Al MunID TableName  ColumnName  Rule Order Description A

g CMS - CaS:;:tnr‘:T X1 SP_TOWN TOWN CODE 1 Town Code
&y Settings SP_PARCEL Parcel Key

XK Integrity X3 SP_PARCEL | X Delete Parcel Key Portion
K Object Aftribute Integrity X3 SP_PARCEL | Properties... ‘ Parcel Tag
D 1? DMS - Drainage x5 SP_SUBURB = Suburb Code
(-gal EMS - Blectricity X7 SP_WARD TAG_VALUE 1 Ward Tag
&-ga® MBK - Map Books X8 SP_STRTXT  TAG_VALUE 1 Street Text Tag
-(3? QRY -Query X3 SP_STRADDR STR_CODE 1 Street Address Code
1

@-(g RMS - Roads v|| X9 SP_STRADDR  STR_NAME Street Address Name v
< > < >

Edit Properties of Integrity Object Attribute Integrity

Figure 28  Selecting Object Attribute Integrity Properties

4 The following dialog will be displayed:
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Note

Modify Object Attribute Integrity - Cadastral
Object Attribute Integrity

Spatial Table: 5P PARCEL

Column: PRCL_KEY

Description: |Pa'rcel Key Portion
Rule Info
Rule Order:
Rule Type: Substring ~

Substring Parameters

Start Position: | 1‘
String Length: | 12|
Operator: Not Equal v

Value to Search: [000000000000

(] Alpha Only (] Numeric Only

[] Match Case

0K Cancel

Figure 29 Modify Object Attribute Integrity

Edit the values on the dialogue to match the desired rule parameters.

Note if you want to reorder Rules, it is best to first change the rule order using a different number set as

the system will not allow rules with the same order.

Once satisfied with the parameter settings, click OK to save your edits.
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Delete an Existing Object Attribute Integrity

You will need the MUNSYS_POWER or MUNSYS_ADMIN roles assigned to be able to

delete an existing object integrity rule.

To delete an existing object integrity rule, do the following:

Select Object Attribute Integrity in the tree under the application under which the object falls, for

which you want to edit an object attribute integrity rule.

Select the existing Object Attribute Integrity Rule in right-hand panel.

Select the Delete option on the Action menu or the context-sensitive (right-click) menu.

H Munsys Management Consale (MCITY14INT) — O o
File Action  Help

ﬂ ?\DDE:ﬁO:: . Al MunID  Table Name Column Name Rule Order  Description A

o X1 SP_TOWN  TOWN.CODE 1 Town Code

=-{g? CMS - Cadastral

| .4y Settings x 3 SP_PARCEL PRCL_KEY 1 Parcel Key

< * Integrity 3 SP_PARCEL, DOCL_VC Y ] Parcel Key Portion

) Obiect Attribute Integrty X3 SP_PARCEL Delete Parcel Tag

[#-{g® DMS - Drainage X5 SP_SUBURE Properties... Suburb Code

-3 EMS - Blectricty X7 SP_WARD TAG VATOE™"T Ward Tag

[#-{g? MBK - Map Books X3 SP_STRTXT  TAG_VALUE 1 Street Text Tag

|§| 3" QRY - Query X9 SP_STRADDR STR_CODE 1 Street Address Code

|§| @ RMS - Roads v xg SP_STRADDR STR_NAME 1 Street Address Name v
< > < >
Delete Integrity Object Attribute Integrity

Figure 30 Select Delete Object Attribute Integrity

The following dialog will be displayed:

Delete Object Attribute Integrity

e Are you sure you want to delete the object attribute integrity?

You have selected to delete the 'SP_PARCEL - PRCL_KEY - 2'
object attribute integrity.

Figure 31  Delete Object Attribute Integrity Notification

Click Yes to delete the Object Attribute Integrity.
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Chapter 6
Record locking

Introduction

Munsys record locking is activated by default, ensuring data integrity within the working
environment and restricting the editing of a spatial object to one user at a time. In the Munsys
Management Console, the following record locking issues are managed from the Locks tree:

Locking behavior — enabling or disabling the record locking mechanism, and setting lock
reminders for users then they log on or off.

Lock reporting and overriding — displays the current status with regard to users and
respective locked objects, and allows the database administrator to unlock objects
currently locked by users.

Record locking in the Munsys schema can be disabled permanently or temporarily.

Disable permanently — the option to clear all existing locks in the database is
recommended before record locking is disabled permanently to ensure that no locking
information is retained in the database.

Disable temporarily — this can be done to allow users with locked objects to post changes
to database, although these objects are not locked in the database. In this case, the
administrator should verify existing locks before clearing all the locks from the database.
The administrator should also ensure that users do not query any objects from the
database while the lock administration is disabled. Clearing all the existing locks may
cause problems when users try to post the changes to the database after the lock
administration is enabled again. It is therefore recommended that the administrator notify
all the users to post changes to the database before disabling the lock administration
temporarily. If any objects are still locked and the administrator ensures that these locks
can be cleared, the option to clear all the locks can be used.
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The Locks tree: overview

The Locks tree contains the Records branch, which displays a summary of the total number of
records currently locked by all users in all tables.

Clicking on Records in the Locks tree displays each user name that has locked objects, the
spatial table where the objects reside and the number of objects locked for that table. You
can drag the column headers to display in any order that you want.

ﬁ "Mun:-y: Management Console (MCITY14INT) - O X
File Action  Help
fi_.' MBK - Map Books P

User Name Table Name Locked Objects
[l
1-_f‘|__l RMS - Roads %sMCITYHINT SP_BUILDING 347 :
{3P SDM - Spatial Data Manag || & MCITY14INT SP_PARCEL 381
1-_f‘|__l SMS - Sewer g MCITYT4INT SP_TOWN 14
[P WMS - Water

5= Foles
E—]--% TablesAiews

6 Spatial Tables

ke Attribute Tables
Lookup Tables
Indexes

7 Triggers
[ |ineana W

£ >

Figure 1 Locks tree: Records
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Enabling or disabling record locking

1

Record locking is activated by default in any Munsys schema. From the Locks tree in the
Munsys Management Console, you can change record locking properties by disabling or
enabling record locking in a schema, or by changing the record locking status reminders for
users.

To be able to work with record locking properties, you need to have the following
roles/privileges assigned:

®  Munsys role: MUNSYS_ADMIN

®  Database privileges: SELECT, INSERT, UPDATE and DELETE on
MUNSYS_DB_SETTINGS

To specify record lock settings
Right-click on Locks, and then select the Properties option on the context-sensitive menu, as
seen below:

¥

¥ Appl

lications

= -

Eﬁ w Clear Locks
*jfg G | Properties...
-2 Sec
4 i Collapse All
+' Expand All
)

4@ Scheduled Tasks

Figure 2 Record Locking: Properties

The Record Locking dialog box is displayed.

Record Locking X

Settings

Enabling record locking on a Munsys schema will require
users to exclusively lock an object before any editing
can take place.

Enable Record Locking
Record Locking Status Reminders

[] Remind users at logon
[] Remind users at logoff

I R

Figure 3 The Record Locking dialog box

Select or clear the Enable Record Locking check box to enable or disable record locking in the
schema.

Recordlocking
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2 Set the record locking status reminders as required (this group is unavailable when record locking
has been disabled):

Remind users at logon reminds users that they still have objects locked when they log on to
the schema.

Remind users at logoff reminds users that they still have objects locked when they log off
from the schema

3  Click OK to apply the settings that you have specified.

Clearing all the locks in the database

Using the Clear Locks menu item, the database administrator can clear all the locks in the
database. Please note that unlocking all locked records could result in the loss of data.

To be able to clear all the locks in the database, you need to have the following roles/privileges
assigned:

Munsys role: MUNSYS_ADMIN
Database privileges: SELECT, INSERT, UPDATE and DELETE on
MUNSYS_LOCKED_OBJECT

To clear all the locks in the database

1  Right-click on Locks, and then select the Clear Locks option on the context-sensitive menu, as seen

below:
+ ﬂ? Applications
Clear Locks
Properties...
Collapse All
Expand All

4 Scheduled Tasks

Figure 4 Record Locking: Clear Locks

The following confirmation message is displayed:

Clear Locks

0 Are you sure you want to remove all record locks?

Removing record locks from the schema can result in loss of
unsaved user data.

Yes _ No

Figure 5 Clear Locks

2 Click Yes to clear all the locks in the database.

The locks are cleared, and the content pane refreshed and updated accordingly.
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Working with locked records in the database

To be able to work with locked records in the database, you need to have the following

roles/privileges assigned:

Munsys role: MUNSYS_ADMIN

Database privileges: SELECT, INSERT, UPDATE and DELETE on

MUNSYS_LOCKED_OBJECT

The Records item in the Locks tree displays the number of objects that are currently locked for

all users in all the spatial tables in the database. Selecting this item displays the following

summary list in the content pane:

ﬁ IMunsys Management Console (MCITY14INT)

File Action  Help

913' Query Categories
i85 Categories

E—J% Privilege
% Table/ Views

..52Z| Roles
E—J% Tables Miews

B
[ |ineana W
£ >

fj' MBK - Map Books || User Name Table Name Locked Objects
:ﬁg ey SIETIENT S5 BiG Erok
@ SDM - Spatial Data Manag ? MCITY14INT SP_PARCEL 1
@ SMS - Sewer g MCITYT4INT SP_TOWN 14
(-3 WMS - Water

=@ Locks

i gk Records

Figure 6 Record locking summary
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Viewing locked objects

You can view details of the objects that have been locked by a user on the Record Locking Detail

dialog box.
To access the Record Locking Detail dialog box, do the following;:

1  Right-click on an item in the summary list, and then select the Details item on the context-sensitive
menu:

ﬁ Munsys Management Console (MCITY14INT) — O b4

File  Action Help

{38 MBK - Map Books 1| User Name Table Name Locked Objects

FAciTy14INT SP_BUILDING :
i R -Foh L MCITY14INT SP_PARCEL st
@ SDM - Spatial Data Manag — = Fibnelacks
7 SMIS - Sewer & MCITY14INT SP_TOWN ear Lod
[-ggB WMS - Water

Details tooltip

Figure 7 Selecting Locked Record Details

The Record Locking Detail dialog box is displayed:

Record Locking Detail x
Detail
User: |MCITY14INT w~
Date/Time Locked Duration Locked Table Name GID &
17/11/2020 7:24:02 AM 0d 00:00:059 SP_STRADDR 54300
17/11/2020 7:24:02 AM Od 00:00:05 SP_STRADDR 54337
17/11/2020 7:24:02 AM Od 00:00:05 SP_STRADDR 54348
17/11/2020 7:24.02 AM Od 00:00:09 SP_STRADDR 94338
17/11/2020 7:24:02 AM 0d 00:00:05 SP_STRADDR 94345
17/11/2020 7:24:02 AM 0d 00:00:059 SP_STRADDR 54302
17/11/2020 7:24:02 AM Od 00:00:05 SP_STRADDR 54333
17/11/2020 7:24:02 AM Od 00:00:05 SP_STRADDR 94303
17/11/2020 7:24:02 AM Od 00:00:09 SP_STRADDR 594319
17/11/2020 7:24:02 AM Od 00:00:05 SP_STRADDR 84321
17/11/2020 7:24:02 AM 0d 00:00:059 SP_STRADDR 54179
17/11/2020 7:24:02 AM Od 00:00:08 SP_STRADDR 54180
17/11/2020 7:24:02 AM 0d 00:00:059 SP_STRADDR 54187
17/11/2020 7:24:02 AM Od 00:00:05 SP_STRADDR 54185
17/11/2020 7:24:02 AM Od 00:00:05 SP_STRADDR 54182
17/11/2020 7:24:02 AM Od 00:00:09 SP_STRADDR 54181
17/11/2020 7:24:02 AM Od 00:00:05 SP_STRADDR 54183
17/11/2020 7:24:02 AM 0d 00:00:059 SP_STRADDR 54156
17/11/2020 7:24:02 AM Od 00:00:08 SP_STRADDR 54184
17/11/2020 7:24:02 AM 0d 00:00:059 SP_STRADDR 54157
17/11/2020 7:24:02 AM Od 00:00:05 SP_STRADDR 54198 v
Unlock Refresh
Close Help

Figure 8 The Record Locking Detail dialog box
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Unlocking locked objects

2
3

You can clear the objects that have been locked by a user by right-clicking on an item in the
summary list, and then selecting the Clear Locks item on the context-sensitive menu, as seen
below:

5 MMunsys Management Console (MCITYT14INT) = O X
File  Action Help
@ Applications User Name Table Name Locked Objects
8 MCITYT4INT SP_STRADDR

Details...

Clear Locks

1;%' Query Categories

Ty Security
Privilege
Tables/Views
Lineage

Scheduled Tasks

Clear locks tooltip

Figure 9 Selecting Clear Locks Option

You can also unlock locked objects from the Record Locking Detail dialog box:

Select the object(s) that you want to unlock, and then right-click on one or more selected records to
display a context-sensitive menu that you can use to clear selected records for unlocking.

Record Locking Detail e
Detail
User: [MCITY14INT |
Date/Time Locked Duration Locked Table Name GID )
17/11/2020 7:24:02 AM 0d 00:01:53 | SP_STRADDR 54300
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR |3} Unlock
17/11/2020 7:24:02 AM 0d 000153 SP_STRADDR |
17/11/2020 7:24:02 AM 0d 000153 SP_STRADDR | % Refresh
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54349
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 34302
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54339
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54303
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54319
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54321
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 84179
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54130
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54187
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54135
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54132
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54131
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54133
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 34156
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54134
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54157
17/11/2020 7:24:02 AM 0d 00:01:53 SP_STRADDR 54158 v
[ Unlock Refresh
Close Help
Figure 10 The Record Locking Detail dialog box: unlocking locked objects

Records can also be unlocked by using the Unlock button on the Record Locking Detail dialog box.

Click Refresh to refresh the dialog box once you have unlocked the locked records.
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Chapter 7
Query Categories

Introduction

Munsys Query categories are maintained from the Query Categories tree in the Munsys
Management Console (MMC). You need to have the MUNSYS_POWER or
MUNSYS_ADMIN roles assigned to be able to manipulate query categories.

Munsys recognizes the following types of query categories:

Uncategorized — by default any new query (not a user query) is seen as being
uncategorized until it has been allocated to a category. Queries may be moved to or from
the uncategorized group, but the category itself is a special case whereby the name may
not be changed — only the content. The uncategorized group may also not be granted
other roles — all queries in this group are seen to be granted the MUNSYS_ALL_QUERY
role. As soon as a query is moved to a category or as a user query, it cannot also belong to
the uncategorized group — the query no longer has this status.

User — whenever a user creates a new query, it is automatically seen as a personal query,
hence called a User query. Other users cannot see any other user’s queries until they are
shared in the pool of Uncategorized or Categorized queries.

Custom Categories — each category is provided with a unique name. When a new category
is created, it is automatically granted the MUNSYS_ALL_QUERY role. A category may
be granted multiple roles.

Munsys provides default custom categories as part of a new Munsys schema. The power user
can customize these and/or add personal categories. The following categories are created in a
new schema, synonymous with the Munsys applications and the default roles will be granted
to these categories:

Fiber - MUNSYS_CFS_QUERY

Cable Routes — MUNSYS_CRS_QUERY
Cadastral - MUNSYS_CMS_QUERY
Drainage —- MUNSYS_DMS_QUERY
Electricity - MUNSYS_EMS_QUERY
Roads — MUNSYS_RMS_QUERY

Sewer — MUNSYS_SMS_QUERY

Water —- MUNSYS_WMS_QUERY
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The Query Categories tree: overview

Note

The Query Categories main tree consists of three branches (nodes):

When an existing Munsys schema is upgraded to a Munsys 14 schema, all system queries are classified

as uncategorized, and the power user/administrator will be required to move these into categories.

m  Categories — allows the user to create and/or delete categories and provides a mechanism for

the user to allocate roles to categories.

= Queries — the properties of the queries are not edited here, but the user may arrange queries

into various categories. The visibility of queries within a category will be restricted by the

roles granted to a user. However, in the MMC the power user has the right to see all queries

and categories regardless of roles granted, having the responsibility to arrange the queries

and query categories.

= Roles — contains the roles that exist in the database and have been granted to the various

query categories.

ﬁ Munsys Management Consale (MCITY14INT)

Eile Action  Help

-0 Applications [#-85 <<Lineage Queres>>
+-8 Locks (- <<Uncategorized Queries>>
B [#-85 Cable Fibers
[+ Cable Routes
(-5 Cadastral
[#-55 Drainage
- (-5 Blectricity
5B Privilege (-5 Roads
4 Tables/\Views (-3 Sewer
+- I8 Lineage -85 Water
443 Scheduled Tasks |J:r| A Water (Abandoned)
35 Water (Potable)
(-3 Water (Raw)

(-3 Water (Reclaimed)

Figure 1 Munsys Management Console: Query Categories tree

The sub-trees within the Query Categories tree are displayed when a user has the

MUNSYS_POWER or MUNSYS_ADMIN role assigned. For more information about the

various Munsys roles, see Chapter 8: Security in the Munsys Management Console.
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Creating a new query category

2

To be able to create a new query category, you need to have the following roles/privileges
assigned:

= Munsys role: MUNSYS_POWER or MUNSYS_ADMIN
®  Database privileges: UPDATE on query-related tables

To create a new query category

Right-click on the Categories node of the Query Categories tree, and then select the New
Category... option on the context-sensitive menu.

=-235 Query Categories

. El i
: Bci New Category...

= Roles Collapse Al
Expand All

Figure 2 Creating a new Query

The New Query Category dialog box is displayed:

New Query Category X

Category Info

Name :

[y New Guery Categony

Privileges

Grant access to the following roles :

] MUNSYS_ADMIN Py
[C] MUNSYS_ALL_EDIT
] MUNSYS_ALL_QUERY
] MUNSYS_CFS_EDIT
[] MUNSYS_CFS_QUERY
[C] MUNSYS_CMS_EDIT
] MUNSYS_CMS_QUERY
] MUNSYS_CRS_EDIT
[] MUNSYS_CRS_QUERY
] MUNSYS_DMS_EDIT

Figure 3 The New Query Category dialog box

On the New Query Category dialog box, do the following:

= Specify a name for the new query category, with a maximum of 40 characters. Query

categories are uniquely named in a schema; a new query category name must therefore not
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already exist in the MUNSYS_QUERY_CAT table. The name may also not begin or end

with the characters << or >>, as this sequences denotes system reserved names.

Grant access to the query category by selecting the appropriate Munsys role(s) from the list
that is provided. The MUNSYS_ALL_QUERY role is granted access to a new query
category by default.

3  Click OK to create the new query category.
The new query category is saved in the MUNSYS_QUERY_CAT table.
Renaming a query category
To be able to rename a query category, you need to have the following roles/privileges assigned:
Munsys role: MUNSYS_POWER or MUNSYS_ADMIN
Database privileges: UPDATE on MUNSYS_QUERY_CAT

To rename query category

1  Inthe Query Categories content pane, right-click on the category that you want to rename, and then
select the Rename option on the context-sensitive menu, as seen below:

+ B Water (Raw)

4] &Y Water (Reclaimed
:

- <<Uncategorize Rename
3 Delete

Collapse All
Expand All

W' View as Tree

View as List

Privileges

Figure 4 Rename Query Categories

2 Specify a new name for the query category, with a maximum of 40 characters. Query categories are
uniquely named in a schema; a new query category name must therefore not already exist in the
MUNSYS QUERY_CAT table. The name may also not begin or end with the characters << or >>,
as this sequences denotes system reserved names. If the new name that you want to give to the query
already exists, an error message to this effect is displayed.
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Changing access to a query category

With this function, you can view or modify the access to a selected query category. You will need
to have the following roles/privileges assigned:

=  Munsys role: MUNSYS_POWER or MUNSYS_ADMIN
®  Database privileges: UPDATE on MUNSYS_QUERY_CAT, MUNSYS_PRIV

To change access to a query category

1  Inthe Query Categories content pane, right-click on the category that you want to modify, and then
select the Privileges option on the context-sensitive menu.

The Query Category Privileges dialog box is displayed.

Query Category Privileges X

Category Info
Name :
Water (Reclaimed)

Privileges

Grant access to the following roles :

MUNSYS_ADMIN A~
MUNSYS_ALL_EDIT

[ MUNSYS_ALL_QUERY

] MUNSYS_CFS_EDIT

[] MUNSYS_CFS_QUERY

] MUNSYS_CMS_EDIT

[C] MUNSYS_CMS_QUERY

] MUNSYS_CRS_EDIT

] MUNSYS_CRS_QUERY

[J MUNSYS_DMS_EDIT

[] MUNSYS_DMS_QUERY

[C] MUNSYS_EMS_EDIT

[] MUNSYS_EMS_QUERY

(] MUNSYS_LICENSE v

Figure 5 The Query Category Privileges dialog box

2 Onthe Query Category Privileges dialog box, change the access to the query category by selecting
or clearing the check boxes adjacent to the roles displayed in the list.

3  Click OK to save the changes to the database.
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Deleting a query category

When a query category is deleted, all the references to the queries in that category are removed
and the queries are marked as Uncategorized. To be able to delete a query category, you need to
have the following roles/privileges assigned:

Munsys role: MUNSYS_POWER or MUNSYS_ADMIN
Database privileges: UPDATE on MUNSYS_QUERY_CAT, MUNSYS_PRIV

To delete a query category

1  Inthe Query Categories content pane, right-click on the category that you want to delete, and then
select the Delete option on the context-sensitive menu.

The Delete Query Category confirmation dialog box is displayed:

Delete Query Category

Are you sure you want to delete the "Water (Reclaimed) query
category?

This operation will remove all references to the queries in this

category and mark them as < <Uncategorized> >,
This operation cannot be undone.

Yes | No

Figure 6 The Delete Query Category dialog box

2 Click Yes on the Delete Query Category confirmation dialog box to delete the query category.

The query category is removed from the MUNSYS_QUERY_CAT table. Any reference
between the queries and the category are removed from the MUNSYS_PRIV table, and any
queries that belonged to the category are moved to the <<Uncategorized>> category.
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Working with queries in a query category

The Queries item in the Query Categories tree of the Munsys Management Console is used to
maintain queries within a query category. The queries can be viewed as either a tree or a list.
The view is set by right-clicking on Queries, and then selecting the View as Tree or View as List

option.

®  The View as Tree option displays the queries in a tree control, with the top level of the tree

containing the query category and the sub-level containing queries that belong to the

various categories.

ﬁ Munsys Management Console (MCITY14INT) O >
Eile  Action Help
- Applications - cclineage Queries>> A
#-(@ Locks =8
=k Rename
Delete
Collapse All
; . Privilege Expand All
529 Tables/Views - View as Tree |
® Lineage : *\,. N N
L..d) Scheduled Tasks View as List
[ Cable Privileges
- Cada
- Drainage
-3 Blectrcity
- Roads
- Sewer
E] ! Water v
View queries as a tree
Figure 7 View queries as tree
®  The View as List option displays a sortable multi-column list.
ﬁ IMunsys Management Console (MCITY14INT) O x
File  Action Help
& i 4 )\ng:catjons Query Name Category Priority
i Quer: Categories .Cable Fiber Dimension Notes
T : *¥ Cable Fiber Dimensions Copy to Category... 56.40
i e Cable Fiber Notes Move to Category... 56.30
i ** Cable Fiber Symbols 56.50
G- *y Fiber Cables Rename 56.10
5 *\, Fiber Paths 3 Delete 56.20
- BB Tables/Views *, Qry: Fiber Cable by Type 5 56.21
2B Lineage *y, Quy: Fiber Path by Service View as Tree 56.22
43 Scheduled Tasks ", Qry: Fiber Strand Court (in Use) |\/ View as List 56.23
XacCable Route Dimension Notes = o 55.41
**Cable Route Dimensions Query Priority... 55.31
%acCable Route Labels Cable Routes 55.51
*y, Cable Route Links Cable Routes 5521
** Cable Route Nodes Cable Routes 55.24
FacCable Route Notes Cable Routes 55.42
**Cable Route Symbols Cable Routes 5522 ¥
View queries as a list
Figure 8 View queries as list
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Using the context-sensitive (right-click) menu, queries can be:
= Copied to other categories

= Moved to another category

®  Renamed

®  Deleted

= Assigned a query priority

ﬁ IMunsys Management Censole (MCITY14INT) = O *
File  Action Help
*‘ﬂ Applications Query Name Category Priority A
ra E"L:: Categories FacCable Fiber Dimension Notes Cable Fibers 56 60
P ++ Cable Fiber Dimensions o
tﬂcCable Fiber Notes Copy to Category... 56.30
** Cable Fiber Symbols Move to Category... 56.50
52 '\,.FberCables 56.10
B Privilege *, Fiber Paths n— 56.20
. B2 Tables/Views *y Qry: FiberCable by Type | 2 Delete 56.21
4 Lineage K&y; Fiber Path by Service Vi - 56.22
1) Scheduled Tasks * Qry: Fiber Strand Court (In Us R 56.23
E'ﬁ Cable Route Dimension Notes v/ View as List 5541
&+ Cable Route Dimensions . 55.31
facCable Route Labels i ikl 55,51
* Cable Route Links Cable Routes 5521
*.¥ Cable Route Nodes Cable Routes 5524
%acCable Route Notes Cable Routes 55.42
**Cable Route Symbols Cable Routes 5522 ¥

Figure 9 View query options

Copying a query to one or more categories

1  Right-click on the query that you want to copy, and then select Copy to Category... from the
context-sensitive menu.

Tip Ifyou are copying a query to the same category it is currently associated with, you will have the option to

replace the query, which retains the QRY _ID of the original query, but replaces the content of the query
in the MUNSYS QUERY table.

The Copy Query dialog box is displayed, showing the name of the query that you have selected.
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Tip

Copy Query X

Destination

Query :
[Cable Fiber Dimensions|

Query Categories

[[] «<Lineage Queries>> A
[ «<Uncategorized Queries...

[] Cable Routes

[ Cadastral

[] Drainage

[] Bectricity

[C] Roads

[1 Sewer

[] Water

[[] water (Abandoned)

] Water (Potable)

[] water (Raw)

[ Water (Reclaimed) i

Cancel Help

Figure 10 The Copy Query dialog box

Change the query name if required.

From the Query Categories list, select the category(ies) that you want the query copied to by
checking the boxes, and then click OK.

A copy of the query is created for each of the categories that you selected. The query name remains
the same, but a new QRY_ID is assigned for each copy.

Moving a query to another category

When a query is moved to another category, the QRY_ID and the query record in the
MUNSYS_QUERY table stay the same, but the MUNSYS_QUERY_CAT table is updated to
change the category reference to the query.

To move a query to another category, do the following:

Right-click on the query that you want to move, and then select Move to Category... from the
context-sensitive menu.

The Move Query dialog box is displayed, with the current category of the query excluded.
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Move Query - Cable Fiber Dimensions

Category

Query Category:
<<Lineage Queries>> v

oK Cancel Help

Figure 11~ The Move Query dialog box

On the Move Query dialog box, select the category that you want to move the query to from the

Query Category list.

The query is moved to the selected category. If a query with the same name already exists within the
new category, an error message will be displayed, and you will not be able to move the query.

Move Errors

Unable to move query ‘Cable Fiber Notes',

Routes’.

X

Query 'Cable Fiber Notes’ already exists in category 'Cable

Figure 12 Move Query Warning Message
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Renaming a query

1  Right-click on the query that you want to rename, and then select Rename from the context-sensitive
menu.

2 Enter a new name for the query.

The query is renamed and the record in the MUNSYS_QUERY table is changed accordingly.
If a query with the same name already exists within the category, an error message will be
displayed, and you will not be able to rename the query.

Deleting a query

Right-click on the query that you want to delete, and then select Delete from the context-
sensitive menu.

The following message is displayed:

Delete Query

e Are you sure you want to delete the ‘Cable Fiber Symbols’
query?

This operation cannot be undone.

Yes No

Figure 13 Delete Query warning message

3  Click Yes to delete the query.
The query is deleted from the MUNSYS_QUERY table, and the association with the query
category is deleted from the MUNSYS_QUERY_CAT table.

Tip If you want to remove a query from a query category, but do not want not delete the query from the
database, use the Move to Category... item on the context-sensitive menu.

Setting a query priority

The query priority of any query determines which objects will be queried on top of others. You
have to have the MUNSYS_POWER role assigned to be able to set a query priority.

1  Right-click on the query for which you want to set/change the priority, and then select Set Query
Priority... from the context-sensitive menu.

The Query Priority dialog box is displayed.
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Query Priority - Cable Fiber Symbols X

Priortty (56.5)

Query Priority (0to 100): 56.5

Figure 14  The Query Priority dialog box

2 Enter a value between 0 and 100. Clicking on the arrows will increment the priority by a whole
number; decimal numbers have to be entered manually. A low number means that the query will be
executed before queries with higher numbers. This means that queries with a higher number will be
executed towards the end of the query process, causing the objects with a higher priority to be placed
on top of the objects queried from queries with a low query priority.

3  Click OK to assign the query priority to the selected query.

Working with query category roles

The Roles tree item in the Query Categories tree of the Munsys Management Console is used
to maintain access privileges to query categories. When the Roles tree item is activated, all
Munsys roles (MUNSYS_) are displayed in a tree view control in the content pane. The tree
contains all the available MUNSYS_roles as the top level nodes, and the query categories as the
sub-level nodes.

ﬁ Munsys Management Console (MCITY14INT) — O X
Eile Action  Help
-8 Applications ERE= MUNSYS_ADMIN A
+-f8 Locks | .87 <<lineage Queries>>
—}-33 Query Categories 35 <<Uncategorized Queries>>
85 Categories 85 Cable Fibers
B Queries 535 Cable Routes
%= Roles 335 Cadastral
¥ 55 Security 35 Drainage
] Privilege 335 Blectricity
+- Tables/Views 335 Roads
4 Lineage S35 Sewer
19 Scheduled Tasks a5 Water

-85 Water (Abandoned)
-85 Water (Potable)
-85 Water (Raw)

-8 Water (Reclaimed)

| MUNSYS_ALL_EDIT
+--@= MUNSYS_ALL_QUERY
|+|£ MUNSYS_CFS_EDIT

When you right-click on a role in the content pane, the context-sensitive menu can be used to
change the privileges for accessing categories by:

= Removing access to query categories from a role — revokes access from a role so that it no
longer has access to any query categories.

Query Categories



®  Granting or revoking access of a role to multiple query categories — changes the access that

a particular role has with regard to various query categories.

Bl Munsys Management Console (MCITY14INT) - O X

File  Action Help

- Applications

| = A
5@ Locks : a% <cLineage 5( Remove All Query Categories

_ @ Query Categories 8§ <<Uncateg Query Category Privileges...

- .53 Categories 83 Cadastra

§ B Queries 54 Drainage Collapse All

- {65 Roles 53 Bectriciy Expand

: All

-85 Security 35 Roads i

+ Privilege 35 Sewer

+)-=5g Tables/Views 54 Water

+ Lineage 85 Water (Abandoned)

“+J) Scheduled Tasks | -85 Water (Potable) v

Revoke all query categories

= When you right-click on a query category assigned to a role in the content pane, you can
remove the access from the role to which it has been assigned using the Remove Privilege
from Role context-sensitive menu item. You will be prompted for confirmation before
access is removed for the role.

B Munsys Management Console (MCITY14INT) . O X
File  Action Help
7-( Applications 82 MUNSYS_ADMIN A
-3 Locks RCEE] o
= 8 <<Uncategorized Gl 9 Remove Category from Role
.--8= Cable Fibers
.88 Cable Routes Collapse All
i--84 Cadastral Expand All
1% Security 5‘35‘ Drainage
- Privilege -85 Electricity
+ Tables/Views -85 Roads
4 Lineage -85 Sewer

43 Scheduled Tasks -3 Water

-85 Water (Abandoned)

Removing all query categories from a role

With this function, you can revoke access to query categories from a selected Munsys role.
When this is done, all the entries associated with the role are removed from the
MUNSYS_PRIV table.

1  Right-click on the appropriate role in the content pane, and then select Remove All Query
Categories from the context-sensitive menu.

Query Categories

78



2

File  Action Help

ﬂ [Munsys Management Conscle (MCITY14INT)

@ Applications
@[3 Locks
)83 Query Categories

Privilege
Tables/\Views

: Lineage
H. 1\{) Scheduled Tasks

Revoke all query categories

Remove All Query Categories

Query Category Privileges...

Collapse All
Expand All

The following message is displayed:

Remove Privileges

Are you sure you want to remove all query categories
from the 'MUNSYS_ADMIN' role?

Figure 15  The Remove Privileges dialog box

Click Yes to remove access to all the query categories from the role.
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Granting or revoking access of a role to multiple query categories

1  Right-click on the appropriate role in the content pane, and then select
Query Category Privileges... from the context-sensitive menu.

H IMunsys Management Console (MCITY14INT) - O X

File  Action Help

-8 Applications [-@&) MUNSYS_ADMIN A
4@ Locks SR MUNSYS_ALL_EDIT

-1-83 Query Categories 8 <<lineage Qu{ ) Remove All Query Categories

| -8F Categories . -88 <«Uncategoriz

- Queries .32 Cadasral | Query Category Privileges..

L a ’Sfcf::'? E g:::;; Collapse Al

o1& Privilege | 33 Roads Expand All

* Tables/Views . 33 Sewer

+-8f§) Lineage [ 33 Water

L.41) Scheduled Tasks . =3 Water (Abandoned) v

Query category privileges

The Query Category Privileges dialog box is displayed, showing the query categories to which access
has already been granted for the role, as well as the query categories that are available to the role.

Query Category Privileges X

Role

Name: |MUNSYS_ALL_EDIT

Query Categories
Available Query Categories: Query Categories Granted:
Cable Fibers <<lineage Queries>> A

<<Uncategorized Quenes>>
Cable Routes

Add > Cadastral
< Bemove Drainage

Blectricity

Roads
Sewer
Water

Water (Ahandnnad)
< >

Cancel Help

Figure 16  The Query Category Privileges

2 Add or remove the query categories to the role as required.
3  Click OK to apply any changes that you have made.
The MUNSYS_PRIV table is updated accordingly.
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Note

Chapter 8

Security

Introduction

In the Munsys Management Console, security management consists of the creation and
maintenance of database users and roles. Database users and roles are managed on the Security
tree. Roles place users in a “category” where certain responsibilities are associated with these
roles. Depending on the role of a user, varying components and/or menu items in the console
will be available for manipulation. The Munsys Management Console recognizes the
following roles:

*MUNSYS_ADMIN - this role is reserved for users who have the authority to change
structure such as creating, dropping or validating schemas, tables or views, re-indexing
tables, overriding object locking status, or manipulating database users and the roles or
privileges that may be assigned to them.

MUNSYS_POWER - this role is reserved for users who have the authority to change the
content of items such as rules, lookup tables and application settings.

MUNSYS_APP_EDIT — users with this role assigned can create and modify objects in a
specified Munsys application only (where APP is the relevant application, for example
MUNSYS_CDS_EDIT or MUNSYS_DRN_EDIT)

MUNSYS_ALL_EDIT - users with this role assigned can create and modify objects in all
of the Munsys applications

MUNSYS_APP_QUERY — users with this role assigned can query objects from a specific
Munsys application only (where APP is the relevant application, for example
MUNSYS_CDS_QUERY or MUNSYS_DRN_QUERY)

MUNSYS_ALL_QUERY - users with this role assigned can query objects from all the
Munsys applications

Having the MUNSYS_ADMIN role assigned is not enough to create and manipulate objects; Oracle
expects other privileges to also be assigned to a user as well before objects such as tables, etc. can be
created or manipulated. The database administrator has the ability to still restrict other privileges in respect
of a user with the MUNSYS_ADMIN role assigned.
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The Security tree: overview
The Security tree consists of two branches (nodes):
1  Users —used for the creation and maintenance of users in the database. When you click on Users in

the Security tree, the content pane displays the relevant user name, with all the assigned Munsys
roles as sub-items. Right-clicking on an item displays a context-sensitive menu, from which user

maintenance can be done.

ﬂ IMunsys Management Console (MCITY14INT)
Eile Action  Help
+-{g# Applications - & APEX_040200
: Locks CTXSYS
3 Query Categories DBSNMP
-85 Categories DVF
i Queries DVSYS
i.% Roles GSMCATUSER
. -ly Securty - & GSMUSER
5 Users 4 LBACSYS
4= Roles g ,,;a
!5 Privilege & MCITY12US
E Table NViews * MDDATA
i..g3| Roles & MDsYS
% Tables/Views & OIVNSYS
Spatial Tables L. & OLAPSYS
g g Attribute Tables ORDSYS
u Lookup Tables QUTLN
Indexes PERCY
i ' Triggers PERCY_APPS
* % Lineage ; SCOTT
+i} Scheduled Tasks 9 SF’ATIAL CSW ADMIN USR
Figure 1 Security tree: Users
Note You have the option of displaying all the database users, or only the Munsys users. This is set by selecting

a user, and then selecting the Display all Users or Display Munsys Users option on the Action menu or
the context-sensitive (right-click) menu.
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ﬂ Munsys Management Console (MCITY 14INT) — O x

File  Action Help

APEX_040200 "
CTXSYS

DBSNMP

DVF

DVSYS

GSMCATUSER

GSMUSER
LBACSYS
MCITY1] Assign Roles...

MDDAT.
MDSYS x DTUP User

QUVMS :

e s‘rl" Display All Users
OHDSY‘ Display Munsys Users
2 OUTLN
PERCY Collapse All
PERCY | Expand All
SCOTT .
SP M'I N Properties... .

B
-

)C'Jtlgﬁﬁ’ihﬁlhhhhﬁﬁﬁﬁhhbbhhhb

=

':| a Tables/Views
Spatial Tables
Atibute Tables
Lookup Tables

Indexes -
Triggers -

Elﬁ Lineage
‘il Scheduled Tasks

oo

Display Munsys and other users

Roles —used for maintenance of the database roles and the creation of Munsys roles. When you click
on Roles in the Security tree, the content pane displays all the database roles, with their assigned
users as sub items. Right-clicking on an item displays a context-sensitive menu, from which role
maintenance can be done.

E Munsys Management Console (MCITY14INT) = O X
Eile  Action Help
-3 Applications -2 MUNSYS_ADMIN
' Locks [+-&&] MUNSYS_ALL_EDIT
[=-35 Query Categories (-85 MUNSYS_ALL_QUERY
P -8 MUNSYS_CFS_EDIT
- &5 MUNSYS_CF5_QUERY
-G MUNSYS_CMS_EDIT
lfl-i% MUNSYS_CMS_QUERY
-85 MUNSYS_CRS_EDIT

5
I

(82| MUNSYS_CRS_QUERY
(85| MUNSYS_DMS_EDIT
-85 MUNSYS_DMS_QUERY
' : 82| MUNSYS_EMS_EDIT
2 g Tables/Views -8 MUNSYS_EMS_QUERY

Spatial Tables @2 MUNSYS_LICENSE
Attribute Tables &= MUNSYS_MBK_EDIT
I Lookup Tables g2 MUNSYS_MBK_QUERY
Indexes =/ MUNSYS_POWER
T Triggers =/ MUNSYS_QRY
u @ Lineage 4| MUNSYS_RMS_EDIT

1) Scheduled Tasks 25 MUNSYS_RMS_QUERY
82/ MUNSYS_SDM_EDIT
4= MUNSYS_SDM_QUERY
4=/ MUNSYS_SMS_EDIT
25 MUNSYS_SMS_QUERY
-8 MUNSYS_WMS_EDIT
[@-4=] MUNSYS_WMS_QUERY

&-
-
-
&-
-
e

Figure 2 Security tree: roles
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Working with Munsys users

Using the context-sensitive (right-click) or Action menu, you can create a new user, assign roles
to a user, drop a user, change the role assignment of a user or revoke a role from a user.

MNew User...

Display All Users

-G=| Rol

E% Tables.

Spa Collapse all
% Lo Expand Al

Display Munsys Users

Indexes T

Assign Roles...
Drop User

Display All Users

Display Munsys Users

Collapse Al
Expand Al

Properties...

Creating a new Munsys user

When a new Munsys user is created, the MUNSYS_ALL_QUERY and CONNECT roles are

assigned by default.

1  To create a new Munsys user, do one of the following:

m  Click on Users in the Security tree, and then select New User... from the Action menu

m  Right-click on Users in the Security tree, and then select New User... from the context-sensitive

menu.

The User Details dialog box is displayed, showing the User Details tab.

User Details
User Info  Assign User Roles

User Details

Enter the user details below.

User Name : |

Password : |

Confirm Password : I

Account Security

Specify the user security settings below.

Status O Locked

@®) Unlocked

] Expire Password

Figure 3 The User Details dialog box: User Details tab
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Under User Details, enter the following information for the new user:

®  the user name

m  password

m  password confirmation

Under Account Security, you can lock a user, or expire a user’s password.

Click the Assign User Roles tab to assign Munsys roles to the new user. The
MUNSYS_ALL_QUERY role is assigned by default.

User Details X

User Info  /

Use the lists below to manage roles for the user.

Available Roles : Assigned Roles :
MUNSYS_ADMIN A MUNSYS_ALL_QUERY
MUNSYS_ALL_EDIT
MUNSYS_CFS_EDIT
MUNSYS_CFS_QUERY
MUNSYS_CMS_EDIT
MUNSYS_CMS_QUERY
MUNSYS_CRS_EDIT =
MUNSYS_CRS_QUERY < Remove
MUNSYS_DMS_EDIT

MUNSYS_DMS_QUERY

MUNSYS_EMS_EDIT

MUNSYS_EMS_QUERY

MUNSYS_LICENSE

MUNSYS_MBK_EDIT

AL IBICWE BANK MIEOW

Figure 4 The User Details dialog box. Assign User Roles tab

Select the check box adjacent to the role that you want to add or remove, and then use the Add or
Remove buttons as required.

When you have specified all the details for the new user, click Commit to save the new user to the
database.
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Changing user properties

Tip

Using the Properties option on the context-sensitive menu or the Action menu when a user
name is selected, the password, security settings and role allocation for a user can be changed.

To change user properties, do the following:

Select a user name in the content pane, and then choose either
Action > Properties, or the Properties option on the context-sensitive menu.

The User Details dialog box is displayed, showing the User Details tab.

User Details - MCITY14NT *
User Info  Assign User Roles

User Details

Enter the user details below.

User Name : [MCITY14INT |

Password :

Confirm Password |“““‘ |

Account Security

Specify the user security settings below.

Status () Locked ® Unlocked

[] Expire Password

Cancel Help

Figure 5 The User Details dialog box. Properties

Change the user details or account security as required.
On the Assign User Roles tab, add or remove roles from the user.

Click Commit to save the changes to the database.

Selecting the Assign Roles option from the context-sensitive or the Action menu when a user is selected
directly displays the Assign User Roles tab.
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Dropping a user

To drop a user do the following:

1  Right-click on the user name, and then select the Drop User option from the context-sensitive menu,
or select the Drop User menu item from the Action menu.

2 The following confirmation message is displayed:

Drop User

0 Are you sure you want to drop user "MCITY14NT'?

User "MCITY14HMNT" still owns objects, Dropping the user will
also remove the objects owned by the user,

Figure 6 Drop user confirmation message

Working with Munsys roles

In the Munsys Management Console, Munsys roles are created and maintained from the Roles
item in the Security tree. You have the option of displaying all the database users in the content
pane, or only the Munsys users. This is set by selecting a user, and then selecting the Display all
Users or Display Munsys Users option on the Action menu or the context-sensitive (right-click)
menu.

Creating a new Munsys role

To create a new Munsys role, do the following:

1  Select Roles in the Security tree, and then select the New Munsys Role option on the Action menu,
or right-click on Roles in the Security tree, and then select the New Munsys Role option from the
context-sensitive menu.

The New Munsys Role dialog box is displayed.

MNew Munsys Role X

Role Info

Role Details

Role Name - MUNSYS_I

Cancel Help

Figure 7 The New Munsys Role dialog box

2 On the New Munsys Role dialog box, enter a name for the role, and then click Commit to save the
new Munsys role to the database.
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Dropping a role from the database

To drop a role from the database, do the following:

1  Right-click on the role that you want to drop in the content pane, and then select the Drop Role
option from the context-sensitive menu, or select the Drop Role menu item from the Action menu.

2 The following confirmation message is displayed:

Drop Role

0 Are you sure you want to drop the "MUNSYS_ALL_EDIT role?

Dropping the "MUNSYS_ALL_EDIT role will remove it
permanently from the database.

Figure 8 Drop Role confirmation message

3  Click Yes to drop the role from the database.
Revoking a role from a user

To revoke a role from a user, do the following:

1  Right-click on a user name in the content pane, and then select the Remove option from the context-
sensitive menu, or select the Remove option from the Action menu.

2 The following confirmation message is displayed:

Revoke Role

Are you sure you want to revoke the "MUNSYS_ALL_EDIT role
from the "MCITY12INT user?

Revoking the ‘'MUNSYS_ALL_EDIT role from the user
"MCITY12INT will prevent the user from accessing objects that
require this role.

Figure 9 Revoke Role confirmation message

3 Click Yes to remove the role from the user.
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Chapter 9

Privilege

Introduction

In the Munsys Management Console, privilege management consists of granting or revoking
privileges on database objects to the users. The administrator can grant or revoke privileges
assigned to the Munsys roles on a table or view and visa-versa.

The Munsys roles are a collection of privileges or access rights to the various tables and views
in the Munsys schema. The administrator assigns a user to Munsys role and then assigns the
role to a spatial table or spatial view. They then grant the role a combination of SELECT,
INSERT, DELETE and/or UPDATE privileges for that spatial table or spatial view.

SELECT - roles with this privilege can select data from a database object. This is used
when users run any of the queries to which they have access in the Munsys applications.

INSERT - roles with this privilege can insert rows into a spatial, attribute or lookup table.
This is used when users post new objects to the database or when a user with the

MUNSYS_POWER role edits the lookup table values in the Munsys Management

Console application.
DELETE - roles with this privilege can delete objects from the table or view.

UPDATE - roles with this privilege assigned can modify existing data in the Munsys
tables. This is used when using any of the change commands in the Munsys applications.



The privilege tree: overview

The Privilege tree consists of two branches (nodes):

1  Tables/Views — used for assigning roles to the tables and views. When you click on Tables/Views
in the Privilege tree, the content pane displays all the table and views in the schema. Right-clicking
on an item displays a context-sensitive menu, where the administrator can assign a role to a table or
view.

ﬂ Munsys Management Console (MCITY14INT) — O *®

File Action  Help

+)-{g Applications --Eeeg ALL_MUNSYS_APPLICATION ~
_@ Locks --eeg ALL_MUNSYS_AT
- & Records =58 ALL_MUNSYS_QUERY

=8 ALL_MUNSYS_SP_COLUMNS
--egg ALL_MUNSYS_SP_TABLES
=8 AT_BLDG_FLOOR_INFO
=8 AT_BLDG_ROOM_INFO
=g CMS_BLDGINFO_VW
=55 FIN_ACCT_NO
228 FIN_EREADINGS
=58 FIN_WREADINGS

=) r§.‘ Query Categories

=] lege e
Table Views +-B5g GEN_DWGCAT
‘.-5= Roles +-e88 LU_CMS_BLDTYPE
=B Tables/Views B8 LU_CMS_DENSITY
- Hgy Spatial Tables i LU_CMS_EASETYPE
. B Mtribute Tables ® LU_CMS_LANDUSE
-} Lookup Tables +-B5g LU_CMS_LSTATUS
LB Indexes +)-85g LU_CMS_PRCLTYPE
& Triggers ) LU_CMS_STRNAME
E.lm Lineage +-#5g LU_CMS_SUBNAME
% Spatial Tables +)-H5g LU_CMS_TOWNNAME
‘.- Reports 485y LU_CMS_WSTATUS
‘1) Scheduled Tasks +-#5g LU_CMS_ZONING
M. 111 NMS CHANNFI MATRI s

Figure 1 Privilege tree: Tables/Views

2 Roles —used for maintenance of tables and views assigned to Munsys roles. When you click on
Roles in the Privilege tree, the content pane displays all the Munsys database roles. Right-clicking
on an item displays a context-sensitive menu, where the administrator can assign a table or view to
arole.
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File Action Help

E IMunsys Management Consale (MCITYT4INT)

&- ti Applications
E ﬂ Locks
B Records
E ng Query Categories
:  --BF Categories
' B Queries
; “-g=| Roles
E & Security
a Users
i i;l Roles
E a Privilege
! TableMews
] Foles)
Td:nleaMews
Spatial Tables
- B Attribute Tables
Lookup Tables
Indexes
Triggers
= % Lineage
BB Spatial Tables
@ Scheduled Tasks

-2 MUNSYS_ADMIN
@-&& MUNSYS_ALL_EDIT
@ 62 MUNSYS_ALL_QUERY
i..g2 MUNSYS_CFS_EDIT
i-@= MUNSYS_CFS_QUERY
)-8 MUNSYS_CMS_EDIT
@---5=| MUNSYS_CMS_QUERY
g2 MUNSYS_CRS_EDIT
5= MUNSYS_CRS_QUERY
- -8= MUNSYS_DMS_EDIT
w-g= MUNSYS_DMS_QUERY
i#l-&| MUNSYS_EMS_EDIT
- g_J MUNSYS_EMS_QUERY
MUNSYS_LICENSE

= MUNSYS_MBK_EDIT

= MUNSYS_MBK_QUERY
=| MUNSYS_POWER

= MUNSYS_QRY

= MUNSYS_RMS_EDIT

= MUNSYS_RMS_QUERY
= MUNSYS_SDM_EDIT

=| MUNSYS_SDM_QUERY
62 MUNSYS_SMS_EDIT
-mE=l MIINSYS SMS QILIFRY

-
([T

H.. H.H ...H

Figure 2 Privilege tree: roles
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Working with Tables and Views

Using the context-sensitive (right-click) or Action menu, you can assign a role to a table or view.

ﬁ IMunsys Management Console (MCITY14INT)

Action | Help
"=.| Refresh

Assign Role

Collapse All
Expand All

i g=| Roles

= % Privilege
- By Table/Views
“-g=| Roles

= % Tables/ Views

: Spatial Tables
: Attribute Tables
U

Lookup Tables

? Indexes
; i) Triggers

= Lineage
: % Spatial Tables
: Reports
) Scheduled Tasks

i o O B O B o o o o M M B e Ay

s SP_BLOCK

T

e SP_CMSNOTE

=8 SP_CONT5M

e SP_CTXTS5M

= SP_DAM

=8 SP_EASELINE

e SP_EASELINETXT
=8 SP_EASEPOLY

= SP_EASEPOLYTXT
=9 SP_ELCABLE

=5 SP_ELDIM

e SP_ELDUCT

=5 SP_ELNODE

= SP_ELNOTE

== SP_ELSERV

=5 SP_ELZONE

e SP_FLOODLINE
=g oF _GEOSCAN_BNDRY
== SP_PARCEL

=8 SP_RAILWAYLINES
=% SP_RDAREA

£ SP_RDCL

SP RNENGF

Assigning a role to a table or view

When a new Munsys table is created using the Munsys Management Tables/Views > Create
New Table option, the following roles are automatically assigned to the new table:

= MUNSYS_ADMIN

= MUNSYS_ALL_EDIT

= MUNSYS_ALL_QUERY
= MUNSYS_POWER

= MUNSYS_SDM_EDIT

= MUNSYS_SDM_QUERY

Should the administrator wish to make the table available to other Munsys applications for
querying or editing, they will need to assign the Munsys roles for the various applications to the

table or view.

1  To assign a role to a table do the following:

m  Click on Tables/Views in the Privilege tree and the content pane is populated with a list of all

tables and views in the schema.

= In the content pane select the table or view to which you want to assign the role to.

= Right-click on table name in the content pane and select the Assign Role option from the

context-sensitive menu.

Privilege
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Note

Note

The administrator has an option of using the right click context-sensitive menu Assign Role to assign
the role or they can select the table or view in the content pane and select Action > Assign Role from
the main menu.

The Assign Role dialog box is displayed showing the Assign Role tab with the table or view name
in the dialog box header.

Assign Role to Table SP_BUILDING X

Assign Role

Select Role:
MUNSYS_ALL_QUERY o
Privileges Assigned

SELECT [] INSERT
[[] DELETE [] UPDATE

Close

Figure 3 The Assign Role dialog box: Assign Role tab

From the Select Role drop down list select the role to be assigned to the table or view.

Check the tick boxes next to the privileges you want to assign to the role on the table or view.

Assign Role to Table SP_BUILDING X

Assign Role
Select Role:
MUNSYS_ALL_QUERY
Privileges Assigned

SELECT [ INSERT
[J DELETE Al E

Commit Cancel

Figure 4 The Assign Role dialog box: Privileges Assigned

Select the Commit button to save the changes to the database.

This selection process must be repeated for all roles added to the table or view.

At least one privilege must be assigned to the role to activate the Commit button.

Privilege
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Removing a role from a table or view

Note

Should the administrator wish to remove the table from the Munsys applications for querying
or editing, they will need to remove the Munsys roles for the various applications to the table
or view.

To remove a role assigned to a table do the following:

m  Click on Tables/Views in the Privilege tree and the content pane is populated with a list of all
tables and views in the schema.

= In the content pane select the expand node next to the table or view whose roles you want to
remove.

m  Right-click on role and select the Remove option from the context-sensitive menu.

Bl Munsys Management Consele (MCITY14INT) - | X
File  Action Help
+-fj Applications - SP_BLOCK A
—--@ Locks =) SP_BUILDING
- -G Records g2 MUNSYS_ADMIN
—)-23 Query Categories @2 MUNSYS_ALL_EDIT
\ L-BF Categories :
3B Queries MUNSYS CMS_EDI| 9% Remove
i ‘ 4= Roles -G MUNSYS_CMS_QU Collapse Al
- Securty g5 MUNSYS_POWER
8 Usen +- BB SP_CMSNOTE Expand All
| L.gil Roles B Sp_CONTSM
=B Privilege 4B SP_CTXTSM
By Table/Views -8 SP_DAM
i “g=| Roles +-B2g SP_EASELINE
- B Tables/Views +- By SP_EASELINETXT
P Spatial Tables +-BEg SP_EASEPOLY
g Attribute Tables +-Bgg SP_EASEPOLYTXT
B} Lookup Tables - B& SP_ELCABLE
g g, indexes +-B5 SP_ELDIM
P i) Triggers +)-B5g SP_ELDUCT
- ) Lineage -85 SP_ELNODE
B spatial Tables +-B% SP_ELNOTE
I Reports +-85g SP_ELSERV
i1 Scheduled Tasks +-B8g SP_ELZONE
«.B& <P FInNNIINFE ~
Remove the assigned role from table/view

Figure 5 The Remove command in the context-sensitive menu

The administrator has an option of using the right click context-sensitive menu Remove to remove the
role or they can select the role in the expanded list of roles in the content pane and select Action >
Remove from the main menu.
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The Remove Role warning message is displayed.

Remove Role

role
from the 'SP_BUILDING' table/view?

o Are you sure you want to remove the ‘MUNSYS_ALL_QUERY'

Figure 6 Remove Role warning message

Click Yes to remove the role.
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Working with Roles

Using the context-sensitive (right-click) or Action menu, you can assign a table or view to a
Munsys role.

H Munsys Management Consale (MCITY 14INT) - O *
Eile Action | Help
(3 Al @ Refresh | |[ @82/ MUNSYS_ADMIN A
+..§l g +1-&&| MUNSYS_ALL_EDIT
453 Q._| Assign Table/View | SRSl MUNSYS_ALL_QUERY
i S 42 MUNSYS_CFS_EDIT
o Collapse All a2l MUNSYS_CFS_QUERY
Expand All -8 MUNSYS_CMS_EDIT
. Erw #)-g=| MUNSYS_CMS_QUERY
- By Tables/Views -2 MUNSYS_CRS_EDIT

Attribute Tables @-82 MUNSYS_DMS_EDIT
Lookup Tables -G MUNSYS_DMS_GUERY
Indexes -2 MUNSYS_EMS_EDIT
L Triggers #-8=) MUNSYS_EMS_QUERY

% Lineage @] MUNSYS_LICENSE

B Spatial Tables )-8 MUNSYS_MBK_EDIT
i “-[E Reports &&= MUNSYS_MBK_QUERY
g) Scheduled Tasks #-a5| MUNSYS_POWER >

Assign a table/view to the role

Assigning a table/view to a role

1  To assign a table or view to a Munsys role do the following:
= Click on Roles in the Privilege tree and the content pane is populated with a list of all Munsys
roles in the schema.
= In the content pane select the role you want to assign the table or view to.

= Right-click on the role in the content pane and select the Assign Table/View option from the
context-sensitive menu.

The Assign Table dialog box is displayed showing the Assign Table tab with the Munsys role name

in the dialog box header.

Assign Table to Role MUNSYS_ALL_QUERY X

Assign Table

Select Table:
SP_BUILDING w
Privileges Assigned

[~] SELECT [] INSERT
[[] DELETE [] UPDATE

Close

Figure 7 The Assign Table to Role dialog box: Assign Table tab
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Note

2
3

From the Select Table drop down list select the table or view to be assigned to the role.

Check the tick boxes next to the privileges you want to assign to the role on the table or view.

Assign Table

Select Table:
SP_BUILDING

Privileges Assigned

Assign Table to Role MUNSYS_ALL_QUERY

SELECT [] INSERT
[7] DELETE UPDATE

Commit

Cancel

Figure 8

Select the Commit button to save the changes to the database and then click the Close button to close

the dialog box

The Assign Table dialog box. Privileges Assigned

This selection process must be repeated for all table or views added to the Munsys roles.

At least one privilege must be assigned to the role to activate the Commit button.

Privilege
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Removing a table/view from a role

1  To remove a table or view from a Munsys role do the following:

= Click on Roles in the Privilege tree and the content pane is populated with a list of all Munsys
roles in the schema

= In the content pane select the expand node next to the Munsys role whose table or view you want
to remove.

= Right-click on the table name and select the Remove option from the context-sensitive menu.

H [Munsys Management Console (MCITY14INT) — O K
File  Action Help
(8 Applications 258 MUNSYS_USAGE_LOG ~
+- (3 Locks 7 MUNSYS_USER_LOG
+-3 Query Categories = SP_BLOCK
-y Securty
- B Priviege 5 SP_CMSNOTH 3¢ Remove
By Table/Views B8 SP_CONTSM
---g=| Roles B SP_CTXTSM Collapse All
—-5 Tables/Views - SP_DAM Expand All
&gy Spatial Tables -8 SP_EASELINE
% Agtribute Tables B SP_EASELINETXT
B Lookup Tables = SP_EASEPOLY
B9 Indexes & SP_EASEPOLYTXT
.. B% Triggers eg SP_ELCABLE
= Lineage = SP_ELDIM
% Spatial Tables 75 SP_ELDUCT
i L.[E Repors = SP_ELNODE
419 Scheduled Tasks &8 SP_ELNOTE -~
Remove the assigned table/view from role

Figure 9 The Remove command in the context-sensitive menu

2 The Remove Table/View warning message is displayed.

Remove Table/View

table/view

0 Are you sure you want to remove the 'SP_BUILDING’
from the 'MUNSYS_ALL_EDIT role?

-

Remove Table/View warning message

Figure 10

3 Click Yes to remove the table or view.
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Chapter 10

I"Ifflbles and indexes

Introduction

The Tables/Views tree of the Munsys Management Console is used to manage spatial tables,
lookup tables and indexes in the database.

With this tree, you can:
w  Create, maintain and validate spatial tables
®  Create and maintain lookup tables

®  Create and maintain indexes on spatial tables, attributes and lookup tables
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The Tables/Views tree: overview

The Tables/View main tree consists of three branches (nodes):

Using the Action menu or context-sensitive (right-click) menu that is activated when an item

Spatial Tables
Attribute Tables
Lookup Tables
Indexes

Triggers

is selected, tables and indexes as created and maintained.

ﬂ |Munsys Management Console (MCITY14INT) — O >
File Action Help
(3 Applcations D Descrintion Table Name Table Type  Geometry .
@-{ Locks _ [Ofe Block Boundaries SP BLOCK Polygon
[)-33 Query Categories .
&8s Secudy +IE,I 16 Buildings SP_BUILDING TABLE Palygon
-8B Priviege anc 17 Cadastral Notes SP_CMSNOTE TABLE Label
5¥ Tables/Views *y.1001 Contours(5m) SP_CONTSM TABLE Line
© BB Spatial Tables || £3c1002  Contour Labels(Sm) SP_CTXT5M TABLE Label
% Attribute Tables || [E)71 Dams SP_DAM TABLE Polygon
i Lookup Tables || *y10 Easement Lines SP_EASELINE TABLE Line
i -B% Indexes ac 11 Easement Line Text SP_EASELINETXT TABLE Label
. BR Trggers 014 Easement Polygons SP_EASEPOLY TABLE Polygon
- Lineage T 15 Easement Polygon Tet  SP_EASEPOLYTXT  TABLE Label
“l) Scheduled Tasks %101 Blectricity Cables SP_ELCABLE TABLE Line
*F108 Electricity Dimensions SP_ELDIM TABLE Point
*4. 103 Blectricity Ducts SP_ELDUCT TABLE Line
ARSI Blectricity Nodes SP_ELNODE TABLE Point
oc 105 Blectricity Notes SP_ELNOTE TABLE Label
*y 107 Electricity SCs SP_ELSERV TABLE Line
@104 Blectricity Zones SP_ELZONE TABLE Polygon
@70 Foodiines SP_FLOODLINE TABLE Polygon
1004  Geo-scan Boundaries SP_GEOSCAN_BND.. TABLE Polygon
@3 Parcels SP_PARCEL TABLE Palygon
*4.1003 Railway Lines SP RAILWAYLINES  TABLE Line
Figure 1 Munsys Management Console: Tables/Views tree
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Working with spatial tables in the Munsys Management Console
Using the Spatial Tables item in the Tables/Views tree, you can do the following:

m  Create custom spatial tables
= Drop a spatial table
»  Validate a spatial table

= Add, modify or delete a column in a spatial table

= Edit Table Description

Creating custom spatial tables

Custom spatial tables are created by selecting the Create New Table or Create from Existing

Table option on the Action menu, or from the context-sensitive (right-click) menu that is

displayed when you right-click on Spatial Tables in the Tables/View tree.

ﬁ IMunsys Management Console (MCITY14INT) — O
File Action Help
* 1? Applications ID Description Table Name Table Type Geometry... A
: 'c'fd‘” @s Block Boundaries SP_BLOCK TABLE Polygon
S Ser et @16 Buidi SP_BUILDING TABLE Pol
58 Securty uildings | 'olygon
-8 Priviege Tac17 Cadastral Notes SP_CMSNOTE TABLE Label
S B Tables/Views 41001 Contours(5m) SP_CONT5M TABLE Line
Y ol Tabl b SP_CTXTSM TABLE Label
g Attribute Tat| Create New Table... SP_DAM TABLE Polygon
By Lookup Tabj Create from Existing Table... SP_EASELINE TABLE Line
: Indexes SP_EASELINETXT  TABLE Label
1 % Triggers Collapse All SP_EASEPOLY TABLE Polygon
¥ % Lineage Expand All SP_EASEPOLYTXT  TABLE Label
il Scheduled Tasks oo SP_ELCABLE TABLE Line -
Create new spatial table tooltip

Figure 2

Spatial table names and descriptions have to be unique; when a new table is created in the

Select Create New Spatial Table

database, the system checks whether the name or description is not yet present. If this is the

case, the table will not be created. A custom spatial table is always assigned a MUNID of >1000.

When a new spatial table is created from an existing table, the following happens:

m  The default columns are added to the table

#  Columns are created in new table that exist in the old table but not in the new one

®  Columns with the prefix _OLD in are created in the new table for all columns that exist in

both the old and new tables.

= All the data from the original table is copied into new table into the corresponding OLD_

columns

m  The table is inserted into MUNSYS_SP_TABLES
m  The table is inserted into MUNSYS_SP_ COLUMNS

Tables and indexes
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The Geometry Metadata (USER_SDO_GEOM_METADATA) is updated
A default query is created (MUNSYS_QUERY)

Roles are assigned to the table (MUNSYS_SDM_QUERY, MUNSYS_ALL_QUERY,
MUNSYS_SDM_EDIT, MUNSYS_ALL_EDIT, MUNSYS_POWER,
MUNSYS_ADMIN)

Indexes are created on the GID and Geometry columns of the new table

When a custom spatial table is created, the Munsys system table MUNSYS_SP_COLUMNS
is populated with the default columns for the new table and its corresponding geometry type.
Default Munsys system queries are also created at this time.

Warning A maximum of 1000 columns may be added to a single spatial table, inclusive of the default
columns per spatial object type.
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To create a custom spatial table

1  Right-click on the Spatial Tables node of the Tables/View tree, and then select the Create New
Table... option on the context-sensitive menu or the Action menu.

The New Spatial Table dialog box is displayed.

New Spatial Table X

Create New Table

Spatial Table Name: SF'_||

Description: |

Geometry Type: W

Figure 3 The New Spatial Table dialog box

2 Enter a unique name used for the spatial table. This name is also used as the primary spatial layer in
Munsys Spatial Data Manager. The name specified is prefixed with SP_ when creating the table
in the database.

3  Enter a descriptive string that will identify which object the new spatial table represents. The
description should be unique in describing the contents of the table.

4  From the Geometry Type list, select the type of geometry data that will be stored in the table. The
available geometry types are Point, Label, Polygon and Line.

New Spatial Table X
Create New Table

Spatial Table Name:  SP_|RAILWAYS

Description: | Railway Lines
Geometry Type: Line »
Create Cancel Help

Figure 4 Creating a new spatial table

5  Click Create.

The spatial table is created in the database.
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To create a custom spatial table from an existing table

1

6

Right-click on the Spatial Tables node of the Tables/View tree or on an existing spatial table, and
then select the Create From Existing Table... option on the context-sensitive menu or the Action

menu.

The New Spatial Table dialog box is displayed.

MNew Spatial Table

Create from Existing Table

Existing Table Name: SP_BUILDING v

Spatial Table Name:  SP_|

Description: |

Geometry Type: i

Figure 5 The New Spatial Table dialog box: create from existing

From the Existing Table Name list, select the spatial table on which you want to base the new table.

Enter a unique name used for the spatial table. This name is also used as the primary spatial layer in
Munsys Spatial Data Manager. The name specified is prefixed with SP_ when creating the table in

the database.

Enter a descriptive string that will identify which object the new spatial table represents. The

description should be unique in describing the contents of the table.

From the Geometry Type list, select the type of geometry data that will be stored in the table. The
available geometry types are Point, Label, Polygon and Line.

MNew Spatial Table
Create New Table

Spatial Table Name:  SP_|RAILWAYS

Description: | Railway Lines
Geometry Type: Line B
Create Cancel Help

Figure 6 Creating a new spatial table

Click Create.

The spatial table is created in the database.
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Dropping a spatial table

Custom spatial tables (tables with MunID > 1000) can be dropped from the database. Munsys-
defined spatial tables cannot be dropped from the Munsys Management Console.

When a table is dropped from the database, all references to the table is deleted from:
The system query table (MUNSYS_ QUERY)
MUNSYS_SP_TABLES
USER_SDO_GEOM_METADATA
MUNSYS_SP_COLUMNS
To drop a spatial table, do the following:

1  Select the table that you want to drop, and then select the Drop Table... option on the Action menu
or the context-sensitive (right-click) menu.

The following confirmation message is displayed:

Drop Table

0 Are you sure you want to drop the "SP_BUILDINGS' table?

The table will be permanently deleted.

Figure 7 Drop Table confirmation message

2 Click Yes to drop the table from the database.
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Validating a spatial table

The Spatial Table Validation function validates the geometry of spatial tables. You need to have
the MUNSYS_ADMIN role assigned and be logged in as the schema owner to be able to
validate a spatial table.

To validate a spatial table, do the following:

1  Select the table that you want to validate, and then select the Validate Table... option on the Action
menu or the context-sensitive (right-click) menu.

The Validation Results dialog box is displayed. This dialog box consists of three tabs:

Summary — this tab lists the main category of the tests that were performed, and whether
the entire category failed or passed the validation test.

Validation Results X

Emors  Validation Log
Summary of validation:

Validation Test Result
v SP_BUILDING Oracle Spatial Validation Passed

Close Help

Figure 8 Validation Results: Summary tab
Errors — this tab contains a list of all the errors that were encountered during the validation.
The results are grouped under the validation category that was performed.

Validation Log — this tab contains a list of the tests that were performed, as well as a detailed
account of the outcome. The validation log can be saved as a text file by clicking the Save
Log button.
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Validation Results X

Summary Emors |
Validation log:
Validation log for table *SP_BUILDING' in schema ‘MCITY12INT

Rows Processed <1591>
No Emors

Save Log...

Figure 9 Validation Results: Log Tab
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Editing columns in a spatial table

Creating a spatial table requires a predefined set of columns to be included in the table. When
using the Munsys Management Console to create a spatial table, these columns are inserted into
the table automatically.

One of the columns that needs to be present in the table is the GID column. This column is
used as the geometry identifier for an object inserted into the table. It is a unique identifier
throughout the Munsys schema, and is used as primary index for the spatial table.

Other required columns are used to hold label or text attributes for the object, such as angle,
size and position of a town name.

The predefined columns cannot be deleted from a table. The database administrator can add
new columns to any spatial table and also delete such columns.

Adding a column to a spatial table

1  Select the spatial table to which you want to add a column, and then select the Edit Columns...
option on the Action menu or the context-sensitive (right-click) menu.

The Edit Spatial Table Columns dialog box is displayed.

Edit Spatial Table Columns - SP_BUILDING X
Table Columns

Column Name Data Type Width Precision Description Edtable Mandatory System

GID NUMBER 10 0 GID N N Y

BLD_TYPE VARCHARZ2 20 Building Type Y N Y

BLD_FLOORS NUMBER 4 0 Number of Floors Y N Y

GEOM_AREA NUMBER 22 0 Geometry Area N N Y

COMMENTS VARCHAR2 150 Comments Y N Y

TAG_X NUMBER 22 0 Tag X Coordinate N N Y

TAG_Y NUMBER 22 0 Tag Y Coordinate N N Y

TAG_VALUE VARCHAR2 40 Tag Value Y N Y

TAG_SIZE NUMBER 22 0 Tag Height N N Y

TAG_ANGLE NUMBER 22 0 Tag Angle N N Y

TAG_JUST CHAR 2 Tag Justification N N Y

GEOMETRY GEOMET... 0 Geometry Object N N Y

BLD_NAME VARCHAR2 250 Building Name Y N Y

BLD_NUM VARCHAR2 10 Building Number Y N Y Ad...
DATA_SOURCE  VARCHAR2 20 Data Source Y N Y Modiy..
DATA_QUALITY VARCHAR2 20 Data Quality Y N Y

< > Delete

Cancel Help

Figure 10 Edit Spatial Table Columns

2 Click the Add button.
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The Add Column dialog box is displayed.

Add Column X

Column Info

Table Name
SP_BUILDING

Column Irformation

Name: “

Data Type: V]

Data Width: 0
Data Precision: (

Display Information
Description:

Data Format: UseDefault v
Is Editable [ ] Is Mandatory

[ Is System Column

Cancel Help

Figure 11 The Add Column dialog box

3  Enter the following column information:

Name — the name of the column. This value cannot be changed.

Data Type — the data type of the column (CHAR, NUMBER, VARCHAR2, DATE or
GEOMETRY).

Data Width — the maximum width of the column.

Data Precision — the number of decimal digits that the column will display. This only
applies to Number data types.

4  Enter the following display information:

Description — enter a description for the new column, or change the description of an
existing column.

Data Format — select a data format from the list (Use Default, Angle, Date/Time,
Hyperlink, or Lookup Table).

Is Editable — specify whether the value may be edited in Munsys Applications.

Is Mandatory - specify whether an integrity check rule must be added to the
MUNSYS_INTEG_ATTR table. If checked, an entry is added and the default
RULE_TYPE is set to NOTNULL. By default this remains unchecked.

5  Click OK to add the column to the spatial table.
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Modifying a column in a spatial table

Note

1

Select the spatial table of which you want to edit a column, and then select the Edit Columns...

option on the Action menu or the context-sensitive (right-click) menu.

Only columns in custom (user-defined) spatial tables can be edited.
The Edit Spatial Table Columns dialog box is displayed.

Select the column that you want to edit, and then click the Modify button.

Edit Spatial Table Columns - SP_BUILDING
Table Columns
Column Mame Data Type Width  Precision Description Editable Ptﬂandator‘_.iI System
G ID N UMBER 10
--
BLD FLOORS NUMBER 0 Number of Floors Y N Y
GEOM_AREA NUMBER 22 0 Geometry Area N N Y
COMMENTS VARCHAR2 150 Comments Y N Y
TAG_X NUMBER 22 0 Tag X Coordinate N N Y
TAG_Y NUMBER 22 0 Tag Y Coordinate N N Y
TAG_VALUE VARCHAR2 40 Tag Value Y N Y
TAG_SIZE NUMBER 22 0 Tag Height N N Y
TAG_ANGLE NUMBER 22 0 Tag Angle N N Y
TAG_JUST CHAR 2 Tag Justification N N Y
GEOMETRY GEOMET... 0 Geometry Object N N Y
BLD_NAME VARCHAR2 250 Building Name Y N Y
BLD_NUM VARCHAR2 10 Building Number Y N Y Ad...
DATA_SOURCE  VARCHAR2 20 Data Source Y N Y Modfy..
DATA_QUALITY  VARCHAR2 20 Data Quality Y N Y
< > Delete
Commit Cancel Help

Figure 12 Edit Spatial Table Columns: Modify
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3
4

The Modify Column dialog box is displayed.

Maodify Column X

Column Info
Table Name
SP_BUILDING

Column Information
Name: [BLD_TYPE

Data Type: VARCHAR2

Data Wicth: [ 20|
Data Precision: DJ
Display Information
Description:
Data Format: UseDefault o
[+] Is Editable [ ] Is Mandatory

[ Is System Column

Figure 13 Modify Column

Edit the column as required, and then click OK.

Click the Commit button to commit the transaction to the database.
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Deleting a column from a spatial table

The administrator can only delete custom columns from the spatial tables. When selecting a
column to delete, the delete process checks to see if there are any integrity rules defined for the
deleted column in the MUNSYS_INTEG_ATTR table, and if so, removes the reference when
the deletion is committed.

Select the column to be deleted so that it is highlighted
1  Click the Delete button

The user is presented with the following Delete Column message

Delete Column

0 Are you sure you want to delete the 'BLD_TYPES' column?

The column will be permanently deleted.

Yes No

Figure 14  Delete Column message

2 Click the Yes button to continue with the deletion process, or click the No button to cancel the
command.

3 Click the Commit button to commit the transaction to the database.
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Working with attribute tables in the Munsys Management Console

Using the Attribute tables item in the Tables/Views tree, you can do the following:
m  Create custom attribute tables
= Drop an attribute tables

®  Add, modify or delete columns in an attribute table
= Modify table description

Create attribute tables

Attribute tables are created by selecting the Create New Table option on the Action menu, or

from the context-sensitive (right-click) menu that is displayed when you right-click on
Attribute tables in the Tables/View tree.

ﬁ Munsys Management Console (MCITY14INT) — O

Eile Action  Help

-3 Applications D
+-f8 Locks
3 Query Categories

[+ ]

+

+-ay Securty .
+ Privilege

= Tables/Views

Spatial Tables

; Attribute Tables

&y Lookup Tables
gy Indexes
- &y Triggers

&1 Scheduled Tasks

Description Table Name

1 Building Floor Info AT_BLDG_FLOOR_INFO
Building Room Info AT_BLDG_ROOM_INFO

Figure 15  Munsys Management Console: Attribute Tables

When creating a new table, the system will automatically add the prefix [AT_] to the name
supplied. Both the table name AND the descriptions must be unique; when a new table is

created in the database, the system checks whether either the name or description already exists.

If this is the case, the table will not be created. A custom attribute table is always assigned a

MUN_ATID of >1000. When a new attribute table is created, the system
® automatically adds an ID column

®  Populates MUNSYS_AT_TABLES Munsys system table

®  Populates MUNSYS_AT_COLUMNS Munsys system table

Note

Oracle imposes a limit of a 1000 columns per table.
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To create a custom attribute table

Note

1  Right-click on the Attribute tables node of the Tables/View tree, and then select the Create New
Table... option on the context-sensitive menu or the Action menu.

Create new attribute table tooltip

H ‘Muns:.r: Management Console (MCITY14INT) ! - | x
File  Action Help

- Applications D Description Table Name

% Locks 1 Building Floor Info AT_BLDG_FLOOR_INFO

+-35 Query Categories L

-3 Securty 2 Building Room Info AT_BLDG_ROOM_INFO

+ Privilege

- Tables/Views

P Spatial Tables

Attribute Table

- E Lookup Table«( Create New Table...

P ﬁ Indexes Add Existing Table...

. L.H Triggers

£ % Lineage Collapse All
g Scheduled Tasks Expand All

Figure 16

Create Attribute Table

The New Attribute Table dialog box is displayed.

New Attribute Table

Create New Table

Attribute Table Name: AT_|ASSET

Description: Asset Registry| |
Create Cancel Help
Figure 17  New Attribute dialog box
Enter a unique name used for the attribute table. The name specified is prefixed with AT when
creating the table in the database.

Enter a descriptive string that will identify which object the new attribute table represents. The

description should be unique in describing the contents of the table.

4 Click Create.

The attribute table is created in the database.

When creating a new attribute table in Munsys, the system will automatically add one column. This is the
ID column which is used as a primary index for the attribute table. It is also possible to make this column
unique throughout the Munsys schema by assigning the sequence MUNSEQ ID to the ID field. (This is
not done automatically.)
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To add an attribute table from an existing table

Note

1

Right-click on the Attribute tables node of the Tables/View tree, and then select the Add Existing
Table... option on the context-sensitive menu or the Action menu.

A dialog box is displayed that lists all available non-system or spatial tables.

Add Existing Attribute Table

Add Existing Tables

Attribute Tables:

FIN_ACCT_NO
FIN_EREADINGS
FIN_WREADINGS
GEN_DWGCAT
TP_PARCEL_DATA
TP_PARCEL_OWNER

Cancel

Figure 18  Add Existing Attribute Table

Select the attribute table that you want to add to the Table Name List and Click Add.

The attribute table is added in the database.

When adding an Attribute Table it enables you to now administer the table i.e. add/modify/delete columns.
It also lists only the tables that you added so even if you have 100 attribute tables in the schema but only

10 are relevant then you can simply add those 10 tables.
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Dropping an attribute table

Tables that are listed under Attribute tables and have a MUN_ATID > 1000 are custom
attribute tables and they can be dropped from the database.

When a table is dropped, references to the table are also removed from the attribute table list,
all references to the table is deleted from:

MUNSYS_AT_TABLES
MUNSYS_AT_COLUMNS
To drop an attribute table, do the following:

1  Select the table that you want to drop, and then select the Drop Table... option on the Action menu
or the context-sensitive (right-click) menu.

The following confirmation message is displayed:

Drop Table

o Are you sure you want to drop the 'AT_ASSET table?

The table will be permanently deleted.

e ] 0w

Figure 19  Drop Attribute Table notification

2 Click Yes to drop the table from the database.
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Removing an attribute table

Tables that are listed under Attribute tables and have a MUN_ATID > 1000 are custom
attribute tables and they can be dropped from the database.

When a table is removed from the attribute table list, all references to the table is deleted from:
MUNSYS_AT TABLES
MUNSYS_AT COLUMNS

To remove an attribute table, do the following:

1  Select the table that you want to drop, and then select the Remove Table... option on the Action
menu or the context-sensitive (right-click) menu.

The following confirmation message is displayed:

Remove Table

0 Are you sure you want to remove the "AT_ASSET table?

The table will be removed from the list of attribute tables
only.

ST

Figure 20  Remove Attribute Table notification

2 Click Yes to remove the table from the attribute list.
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Editing columns in an attribute table

When creating a new attribute table in Munsys, the system will automatically add one
column.Any other columns that are needed will have to be added after the table is created.

When you have a configured Attributed table, you can also use the edit function to add or edit
columns to that table.

Adding a column to an attribute table

1  Select the attribute table to which you want to add a column, and then select the Edit Columns...
option on the Action menu or the context-sensitive (right-click) menu.

The Edit Attribute Table Columns dialog box is displayed:

Edit Attribute Table Columns - AT_ASSET X
Table Columns
Column Name Data Type Width  Precision Description Editable Mandatory System
ID NUMBER 10 0 ID N N Y
Add...
Modfy...
Delete
Cancel Help

Figure 21  Add a column to an Attribute table

2 Click the Add button.
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3

4

5

The Add Column dialog box is displayed:

Add Column X

Column Info

Table Name
AT_ASSET

Column Information

Name: l
Data Type: v

Data Width: 0

Data Precision:

Display Information
Description:

Data Format: UseDefault ~
Is Editable

[] Is System Column

Figure 22 Add Column Dialog box

Enter the following column information:

Name — the name of the column. This value cannot be changed.

Data type — the data type of the column (CHAR, NUMBER, VARCHAR?2, DATE or
GEOMETRY).

Data Width — the maximum width of the column.

Data Precision — the number of decimal digits that the column will display. This only applies
to Number data types.

Enter the following display information:

Description — enter a description for the new column, or change the description of an
existing column.

Data Format — select a data format from the list (Use Default, Angle, Date/Time,
Hyperlink, or Lookup Table).

Is Editable (This specifies whether the value may be edited in Munsys Applications and is
turned on by default.)

Is System Column — flagging a column as a System column prevents it from been

deleted/dropped.

Click OK to add the column to the attribute table
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Modifying a column in an attribute table

1

Select the attribute table within which you want to edit a column, and then select the Edit Columns...

option on the Action menu or the context-sensitive (right-click) menu.

The Edit Attribute Table Columns dialog box is displayed. Note that only user-defined attributes

within registered attribute tables can be edited.

Select the column that you want to edit, and then click the Modify button.

Edit Attribute Table Columns - AT_ASSET

Table Columns

Column Name Data Type Width  Precision Description Editable Mandatory System
NUMBER 10 0 ID N

ID N Y
[ASSET_NUMBER | NUMBER _| 20| 1] Asset Barcode Number [ Y | N ___[N ]

Add...
Modfy..
Delete
Commit Cancel Help
Figure 23 Modify Attribute Table Columns
The Modify Column dialog box is displayed:
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4
5

Modify Column

Column Info

Table Name
AT_ASSET

Column Information

Name: |ASSET_NUMBER

Data Type: NUMBER

DataWidth: | 20|
Data Precision: E

Display Information
Description:

Ass-et Barcode Number]

Data Format: UseDefault
[+ Is Editable

[] Is System Column

Figure 24  Modify Column

Edit the column as required, and then click OK.

Click the Commit button to commit the transaction to the database.
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Deleting a column from an attribute table

The administrator can only delete custom columns from the attribute tables. When selecting a
column to delete, the delete process checks to see if there are any integrity rules defined for the
deleted column in the MUNSYS_INTEG_ATTR table, and if so, removes the reference when
the deletion is committed.

1  Select the column to be deleted so that it is highlighted.
2 Click the Delete button

The user is presented with the following Delete Column message:

Delete Column

Are you sure you want to delete the "ASSET_NUMBER'
column?

The column will be permanently deleted.

e 770 mo

Figure 25  Delete column notification

3 Click the Yes button to continue with the deletion process or click the No button to cancel the
command.

4 Click the Commit button to commit the transaction to the database.
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Working with lookup tables in the Munsys Management Console

Alookup table is designed in the same way as an attribute table, with the difference that lookup
tables are not used to capture data, but rather to look up data values. All possible values for a
single field, for example all the possible values for zonings, are grouped into one lookup table.
The user is presented with a list of values to choose from. This method of data capture enhances
data accuracy. The database administrator can add lookup values to lookup tables, or modify or
delete existing values.

Note The lookup tables have a unique primary key index assigned to the lookup code column enforcing the
LCODE value to be unique.

Using the Lookup Tables item in the Tables/Views tree, you can do the following:
m  Create new lookup tables

®  Create and edit links between lookup tables and spatial tables

= Delete lookup links

= Drop lookup tables

m  Create and edit lookup values in a lookup table

Creating a new lookup table

To create a new lookup table, do the following:

1  Select the New Lookup Table... option on the Action menu or the context-sensitive (right-click)
menu that is displayed when you select Lookup Tables on the Tables/Views tree.

H Munsys Management Console (MCITY14INT) - O X
File Action  Help
1) Applications -84 LU_CMS_BLDTYPE A
-3 Locks -8y LU_CMS_DENSITY
+)-35 Query Categories 2] m LU_CMS_EASETYPE
+)- 2%, Security -8y LU_CMS_LANDUSE
E: Privilege By LU_CMS_LSTATUS
- Tables/Views By LU_CMS_PRCLTYPE
g Spatial Tables By LU_CMS_STRNAME
' Attribute Tables By LU_CMS_SUBNAME
=58 Lookup Tables) & By LU_CMS_TOWNNAME
g ﬁ» indexes By LU_CMS_WSTATUS
- B% Triggers -8y LU_CMS_ZONING
I Lineage -8y LU_DMS_CHANNELMATRL
&1 Scheduled Tasks -8y LU_DMS_CHANNELTYPE
[xal El 11l MMC SLnvCoThRCDTUL v

Figure 26 Munsys Management Console: Lookup Tables

The Create Lookup Table dialog box is displayed:
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Create Lookup Table
Table Info

Table Name
Table Name Lu_

Lookup Code
Data Type: CHAR ~
Data Width: 10 =

Lookup Value
Data Type: VARCHAR2
Data Width 20 =

Cancel Help

Figure 27 The Create Lookup Table dialog box

Enter the following information:

Table Name — enter a descriptive name for the lookup table. The table is automatically
prefixed with LU_.

Lookup Code: Data Type — enter the appropriate data type for the lookup table: CHAR,
VARCHAR?2 or NUMBER. If you select NUMBER, the data precision field becomes
available.

Lookup Code: Data Width — enter the width for the column. The maximum is 20.

Lookup Code: Data Precision — enter the number of decimal digits that the column will
display. This field is only available when you selected NUMBER as the data type.

Lookup Value: Data Type — the data type for the lookup value is set to VARCHAR2 by
default. This value cannot be changed.

Lookup Value: Data Width — enter the maximum width for the column. The maximum is
200

Click the Create button to create the new lookup table.
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Creating links between lookup tables and spatial tables

To create a link between a lookup table and a spatial table, do the following;

1  Select the Lookup Links... option on the Action menu or the context-sensitive (right-click) menu
that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

The Lookup Links dialog box is displayed:

Lookup Links X
LU_CMS_BLDTYPE
Table Link Column Lookup Link Column
SP_BUILDING  BLD_TYPE LCODE
Modify...
| <€ > Delete
Close Help
Figure 28  The Lookup Links dialog box
2 Click the Add... button.
The Lookup Link dialog box is displayed.
Lookup Link X

Table: v
Link Column: v
Lookup Link Column: |LCODE v

Cancel Help

Figure 29 The Lookup Link dialog box
Select the required spatial table from the list.
Select the required spatial link column from the list.

Select the required lookup link column as required.

A N R W

Click OK to create the lookup link.
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Editing links between lookup tables and spatial tables
To edit a link between a lookup table and a spatial table, do the following:

1  Select the Lookup Links... option on the Action menu or the context-sensitive (right-click) menu
that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

The Lookup Links dialog box is displayed:

Lookup Links X

LU_CMS_BLDTYPE

Table Link Column Lookup Link Column

SP_BUILDING | BLD_TYPE LCODE

Close Help

Figure 30  The Lookup Links dialog box

2 Select the lookup link that you want to edit, and then click the Modify... button.
The Lookup Link dialog box is displayed.

Lookup Link X

Table: SP_BUILDING v
Link Column: BLD_TYPE v
Lookup Link Column: | LCODE v

Figure 31  The Lookup Link dialog box

3  Change the spatial table if required.
4 Change the spatial link column and the lookup link column as required.
5 Click OK to apply the changes to the lookup link.
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Deleting a link between a lookup table and a spatial table

Tip

To delete a link between a lookup table and a spatial table, do the following:

Select the Lookup Links... option on the Action menu or the context-sensitive (right-click) menu

that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.
The Lookup Links dialog box is displayed:

Lookup Links

LU_CMS_BLDTYPE

Table

Link Column

Lookup Link Column

SP_BUILDING | BLD_TYPE LCODE

Close

Modfy...

Delete

Figure 32 The Lookup Links dialog box

Select the lookup link that you want to delete, and then click the Delete... button.

The lookup link is deleted.

Click Commit to save the changes to the database.

You can also remove a link by selecting the appropriate link in the content pane, and then selecting the
Remove Link option on the Context-sensitive menu.

The following dialog is displayed:

Remove Link

Yes

Are you sure you want to remove lookup link 'SP_BUILDING'
on column ‘BLD_TYPE' from table 'LU_CMS_BLDTYPE'?

Figure 33 Remove Link notification
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Dropping a lookup table from the database
To drop a lookup table from the database, do the following:

1  Select the Drop Lookup Table... option on the Action menu or the context-sensitive (right-click)
menu that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

A confirmation message is displayed:

Drop Lookup Table

o Are you sure you want to drop the table "LU_CMS_BLDTYPE'?

The lookup table will be permanently deleted.

Yes . No

Figure 34  Drop Lookup Table notification

2 Click Yes to drop the lookup table from the database.
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Creating a lookup value in a lookup table

To create a new lookup value for a lookup table, do the following:

1  Select the Lookup Values... option on the Action menu or the context-sensitive (right-click) menu
that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

The Lookup Values dialog box is displayed.

Lookup Values X

LU_CMS_BLDTYPE

Table Values:

Lookup Code Lookup Value

RESIDENTIAL Residential

OFFICE Office

MEDICAL Medical

FACTORY Factory

HOTEL Hotel

GENERAL  Geners

Modify...

Delete

Close

Figure 35  The Lookup Values dialog box

2 Click the Add... button.
The New Lookup Value dialog box is displayed.

New Lookup Value X

LCODE:

LVALUE:

T R

Figure 36 The New Lookup Value dialog box
Enter a new lookup code (LCODE).

Enter a new lookup value (LVALUE).
Click OK to add the lookup value to the table.

A N xR W

Click Commit on the Lookup Values dialog box to save the changes to the database.
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Modifying a lookup value in a lookup table

1

2

3
4

Select the Lookup Values... option on the Action menu or the context-sensitive (right-click) menu

that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

The Lookup Values dialog box is displayed:

Select the value that you want to change, and then click the Modify... button.

Lookup Values

LU_CMS_BLDTYPE

Table Values:

Lookup Code  Lookup Value

OFFICE Office
MEDICAL Medical
FACTORY Factory
HOTEL Hotel
GENERAL General

RESIDENTIAL

Add...

Modify...
Delete

Figure 37 The Lookup Values dialog box

The Modify Lookup Value dialog box is displayed.

Modify Lookup Value X

LCODE:

|RESIDENTIAL

LVALUE:
| Residential

T R

Figure 38  The Modify Lookup Value dialog box

Change the lookup value as required, and then click OK.

Click Commit on the Lookup Values dialog box to save the changes to the database.
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Deleting a lookup value from a lookup table

1  Select the Values... option on the Action menu or the context-sensitive (right-click) menu that is
displayed when you select the appropriate Lookup Table on the Tables/Views tree.

The Lookup Values dialog box is displayed:
2 Select the value that you want to delete, and then click the Delete... button.

Lookup Values X

LU_CMS_BLDTYPE

Table Values:

Lookup Code  Lookup Value

RESIDENTIAL

OFFICE Office

MEDICAL Medical

FACTORY Factory

HOTEL Hotel

GENERAL General _—

Delete

Figure 39 The Lookup Values dialog box

The lookup value is deleted from the lookup table.

3  Click Commit on the Lookup Values dialog box to save the changes to the database.
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Editing lookup columns

1  Select the Edit Columns... option on the Action menu or the context-sensitive (right-click) menu
that is displayed when you select the appropriate Lookup Table on the Tables/Views tree.

ﬁ IMunisys Management Console (MCITY13INT) - O x
File  Action Help
- fi Applications ® %‘. A
#-[@) Locks @B} LU_CMS_DENSIT Lookup Links...
#1-3§ Query Categories - By LU_CMS_EASET 2 Drop Lockup Table
-2 Security @By LU_CMS_LANDU
+ ; Privilege |+|§u LU_CMS_LSTAT Lookup Values...
= Tables/Views -y LU_CMS_PRCLT] E
B8 Spatial Tables w5 LU_CMS_S‘I'HNA| B o
- BR Attribute Tables - &y LU_CMS_SUBNA Collapse All
By Lookup Tables -8} LU_CMS_TOWN
Indexes o B LU_CMS_WSTM" Expand Al
_ % Triggers @By LU_CMS_ZONING
+- M Lineage -8y LU_DMS_CHANNELMATRL
1) Scheduled Tasks @By LU_DMS_CHANNELTYPE
|:| E 11l NMC FINVWCDThCDTU v
Edit Columns tooltip

Figure 40  Edit Lookup Columns

The Edit Lookup dialog box is displayed:

Edit Lookup Table X

Table Info
Table Name
Table Name: LU_ CMS_BLDTYPE

Lookup Code
Data Type: VARCHAR2 v
Data Width: 20 =

=
»

Lookup Value

Data Type: VARCHAR2

Data Width: 40 =

Commit Cancel Help

Figure 41  Edit Lookup Table

2 Setthe Lookup Code column to either CHAR, VARCHAR or NUMBER. Each option displays
parameters associated with that data type. Set each of the parameters as required.
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Only the width of the Lookup Value can be changed. Set this value as required

If you tried to change the data type of any lookup table that contains values, and error will occur to
prevent data loss.

Database Error X

e Unable to alter Lookup Table ‘LU_CMS_BLDTYPE',

ORA-01441: cannot decrease column length because some
value is too big

Figure 42 Data loss notification

Click Commit to update the changes in the database
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Working with indexes on spatial tables and lookup tables

In the Munsys Management Console, you can create custom indexes, as well as recreate and
drop indexes on Munsys spatial, attribute and lookup tables using Indexes on the Tables/Views

tree.
ﬁ |Munsys Management Console (MCITY14INT) — O 5
Eile Action  Help
-3 Applications - &3y Spatial Tables
+-f@ Locks [+-&5) Lookup Tables
5 Query Categories [+- &) Attribute Tables

~

+
+-ay Security
+ Privilege
E Tables/Views
P Spatial Tables
g Attribute Tables
-8 Lookup Tables

Indexes

T Triggers

* % Lineage

&1 Scheduled Tasks

Figure 43 Munsys Management Console: Indexes

Indexing is separated into two different sections:
w  Spatial Tables — All tables starting with the prefix SP_.
»  Lookup Tables — All tables starting with prefix LU_.

»  Atctribute Tables — All tables that are being managed by the Munsys Attribute Management
tools.

A custom index for a spatial, attribute or lookup table is created using the Create Custom Index
dialog box. This dialog box is accesses by selecting the appropriate spatial, attribute or lookup
table, and then selecting the Create Custom Index option on the Action menu or context-
sensitive (right-click) menu.

Each spatial or lookup table lists the columns on which indexes have been created. A spatial or
attribute table can have multiple indexes.
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Creating a custom index for a spatial or lookup table

The Create Custom Index dialog box is used to create custom indexes for columns in a selected
spatial table. The GID and GEOMETRY columns have preset index names and custom indexes
cannot be created on these two columns.

To create a custom index for a spatial or lookup table, do the following:

1  Select the Create Custom Index... option on the Action menu or the context-sensitive (right-click)
menu that is displayed when you select the appropriate table on the Tables/Views tree.

H Munsys Management Console (MCITY14IMT) — O X
File  Action Help
- Applications 'T"% Spatial Tables A
#-[@ Locks R 1] SP_BLO
+-33 Query Categories E: SP_BUIL Create Custom Index...
H-gy Securty % SP_CMS Create Geometry Index
+ Privilege * SP_CON IR
& Tables/Views & SP_CTX] Create GID Index
- Spatial Tables -4 SP_DAM Rebuild All Indexes
; Attribute Tables * SP_EASE
-8y Lookup Tables & SP_EASE Collapse All
Indexes - ) SP_EASE
i % Triggers w- B8 SP_EAS Expan A
+- I Lineage 3 SP_ELCABLE
“-i1 Scheduled Tasks 3 SP_ELDIM
0 Co CiwrT b
Create Custom Index tooltip

The Create Custom Index dialog box is displayed:

Create Custom Index X

SP_BLOCK

Index Name: ||

Column: v

Cancel Help

Figure 44 The Create Custom Index dialog box

2 Enter a descriptive name for the custom index that you are creating.

3  From the Column list, select the column that you want to create the index for (the list only displays
currently non-indexed columns).

4 Click Create to create the new custom index.
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Rebuilding all indexes on a spatial or lookup table

To rebuild an index on a table, do the following:

1  Select the Rebuild All Indexes option on the Action menu or the context-sensitive (right-click)
menu that is displayed when you select the appropriate table on the Tables/Views tree.

The following message is displayed:

Rebuild Indexes

Are you sure you want to rebuild all the indexes for table
'SP_BLOCK'?

All the indexes on table "SP_BLOCK' will be rebuilt one by one.
This operation may take several minutes,

Yes | No

Figure 45  Rebuild indexes notification

2 Click Yes to rebuild the indexes.

The indexes are rebuilt.
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Chapter 11

Munsys Lineage

Introduction

Munsys Lineage is primarily used as a data management tool to track and archive changes
made to records in spatial tables. This is achieved through the implementation of database
triggers which populate Munsys system tables based on the preferences selected when
Lineage is added to a spatial table. Reports can also be generated to query the database for
MONItor or usage purposes.

This chapter is divided into the following sections for easy reference:
The Lineage Tree: overview
Working with Munsys Lineage
Enabling or disabling Lineage
Adding Lineage
Disabling triggers
Enabling triggers
Editing Lineage
Removing Lineage
Recompiling triggers
Rebuilding triggers
Deleting monitor logs
Running reports
Adding reports
Editing reports

Deleting reports
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The Lineage tree: overview

The Lineage tree consists of the Spatial Tables and Reports branch.

ﬁ [Munsys Management Console (MCITY14IMT)

File Action  Help

& Fopicatons R, V5ot v
-3 Locks i-E] Reports
-5 Query Categories
B Security
Privilege
Tables/ \iews
Lineage
B Spatial Tables
i Reports
‘&) Scheduled Tasks

s L = R R e S s

Figure 1 Munsys Management Console: Lineage Tree

= Clicking on Spatial Tables in the Lineage tree displays existing spatial tables (if any) to
which triggers have being implemented to track Lineage. Refer to the specific sections in

this chapter for more details on the available functions on the Spatial Tables branch.

ﬁ Munsys Management Censale (MCITY14INT) O b4
File Action Help

- Applications E2R---Y SP_WATNOTE

+-@ Locks -8 SP_WATPIPE Spatial table to which

+-33 Query Categories |1 t» 5P _WATRESPIPE ’ triggers have been added

@8 Secuiy By SP_WATSERV

w-B4 Privilege =-Bf SP_WATSYM

+-B5 Tables/Views () MARC_SP_WATSYM

=0 Lineage - Q MMA_SP_WATSYM ]_y Triggers

- B Spatial Tables () MMS_SP_WATSYM

i Reports

"1} Scheduled Tasks

Figure 2 Lineage Tree: Spatial Tables branch

= Clicking on Reports in the Lineage tree displays the reports that can be run. Reports are
created and maintained in this window. Refer to the specific sections in this chapter for

more details on the available functions on the Reports branch.
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E Munsys Management Console (MCITY14INT)

File Action Help

-l Applications ID Type Description

9 Monitor Grouped by Month and Operation

10 Monitor Grouped by Month and User Name
1 Monitor Grouped by Month and Table Na...
12 Monitor Grouped by Month, Table Name ...
13 Monitor Grouped by Month, Table Name ...
14 Monitor  Grouped by Table Name, Morth ...
15 Monitor Grouped by Table Name, Month ...
16 Usage Number of unique users per dayf...
17 lUsage Number of applications used per ...

18 Usage Applications used per user forthe...
19 Usage Shared users (users with same na...
20 Usage Logged on users forthe past 24 h...

E"' Locks f = o

& 2 Guery Calegaries il Monitor Total Number of Records select round(count(").0) "Re
-8 Secury 2 Monitor ~ Records for the past 24 Hours select gid "GID", table_nam
@ Privilege 3 Monitor Records for the past Week select gid "GID", table_nam
(- B Tables/Views - Monitor ~ Records for the past Month select gid "GID". table_nam
E Lineage 5 Monitor Grouped by Operation select round(count(").0) "Re
B spatial Tables 6 Monitor  Grouped by User Name select round(count("),0) "Re
 -[H Reports 7 Monitor ~ Grouped by Month select round(count(").0) "Re
@ Scheduled Tasks 8 Monitor Grouped by Table Name select round(count(").0) "Re

select round(count().0) "Re
select round(count(*),0) “Re
select round(count(*),0) "Re
select round(count().0) "Re
select round(count().0) "Re
select round(count(*),0) “Re
select round(count(*),0) "Re
select count(c users) "Uniqu
select count(c.app) " Unique
select distinctlb.module_nar
select b.user_name "User M
select user_name "User Na
>

Figure 3 Munsys Management Console: Reports
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Working with Munsys Lineage

Note

Munsys Lineage can be used to:
Monitor changes to records made in a specified table.
Archive deleted or updated records into an archive table.

Report according to specific monitor and usage requirements.

Monitor
Munsys Lineage can be used to log and monitor the following information about operations
done on a table:

the type of operation

the date and time of the operation

the table on which the operation was done
the user who executed the operation

Logging is done during insert, update, and delete operations on a specified table in the Oracle
schema. Updates are classified based on the columns updated, and as Spatial or Attribute, for
example if the geometry of an object has been changed, it can be classified as a spatial update.

Logging information is stored in the MUNSYS_MONITOR_LOG and is maintained by the
administrator to prevent logs from growing too big.

Lineage date is important, especially if you want to be able to supply incremental updates to
other customers, for example if the county wants to supply changes to the municipality based
on a specific date.

The Show Info function in Munsys Applications shows the history of the object on the Linked Tables
tab. This is done by inserting a record into the MUNSYS_LNK TABLES table.

Archive

Munsys Lineage can be used to archive deleted or updated records into an archive table
associated with a specified spatial table. This requires the creation of an archive table
(SP_AD_tablename) and an associated archive trigger for a selected spatial table in the database.
The archive trigger is implemented in such a way that all the columns in a specified spatial table
are archived. When Lineage is added to a spatial table, the structure of that spatial table is
duplicated to create an archive table. The archive table is populated with records that meet
archive requirements as specified when Lineage is added or edited. Three extra columns are
added to the archive table to keep track of the following information:

the type of operation performed which resulted in the record being archived: An operation
type column (ARCHIVE_OPERATION) is added to the archive table, which can be
populated with the operation types DEL (delete) and UPD (update).

the date and time of the archive: A date stamp column (ARCHIVE_DATE) is added to the
archive table, which is populated with the date and time that the archive operation
occurred.

the archived ID: A unique ID column (ARCHIVE_ID) of the archived record is added.
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The archive table is also inserted into the Munsys system tables, enabling users to query deleted
records from an archive table using Munsys Applications.

The database administrator maintains the records in the archive tables to prevent the tables
from growing too big. Records are deleted from the archive table based on the time stamp of
the deleted record.

Reports

Reports can also be generated from spatial tables to which Lineage is applied. Administrator can
generate monitor and usage reports to provide basic or detailed reporting based on predefined
or customised requirements.

Munsys Lineage also reports on user logon/logoff and license usage, based on the entries in the

MUNSYS_USAGE_LOG table.
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Enabling or disabling Lineage

Lineage can be enabled and disabled from within the schema Properties dialog box. The Lineage
tree branch only becomes active and functional once it has been enabled for a schema.
Alternatively, when Lineage is not enabled, all Lineage functionality is disabled and cannot be
modified in the Lineage tree branch of the Munsys Management Console.

To enable / disable Lineage and for more information, please refer to the chapter on Schema
management: The Lineage Tab.

Munsys Lineage 142



Adding Lineage
Adding Lineage to a spatial table will create the necessary tables and triggers in the database to

monitor and archive operations for the selected spatial table. The administrator will also be able
to customise how and when Lineage should monitor and archive records.

Three types of triggers are created when Lineage is added to a spatial table, two for logging
purposes and one for archiving. These triggers populate Munsys system tables based on the
preference selected when Lineage is added or edited.

MMA_tablename (for example MMA_SP_PARCEL) — this trigger name contains the
prefix MMA_(Munsys Monitor Attribute columns) to indicate that the primary function
is to log attribute updates. This trigger populates the MUNSYS_MONITOR_LOG table
with the following operations:

INS — Insert operations
UPD — Update operations, based on the columns selected during the implementation
DEL — Delete operations

MMS_tablename (for example MMS_SP_PARCEL)- this trigger name contains the prefix
MMS_(Munsys Monitor Spatial update) to indicate that the primary function is to log
spatial updates that occurred in the GEOMETRY column. This trigger populates the
MUNSYS_MONITOR_LOG table with spatial updates only. This trigger is only created
if the user selects the option to log spatial updates explicitly when the Lineage is added or
edited. In this case, the SPA (spatial update) operation will be used in the case of a spatial
update.

MARC_tablename (for example MARC_tablename) — this trigger name contains the prefix
MARC_(Munsys Archive columns) to indicate that the primary function is to archive
records. The MARC trigger populates the archive table associated with a spatial table (for
example SP_AD_WATERPIPE) with the archived records. The MARC_tablename trigger
populates the SP_AD_tablename with the operations update or delete (as preferenced when
Lineage is added or edited).
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To add Lineage to a spatial table

1  Select the Spatial Tables branch in the Lineage tree to view spatial tables with triggers already
implemented.

ﬁ |Munsys Management Console (MCITY14INT) — O b4

File Action Help

#-(gP Applications - B SP_WATNOTE ' '
@ Locks -8 SP_WATPIPE Spatial tables with
-85 Query Categories -5y SP_WATRESPIPE triggers implemented
- Securty w-Bgh SP_WATSERV
+- B4 Privilege w-Bfy SP_WATSYM
- Tables/ \Views
=7 Uneage
R, Y5oatial Tables|

“-[E Repors

J Scheduled Tasks

Figure 4 Lineage tree: Spatial Tables

2 To add lineage to a spatial table, select the Add Lineage... option that is displayed when you right
click the Spatial Tables branch of the Lineage tree.

B Munsys Management Console (MCITY14INT) - O X
File  Action Help

7-(8 Applications -8 SP_WATNOTE
+-{3} Locks [+-9g9 SP_WATPIPE
+-35 Query Categories Ifl- SP_WATRESPIPE
+1- &% Security -89 SP_WATSERV
#-BEL Privilege -5 SP_WATSYM
+)-25g Tables/Views
=t Lineage
% mgwm | AddLineage...
\) Scheduled Ta Delete Logs...
Collapse All
Expand All

I

Creates a new lineage on spatial table.

Figure 5 Add Lineage selection

The Add Lineage dialog will appear:
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Add Lineage e

Lineage Details

Table Name: | SP_WATNODE o
Monitor
Log Insert, Update and Delete Operations
Log Spatial Updates Explicitly

Archive
Archive on Update Operations Log Attribute Changes
Archive on Delete Operations

Columns
@ All Columns

O Specfic Columns

o ||t

Figure 6 The Add Lineage dialog box

3 Inthe Table Name drop down of the Add Lineage dialog box, select a table for which Lineage will
be applied. The table selection does not include tables to which Lineage is already applied.

4 Inthe Monitor area, select one or more of the following check boxes (all operations are selected by
default):

Log Insert, Delete and Update Operations — This option logs insert, update and delete
operations. Selecting this option creates the MMA_tablename trigger in the database.

Log Spatial Updates Explicitly — Log Spatial Updates this option logs updates on the
GEOMETRY column as an additional operation. The MMS_ tablename trigger is created,
firing only on the GEOMETRY column when an update occurs. The trigger logs an
operation of SPA (spatial update) in the monitor log.

5 Inthe Archive area, select one or more of the following check boxes (all operations are selected by
default):

Archive on Update Operations — this option archives records that have been updated. The
MARC_tablename trigger will populate the SP_AD_tablename for update operations. The
trigger logs an operation of UPD in the monitor log.

Archive on Delete Operations — this option archives records that have been deleted. The
MARC_tablename trigger will populate the SP_AD_ tablename for delete operations. The

trigger logs an operation of DEL in the monitor log.
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Note

6

Specify the Columns that will be monitored and archived in the Lineage.

All Columns — when this option is selected, all columns will be used, which means that the
trigger is not dependent on the structure of the table. The trigger will also fire on the

GEOMETRY column (for spatial updates). The All Columns option is the default option.

Specific Columns — when this option is selected, the Available Columns and Monitored
Columns lists, as well as their associated options, become available. The arrow options are
used to add or remove columns from the two lists. The columns on which the trigger should
fire are moved from the Available Columns list to the Monitored Columns list, as seen in
the example below. Note that, the GEOMETRY column is not listed as an available column
but the MARC_tablename trigger will automatically fire on this column when a spatial
update is made.

If a new column is added to a spatial table that has Lineage applied, that column will not automatically be
added to the Monitored Columns list. It will have to be manually shifted to from Available Columns list to
the Monitored Columns in the Edit Lineage dialog box. The new column will then be added to the specified
database trigger(s). The column will also automatically be added to the associated archive table.

Click OK.

The spatial table will be added to the Spatial Tables branch of the Lineage tree. The necessary
triggers will also be created in the database to log and archive operations for the selected spatial
table. Triggers will be customised to track Lineage only for selected operations and columns as
defined in the Add Lineage dialog box upon implementation.

H IMunsys Management Console (MCITY14IMNT) — O %

Eile Action Help

{8 Applications 0] SP_WATNOTE
-3 Locks c] % SP_WATPIPE .
+-33 Query Categories () MARC_SP_WATPIPE Triggers on the
+- 8, Securty .. MMA_SP_WATPIPE > SP_WATPIPE table
+ Privilege i () MMS_SP_WATPIPE
+ Tables/Views & SP_WATRESPIPE
= Lineage £ SP_WATSERV
B Spatial Tables -8 SP_WATSYM
i Reports

&1 Scheduled Tasks

Figure 7 Spatial tables and triggers
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Disabling triggers

The current operation status of a trigger is identified by the following prefix symbols:

L)

SP_tablename

) —— Light bulb on (yellow): Enabled trigger

) —— Light bulb off (blue): Disabled trigger

¥ — Light bulb off with redline strike: Invalid trigger

Figure 8

Trigger status symbols

Disabling all triggers on a spatial table

1  To disable all triggers on a spatial table, select the Disable All Triggers option on the context-

sensitive (right-click) menu that is displayed when you right click on a spatial table in the Spatial

Tables branch of the Lineage tree.

H Munsys Management Consaole (MCITY 14INT) O x
File  Action Help

- Applications +-Egp SP_WATNOTE

+- {3 Locks =- : :
+]-83 Query Categories -0 MARC_r Disable All Triggers
4% Security () MMA_ Enable All Triggers
+- &3 Privilege P D MMS_ L

-2 Tables/Views -8 SP_WATR i

=) Lineage |§|. SP_WATS Remove Lineage...

B Spatial Tables -8 SP_WATS P

| Reports ollapse
~) Scheduled Tasks Expand All

Disable all triggers active on spatial table

Figure 9

Disable All Triggers

All triggers for the selected spatial table will be disabled.
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Disabling a selected trigger

1  Todisable only a selected trigger on a spatial table, right click the trigger and select Disable Trigger
on the context-sensitive (right-click) menu.

The selected trigger will be disabled.

ﬁ Munsys Management Console (MCITY14INT) — O 4
File  Action Help
+-( Applications -8 SP_WATNOTE
+- {3 Locks =-9%y SP_WATPIPE
+)-85 Query Categories RO R MARC_SP_WATPIPE
-0y Securty () MMA_SP_WATPIPE | Disable Trigger
8 Priviege -0 MMS_SP_WATPIPE Rebuild Trigger
+- B Tables/Views w-Bg) SP_WATRESPIPE o
=-8g) Lineage -5 SP_WATSERV Recompile Trigger
- Bg Spatial Tables -5y SP_WATSYM
oL Reports Collapse All
“J) Scheduled Tasks Expand All
Disable selected trigger

Figure 10 Disable selected trigger
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Enabling triggers

The current operation status of a trigger is identified by the following prefix symbols:

=B SP_tablename

) —— Light bulb on (yellow): Enabled trigger
) —— Light bulb off (blue): Disabled trigger

¥ — Light bulb off with redline strike: Invalid trigger

Figure 11 Trigger status symbols

Enabling all triggers on a spatial table

1  To enable ALL triggers on a spatial table, select the Enable All Triggers option on the context-
sensitive (right-click) menu that is displayed when you right click on a spatial table in the Spatial

Tables branch of the Lineage tree.

H Munsys Management Consale (MCITY14INT)
File  Action Help
#-(30 Applications 5% SP_WATNOTE
1+ Locks SR~ ¥ SP_WATPIPE
+-35 Query Categories i () MARC_ Disable All Triggers
1&gy Securty 0 MMA ST e ble All Triggers
+ Privilege i L) MMS_S —
+ B Tables/Views B SP_WATRE Edit Lineage...
-1 Lineage [+-Sgp SP_WATSE Remove Lineage..
. B Spatial Tables - E§p SP_WATSY
P Reports Collapse All
‘1) Scheduled Tasks Expand All
Enable all triggers active on spatial table

Figure 12 Enable All Triggers

All triggers for the selected spatial table will be enabled.

Munsys Lineage

2149



Enabling a selected trigger

1

To enable only a selected trigger on a spatial table, select the Enable Trigger option on the context-

sensitive (right-click) menu that is displayed when you right click on a spatial table in the Spatial

Tables branch of the Lineage tree.

The selected trigger will be enabled:

File  Action Help

E IMunsys Management Consele (MCITY14INT)

Enable selected trigger

7-(8 Applications -5 SP_WATNOTE

(5 Locks qg SP_WATPIPE

+1-83 Query Categories -0

-y Securty -0 MMA_SP_WA‘I'F'IPEF Enable Trigger

5 Privilege ‘() MMS_SP_WATPIPE Rebuild Trigger

3B Tables/Views - B SP_WATRESPIPE 3 i

5 Lineage & SP_WATSERV ecompile Trigger
P % Spatial Tables & SP_WATSYM Collapse All

. Reports

) Scheduled Tasks Copl A

Figure 13

Enable selected trigger
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Editing Lineage

1  Toedit the Lineage of a spatial table, select the Edit Lineage... option on the context-sensitive (right-
click) menu that is displayed when you right click on a spatial table in the Spatial Tables branch of
the Lineage tree.

ﬂ Munsys Management Consale (MCITY14INT) - O X
File  Action Help

1)-{g8 Applications -5 SP_WATNOTE

+- @ Locks = ; :

+)-35 Query Categories MARC | Disable All Triggers

- &y Securty Q MMA_S Enable All Triggers

- 83 Privilege Lo ) MMS_S —

B Tables/Views B SP_WATR Pl

=B Lineage 0B SP_WATSE Remove Lineage...
. L-HRp Spatial Tables [+-EFp SP_WATS Colt Al
[ Reports ollapse
“-) Scheduled Tasks Expand All
Edit lineage table settings and triggers
Figure 14 Edit Lineage selection
The Edit Lineage dialog box will appear:
Edit Lineage e
Lineage Details
Table Name: |SP_WATPIPE
Monitor
[ Log Insert, Update and Delete Operations
] Log Spatial Updates Explicitly
Archive
] Archive on Update Operations [ Log Attribute Changes
[ Archive on Delete Operations
Columns
® Al Columns
(O Specfic Columns
COMMENTS ~
DATA_QUALITY
DATA_SOURCE
> END_NODE
GEOM_LENGTH
>
<
<<
v
0 Help

Figure 15  Edit Lineage dialog box
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2  Lineage preferences can be edited for the selected spatial table by selecting the Monitor and
Archive check boxes and specifying the Columns to which Lineage will apply.

3  Click OK to apply any changes.
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Removing Lineage

1  To remove the Lineage of a spatial table, select the Remove Lineage... option on the context-

sensitive (right-click) menu that is displayed when you right click on a spatial table in the Spatial

Tables branch of the Lineage tree.

File  Action Help

H Munsys Management Consale (MCITY 14INT)

+

[F -

(P Applications

Locks
835 Query Categories
. Security
Privilege
Tables/Views
Lineage
-5 Spatial Tables
; Reports

19 Scheduled Tasks

§

3
E3]
=

Remove lineage functionality from spatial table

SP_WATNOTE

SP_WATPIP
() MARC_S

O MMA_SF
@ Mms_SF
SP_WATRE]
SP_WATSEF
SP_WATSYI

Disable All Triggers
Enable All Triggers
Edit Lineage...

Remove Lineage...

Collapse All
Expand All

Figure 16  Remove Lineage

The Remove Lineage Confirmation dialog box will appear.

Remove Lineage Confirmation

Removal Details

["] Remove Monitor Logs

[C] Drop Archive Table

Help

Figure 17

2 Select the check boxes to also remove the monitor logs and associated archive table for the selected

spatial table.

3  Click Remove.

Remove Lineage Confirmation dialog box
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Recompiling triggers

1

To recompile a trigger, select the Recompile Trigger option on the context-sensitive (right-click)
menu that is displayed when you right click on a trigger that belongs to spatial table in the Spatial

Tables branch of the Lineage tree.

This option will recompile the currently selected trigger. This is useful if the structure of the related

table has changed and the trigger needs to be recompiled.

File  Action Help

H IMunsys Management Console (MCITY14INT)

(3 Applications

' Locks

85 Query Categories

2 Security
Privilege
Tables/\Views
Lineage

B8 Spatial Tables

. Reports

: iQ Scheduled Tasks

- - -

Recompile selected trigger

[+-cheg SP_WATNOTE
-8 SP_WATPIPE

(@FMARC_SP_WATPIPE

(@ MMA_SP_WATPIPE
0 MMS_SP_WATPIPE

Disable Trigger
Rebuild Trigger

Recompile Trigger

E3]

-8 SP_WATRESPIPE
- By SP_WATSERV |

SP_WATSYM

Collapse All
Expand All

Figure 18  Recompile selected trigger
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Rebuilding triggers

1

To rebuild a trigger, select the Rebuild Trigger option on the context-sensitive (right-click) menu
that is displayed when you right click on a trigger that belongs to spatial table in the Spatial Tables
branch of the Lineage tree.

Rebuild Trigger will rebuild and compile the trigger and associated views. The trigger will be rebuilt

using the same process as when creating a new trigger.

File  Action Help

H |Munsys Management Console (MCITY 14INT)

- Applications

: Locks

85 Query Categories

. Security
Privilege
Tables/Views

= Lineage

- BF Spatial Tables

- ) ) - -

. Reports
13 Scheduled Tasks

Rebuild selected trigger

i |

RS9 ¥ ARC_SP_WATPIPE

=
3
E3]

SP_WATNOTE
SP_WATPIPE

(@ MMA_SP_WATPIPE
0 MMS_SP_WATPIPE
SP_WATRESPIPE
SP_WATSERV
SP_WATSYM

Disable Trigger

Rebuild Trigger

Recompile Trigger

Collapse All
Expand All

Figure 19 Rebuild selected trigger

Munsys Lineage

2155



Deleting monitor logs

The delete logs function can be used to maintain the amount of records in the

MUNSYS_MONITOR_LOG.

1  To delete monitor logs, select the Delete Logs... option on the context-sensitive (right-click) menu

that is displayed when you right click the Spatial Tables branch of the Lineage tree.

File  Action Help

ﬁ Munsys Management Consale (MCITY14INT)

i3 Applications ®

- Locks

-85 Query Categories
%, Security
Privilege

[} ) ) ) -

Tables/Views I;I :

-

Add Lineage...

3

SP_WATNOTE
SP_WATPIPE

() MARC_SP_WATPIPE
- MMA_SP_WATPIPE
-.() MMS_SP_WATPIPE

SP_WATRESPIPE
SP_WATSERV
WATSYM

Delete Logs...

Collapse All
Expand All

1

Delete existing lineage logs

Figure 20

Spatial Tables: Delete Logs

2 The Delete Logs dialog box will appear:

Delete Logs

Delete Logs
Table
@ Al Tables
O Specfic Table
Operation
[ Insert Update
[ Delete Spatial Update

Date
(® Al Dates
(O Speciic Date
Older than 6 Months
Older than 12 Months
Custom
From: Monday .16 Apnl 2018

To: Monday .16 Aprl 2018

User
® All Users

(O Specific User

Help

Figure 21

The Delete Logs dialog box
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Note  Different options are available to filter the records in this table before they are deleted. Records can be deleted
from specific tables, by specific operations, according to specific dates and by specific user.

3 In the Table area, do one of the following:
Select the All Tables option to delete all the records for all the tables

Select a spatial table name from the Specific Table drop down list to delete records for
a specific spatial table.

4  In the Operation area, select one or more of the following check boxes (all operations are selected
by default):

Insert — deletes all operations of the type INS (Insert)

Delete — deletes all operations of the type DEL (Delete)

Update — deletes all operations of the type UPD (Update)

Spatial Update — deletes all operations of the type SPA (spatial update)

5 Inthe Date area, do one of the following:

Select the All Dates option to delete records from all dates

Select the Specific Date option to apply one of the following date filters:
Older than 6 months — will select logs older than 6 months from the current date.
Older than 12 months — will select logs older than 12 months from the current date.

Custom — specity your own dates by clicking on the calendar drop down and navi-
gating to a desired From and To date. The default From and To dates are set to the current
system date.

Delete Logs X

Delete Logs

Table
@ Al Tables
O Specific Table

Operation

Insert Update
Delete Spatial Update
Date

(O All Dates

® Specific Date

(O Olderthan 6 Morths
(O Olderthan 12 Months

@ Custom

from:  Monday .16 Apil 2018

To Al April 2018 4
Sun Mon Tue Wed Thu Fri Sat
User 1 2 3 a4 s & 7|
(® Al Users 8 5 10 11 12 13 4
15 17 18 19 20 2
2 3 24 5 26 27T 28
29 30 2 3 ! 5
( Today: 2018/04/16

}
I Delete Cancel Help

(O Specific User

Figure 22 Delete Logs: Date Custom
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6  Inthe User area, do one of the following:
Select the All Users option to delete records of all users

To delete records for a specific user, select the Specific User option, and then select a
user from the list.

7  When you have selected all the appropriate filters, click Delete.

8  The Log delete confirmation dialog box is displayed, prompting for confirmation to delete the
records as specified.

Log delete confirmation

o Are you sure you want to delete the selected logs?

Figure 23 The Log Delete Confirmation dialog box

9  Click Yes.
The Logs Deleted dialog box will appear when the selected logs have been successfully deleted.

Logs Deleted X

o Selected logs have been successfully deleted.

Figure 24 The Logs Deleted dialog box

Running reports
Reports can be run to query the database for monitor or usage purposes:

Reports of type Monitor can be used to provide basic or detailed reporting, based on
operation type, user, table name and date of the operation.

Reports of type Usage can be used to show the license usage of the complete range of
Munsys applications, providing the administrator with the necessary records to evaluate the
license usage and detail of users logging on to the Oracle database and using any of the
Munsys applications.

All report queries are stored in the MUNSYS_MONITOR_REPORT table in the database.
Once a report has been run, the results can be saved to a CSV or text file.
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Note

2

The number of records output to the Munsys Management Console display for any of the monitor or usage
reports is limited to 10,000. If any of the reports return more than 10,000 records, a message is produced
indicating that the report process has stopped. The Administrator can continue to execute the report directly

from the database from the SQL command prompt and spool it to a file.

To run a report

Select the Reports branch of the Lineage tree to view the available reports.

A list of Monitor and Usage reports are displayed. The Description field is generally descriptive of

the specific query operation.

ﬂ Munsys Management Console (MCITY14INT) — O X
File Action Help
*T? Applications D Type Description
+- (& Locks ’ -
&-23 Query Categasies i Monitor  Total Number of Records
=.0 Securly 2 Monitor Records for the past 24 Hours
+ ) Privilege 3 Monitor Records for the past Week
+- B Tables/Views 4 Monitor ~ Records for the past Month
- 8 Lineage 5 Monitor  Grouped by Operation
: % Spatial Tables 6 Monitor ~ Grouped by User Name
P Reports 7 Monitor Grouped by Month
. Jj} Scheduled Tasks 8 Monitor Grouped by Table Name
9 Monitor Grouped by Month and Operation
10 Monitor Grouped by Month and User Name
1" Monitor Grouped by Month and Table Name
12 Monitor Grouped by Month, Table Name and Operation
13 Monitor Grouped by Month, Table Name and User Name
14 Monitor Grouped by Table Name, Month and Operation
15 Monitor Grouped by Table Name, Month and User Name
16 Usage Number of unique users per day for the past 12 months
17 Usage Number of applications used per day for the past 12 months
18 Usage Applications used per user for the past 12 months
19 Usage Shared users (users with same name logging on from different machines)
20 Usage Logged on users for the past 24 hours
<

Figure 25

To run a report, right click on an available report and select the Run Report option that appears on

the context-sensitive (right-click) menu.

Lineage Tree: Reports by Type
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Grouped by Month, Table Name and Operation
Grouped by Month, Table Name and User Name

Grouped by Table Name, Month and Operation

E Munsys Management Console (MCITY14INT) - O X
File  Action Help
(3 Applications D Type Description
(-5 Locks 3 Total Number of Recon
= .. Cd N Olal NUmoer o e I—‘
= Quen Categores 2 Montor  Records forthe past 24 Run Report
w1 B Privilege 3 Monitor  Records for the past Edit Report...
BB Tables/Views 4 Monitor  Records forthe past M{ %¢  pelete Report
E| Lineage 5 Monitor Grouped by Operation
6 Monitor  Grouped by User Name
7 Monitor  Grouped by Month
8 Monitor Grouped by Table Name
9 Monitor Grouped by Month and Operation
10 Monitor Grouped by Month and User Name
1 Monitor Grouped by Month and Table Name
Monitor
Manitor
Monitor

15 Monitor Grouped by Table Name, Manth and User Name
16 Usage Number of unique users per day for the past 12 months
17 Usage Number of applications used per day forthe past 12 months
18 Usage Applications used per user for the past 12 months
19 Usage Shared users (users with same name logging on from different machines)
20 Usage Logged on users for the past 24 hours
<
Execute and display report results.

Figure 26 Run Report selection

A dialog box will appear for the selected report displaying the results of the query.

For example, the report dialog box below displays Report Details for the total number of
Records recorded in the MUNSYS_ MONITOR_LOG grouped by each OPEPRATION.

Grouped by Operation

Report Details

Operation

Insert

Spatial

Update

Figure 27 The run report dialog box
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Once the report has been run, the results can be saved.

3  Click Save... to save the results to a folder of your choice. Results can be saved as a CSV or text
file.

Save As

- v » ThisPC » Local Disk(C:) » Munsys14.0 b [¥]

e
Organize v New folder Bz (7]

[&] Pictures +n Mame Date Type Size Tags

@ OneDrive - Open ! @ Munsys 16/11/2020 10:59 AM Microsoft Excel C... 1KB

& ThispC
_§ 3D Objects
& A360 Drive (dgo
[ Desktop
@ Documents
‘ Downloads
J\ Music
[&=] Pictures
B Videos
“am Local Disk (C3)

= ftp (\\197.85.185
v

File name:

Save as type: | £S5V files (*.e5v)

A Hide Folders Cancel

Figure 28  Saving a report
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Editing reports
Reports can be edited to specific user requirements so that only the desired information is
queried from the database.

1  Toeditareport, right click on an available report and select the Edit Report option that appears on
the context-sensitive (right-click) menu.

ﬁ Munsys Management Console (MCITY14INT) — O X
File Action  Help

#-(3 Applications ID Type  Description

+- [ Locks .

3-82 Query Categories 1 Monitor  Total Number of Records Run Report

:+.- B Securty 2 Monitor Records for the past 24 Hours :

o B Poviege 3 Montor Recordsforthepast Wesk || Edit Report.. |
f+.- TablesMews 4 Monitor Records forthe past Month 3 Delete Report

=) Lineage 5 Manitor Grouped by Operation

% Spatial Tables 6 Monitor  Grouped by User Name
i “-[E Reports 7 Monitor  Grouped by Month
1) Scheduled Tasks 8 Monitor ~ Grouped by Table Name
9 Monitor Grouped by Month and Operation

10 Monitor Grouped by Month and User Name
1" Monitor Grouped by Month and Table Name
12 Monitor Grouped by Month, Table Name and Operation
13 Monitor Grouped by Month, Table Name and User Name
14 Monitor Grouped by Table Name, Month and Operation
15 Monitor Grouped by Table Name, Month and User Name
16 Usage Number of unique users per day for the past 12 months
17 Usage Number of applications used per day forthe past 12 months
18 Usage Applications used per user for the past 12 months
19 Usage Shared users (users with same name logging on from different machines)
20 Usage Logged on users for the past 24 hours
< >

Edit existing report

Figure 29  Edit Report selection

The Edit Report dialog box will appear displaying the Report Type, Report Description and
Report SQL (statement) for the current report.
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Edit Report

Report Details

Report Type: . Monitor

Report Description:
Grouped by Operation

Report SQL:

select round(count(”).0) "Records”, decode

(operation, DEL", Delete’, NS’ Insert”, UPD',"Update’,'SPA’,"Spatial) "Operation” from
munsys_monitor_log group by operation order by operation

Figure 30  The Edit Report dialog box

Report Type: Click on the drop down menu to change the report type.

In the Edit Report dialog box, the Report Type, Report Description and Report SQL are editable

Report Description: Click inside the text box to edit or change the report description.

Report SQL: Click inside the text box to edit or change the report SQL statement.

If the Report SQL is modified the statement will need to pass the Validate test before the changes can be
applied in the Edit Report dialog.

Munsys Lineage
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Report SQL:

select round(count(*),0) "Records”, decode

(operation, ' DEL" Delete’, INS"‘Insert’,'UPD’", Update’ 'SPA’'Spatial’) "Operation” from
munsys_monitor_log group by operation order by operation

Figure 31 The Report SQL text box

= Click Validate to test the changes.

If the SQL is valid, the Report Validate Success dialog box will appear.

Report Validate Success

o Report SOL statement is valid.

Figure 32 The Report Validate Success dialog box

= Click OK to return to the Edit Report dialog box.

The Click OK button in the Edit Report dialog box is now active again.

= Click OK in the Edit Report dialog box to apply any SQL statement changes, or continue
making edits in the Edit Report dialog box.
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Adding reports

Reports can be created to query the database according to customised requirements.

1  To add a new report, select the Add Report... option that is displayed when you right click the
Reports branch of the Lineage tree.

ﬁ Munsys Management Console (MCITY14INT) - 0o
File  Action Help
# (@ Applications D Type  Description
+ Locks .
.83 Query Calegories 1 Morfmr Total Number of Records
3-8 Securiy 2 Monitor Records for the past 24 Hours
o Priviege 3 Monitor Records for the past Week
0 B Tables/Views 4 Monitor ~ Reconds for the past Month
=| Lineage 5 Monitor ~ Grouped by Operation
: % Spatial Tables 6 Monitor  Grouped by User Name
Pk itor Grouped by Month
1) Schedu AL LG nior  Grouped by Table Name
Collapse All nitor Grouped by Month and Operation
hitor Grouped by Month and User Name
Expand Al htor  Grouped by Month and Table Name
12 Monitor Grouped by Month, Table Name and Operation
13 Monitor Grouped by Month, Table Name and User Name
14 Monitor Grouped by Table Name, Month and Operation
15 Monitor Grouped by Table Name, Month and User Name
16 Usage Number of unique users per day for the past 12 months
17 Usage Number of applications used per day for the past 12 months
18 Usage Applications used per user for the past 12 months
19 Usage Shared users (users with same name logging on from different machines)
20 Usage Logged on users for the past 24 hours
<
ICreates a new report record
Figure 33 Add Report selection

The Add Report dialog box will appear:

Add Report

Report Details

Report Type:

Report Description:

Report SQL:

Validate

OK Cancel Help

Figure 34

The Add Report dialog box
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In the Report Type drop down of the Add Report dialog box, select a report type or create a new
report type/category by typing in the drop down area.

In the Report Description area, briefly describe the report. For example, “Grouped by Month and
Operation”.

In the Report SQL area, include the SQL statement that will be used to generate the report.

The OK button in the Add Report dialog box will only become available once the Report SQL
statement has passed the Validate text.

Click on the Validate button to test the validity of the SQL statement in the Report SQL field.
If the SQL statement is valid, the Report Validate Success dialog box will appear.

Report Validate Success X

o Report SOL statement is valid.

Figure 35  The Report Validate Success dialog box

Click OK in the Report Validate Success dialog box.
Click OK in the Add Report dialog box to create the report.

The report will appear in the right hand side window when the Reports branch of the Lineage tree
is selected.

Munsys Lineage
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Deleting reports

Reports can be deleted if they are unused or no longer required.

1  To Delete a report, right click on a report and select the Delete Report option that appears on the
context-sensitive (right-click) menu.

ﬂ Munsys Management Censale (MCITY14INT) — O bd
File  Action Help
43 Applications ID Type  Desciption
+-{3 Locks .
583 Query Categories 1 Monitor  Total Number of Records
h-$ Secuty 2 Monitor ~ Records forthe past 24 Hours Run Report
f+.- Privilege 3 Monitor Records for the past Week Edit Report..
) TablesMews 4 Monitor ~ Records for the past Month
B8 Lineage 5  Monlor GroupedbyQperslion [X_ DeleteReport |
i % Spatial Tables 6 Monitor ~ Grouped by User Name
- Reports 7 Monitor Grouped by Month
1) Scheduled Tasks 8 Monitor  Grouped by Table Name
9 Monitor Grouped by Month and Operation
10 Monitor Grouped by Month and User Name
1 Monitor Grouped by Month and Table Name
12 Monitor Grouped by Month, Table Name and Operation
13 Monitor Grouped by Month, Table Name and User Name
14 Monitor Grouped by Table Name, Month and Operation
15 Monitor Grouped by Table Name, Month and User Name
16 Usage Number of unique users per day for the past 12 months
17 Usage Number of applications used per day for the past 12 months
18 Usage Applications used per user for the past 12 months
19 Usage Shared users {users with same name logging on from different machines)
20 Usage Logged on users for the past 24 hours
< >
Delete existing report

Figure 36 Delete Report selection

The Report delete confirmation dialog box will appear:

Report delete confirmation

Are you sure you want to delete report ‘Total Number of
Records'?

T T

2 Click Yes in the Report delete confirmation dialog box to delete the selected report.
The selected report will be deleted.
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Note

Chapter 12
Munsys Scheduled Tasks

Introduction

Munsys allows users to set up and manage regular scheduled database tasks. The scheduled
task will run a Procedure and can pass a range of Parameters with their values (Key / Value
Pairs) to the procedure. Tasks can be scheduled to run on a Daily, Weekly or Monthly basis.

This chapter is divided into the following sections for easy reference:

Adding Scheduled Task
Editing Scheduled Tasks
Deleting Scheduled Tasks

A Schedule Task has been setup to remove all locks on objects which are locked around 1am every morning.
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Adding Scheduled Tasks

Scheduled Tasks can be created to automate the running of regularly scheduled tasks.

Clicking on Scheduled tasks in the Munsys Management Console tree displays existing
scheduled tasks (if any).

ﬁ Munsys Management Console (MCITY14INT) — O b4
File Action Help

o ﬁ;:caﬂm D Description Enabled Schedue Name

e Quer: e 1002 Log Atibute Changes for SP_WATNOTE Y Daily MP_ADLOG_POPUL

o B Cecut 1003  Log Attribute Changes for SP_WATPIPE Y Daily MP_ADLOG_POPUL

o Prviege 1004  Log Attribute Changes for SP_WATRESPIPE Y Daily MP_ADLOG_POPUL

B ToblesViews 1005 Log Attibute Changes for SP_WATSERV Y Daily MP_ADLOG_POPUL

+ Lineage 1006 Log Attribute Changes for SP_WATSYM Y Daily MP_ADLOG_POPUL
< >

Figure 1 Munsys Management Console: Scheduled Tasks

select the Add Scheduled Task...option.

To add a new Scheduled Task right-click on the Scheduled Tasks node in the tree or using the
Action menu or context-sensitive (right-click) menu that is activated when an item is selected and

B3 Munsys Management Consale (MCITY14INT) - | x
File  Action Help
ol fﬂmm D Description Enabled Schedule  Name
. Qw: S 1002 Log Attribute Changes for SP_WATNOTE Y Daily MP_ADLOG_POPUL
3-8 Secuty 1003 Log Attribute Changesfor SP_WATPIPE Y Daily MP_ADLOG_POPUL
o B Prviege 1004 Log Aftrbute Changes for SP_WATRESPIPE Y Daily MP_ADLOG_POPUL
3 B Tables Views 1005 Log Attrbute Changesfor SP_WATSERV Y Daly ~ MP_ADLOG_POPUL
2B Lineage 1006 Log Attribute Changes for SP WATSYM Y Daily MP_ADLOG_POPUL
Add Scheduled Task...
Collapse All
Expand All
IP ,
Figure 2 Add Scheduled Task
The Add Scheduled Task dialog is displayed:
Munsys Scheduled Tasks
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0 N & W

MNew Munsys Scheduled Task *

Scheduled Task

Task Description: |

Scheduled Task Procedures:

Procedure Parameters:

Parameter Name Parameter Value

Modify

Priority: 1 Task Enabled
Schedule
(® Daily () Weekly O Monthly

(o ][

Figure 3 Add Scheduled Task dialog box

In the Scheduled Task Description area, briefly describe the Scheduled Task. For example, ‘Run
Asset Management Update’.

In the Scheduled Task Procedures drop down of the Add Scheduled Task dialog box, select a
Scheduled Task Procedure. These are procedures that are part of the

MUN SCHEDULED TASKS PACKAGE. To add new Scheduled Tasks Procedures this package
must be edited. Please contact Open Spatial before editing the package.

In the Scheduled Task Parameters area, a list of Parameters will be loaded depending on the
selected Procedure. Modify the Parameters to obtain the desired outcome.

Set the Priority Value — 1 is the default value.

If all the values are correct, select the Task Enabled option.

Set the Task interval: Daily, Weekly or Monthly.

Click OK in the Add Scheduled Task dialog box to create the Scheduled Task.
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Editing Scheduled Tasks

Scheduled Tasks can be run to facilitate easy and regular maintenance and management jobs

in Oracle.

1  To edit a Scheduled Task, right click on an available Scheduled Task and select the Edit
Scheduled Task option that appears on the context-sensitive (right-click) menu.

ﬁ IMunsys Management Console (MCITY14INT)

File  Action Help

o . mwﬁm D Description Enabled Schedule  Name
: Quer: Categories Log Attribute Changes for SP_WATNOTE v Diaik,
2.0 Secui 1003  Log Attribute Changes for SP_WATPIPE Add Scheduled Task... _POPUL
8 Privilege 1004  Log Attribute Changes for SP_WATRES | Edit Scheduled Task... | _POPUL
+ Tables/Views 1005 Log Attribute Changes for SP_WATSER _POPUL
5. 08 Lineage 1006 Log Attribute Changes for SP_WATSYM 2  Delete Scheduled Task.. _POPUL
{43 Scheduled Tasks
< >
Edit an existing scheduled task.
Figure 4 Edit Scheduled Task
The Edit Munsys Scheduled Task dialog is displayed:
Edit Munsys Scheduled Task X
Scheduied Task
Task Description: |Log Aftribute Changes for SP_WATNOTE |
Scheduled Task Procedures:
MP_ADLOG_POPULATE ~]
Procedure Parameters:
Parameter Name: Parameter Value
P_TAB_NAME SP_WATNOTE
Modify
Priority: Task Enabled
Schedule
@ Daly (O Weekly (O Monthly
oo | [ i
Figure 5 Edit Munsys Scheduled Task
Munsys Scheduled Tasks
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2 Inthe Edit Scheduled Task dialog box, the Scheduled Task parameters are editable.
= Task Description: Click inside the text box to edit or change the Scheduled Task

description.

= Task Procedure: Click on the drop-down menu to change the Scheduled Task Procedure.

= Procedure Parameters: Click on the parameters and then click Modify to edit or change
the Scheduled Task Parameters.

®  Priority — If more than one Scheduled task is available for a table, this will allow users to
set the order in which the tasks are executed.

m Task Enabled — Allow users to enable or disable a scheduled task.
= Schedule — Allows the task to be run on a Daily, Weekly or Monthly

3 Click OK to save changes to the Edit Scheduled Task.

Deleting Scheduled Tasks

Custom Scheduled Tasks can be deleted if they are unused or no longer required. Some tasks
are managed by other tools with the Munsys application and these cannot be deleted.

1  To Delete a Custom Scheduled Task, right click on a Scheduled Task and select the Delete
Scheduled Task option that appears on the context-sensitive (right-click) menu.

H Munsys Management Console (MCITY14INT) = O X
Eile Action Help
- f? Applications ID Description Enabled Schedule Name
+- A Locks
5132 Query Caiegories 1002 Log Ntme Changes for SP_WATNOTE Add Scheduled Task...
3-8 Security 1003 Log Attribute Changes for SP_WATPIPE Edit Scheduled Task OPUL
2B Piviege 1004 Log Attribute Changesfor SP_WATRESPIf ~ =aft >cheduled Task... OPUL
&) Tables/Views 1005 Log Attribute Changes for SP_WATSERV |x Delete Scheduled Task... EOPUL
3 Lineage 1006 Log Attribute Changes for SP_WATSYM — Ly = =POP UL
-9 Scheduled Tasks
< >
Deletes an existing scheduled task.
Figure 6 Delete Scheduled Task
The Delete Scheduled Task confirmation dialog box will appear:
Munsys Scheduled Tasks
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Delete Scheduled Task

o Are you sure you want to delete the scheduled task: 10077

Deleting the scheduled task cannot be undone.

Figure 7 Delete Scheduled Task notification

If the task you selected to delete cannot be deleted from this dialog, a message will be shown

indicating where to edit that scheduled task.

Delete Scheduled Task - Lineage X

Scheduled task is managed by Lineage and cannot be
deleted.

Please use Lineage to configure this.

Figure 8 Cannot Delete Scheduled Task notification

Munsys Scheduled Tasks
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A
Action menu 2- 7
Add Column dialog box 9- 109
application setting
creating new 4- 37
deleting 4- 40
lookup table for value 4- 38
modifying 4- 39
new 4- 37
application settings, definition 4- 35
application settings, display group 4- 38
applications tree
overview 4- 36, 138
applications tree 4- 35
Assign Role 8- 93
Assigning Table/Views 8- 96

C
change password 2- 9
clearing locks 5- 62, 65
Connect to Database dialog box 2- 8
context-sensitive menu 2- 6, 7
coordinate system code 3- 14
Create Custom Index dialog box 9- 135, 151
create new schema
create a new Munsys Schema 3- 12
data models 2- 11
database extents and coordinate tolerances
3-11
regional information 2- 11
roles 3- 11
schema name and password 3- 11
tablespaces 3- 11
create new schema 3- 11
custom index, creating 9- 135
custom spatial table, creating from existing 9-

104
custom spatial tables, creating 9- 101

D
data files, schema 3- 16
data models
installing 3- 24
roles/privileges 3- 24
data models 3- 15
database extents and tolerances 3- 13
database extents, changing 3- 26
database users, creating 7- 82
database, connecting to 2- 4
Delete privilege, definition 8- 89
drop schema 3- 18
Drop Schema dialog box 3- 18
dump file 3- 19

E
Edit Spatial Table Columns dialog box 9- 110
Enable Record Locking check box 5- 61

exporting a schema 3- 19

F

File menu 2- 8

|

indexes, rebuilding 9- 136

indexes, spatial and lookup tables 9- 134
Insert privilege, definition 8- 89
interface 2- 4

L

links, deleting 9- 127
links, editing 9- 126
locked objects
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unlocking 5- 65
viewing 5- 64
locked objects 5- 60
Locks tree, overview 5- 60
log in with different credentials 2- 9
logging in 2- 8
Lookup Link dialog box 9- 126
Lookup Links dialog box 9- 125
lookup table
creating lookup value 9- 129
creating new 9- 123
deleting from the database 9- 128
dropping 9- 128
lookup table, application setting 4- 38
lookup tables 9- 123
lookup value
deleting 9- 131
modifying 9- 130
Lookup Values dialog box 9- 129, 130, 131

M

Modify Lookup Value dialog box 9- 130
Munsys roles 7- 81

Munsys roles, working with 7- 87
MUNSYS_ADMIN role, definition 7- 81
MUNSYS_ALL_EDIT role, definition 7- 81
MUNSYS_ALL_QUERY role, definition 7- 81
MUNSYS_APP_EDIT role, definition 7- 81
MUNSYS_APP_QUERY role, definition 7- 81
MUNSYS_LICENSE role, definition 7- 81
MUNSYS_POWER role, definition 7- 81
MUNSYS_QUERY_CAT table 6- 69

N

New Application Setting dialog box 4- 37
New Lookup Value dialog box 9- 129
new Munsys role, creating 7- 87

new Munsys user, creating 7- 84

New Query Category dialog box 6- 68

0]
Oracle SRID 3- 14
Oracle SRID, changing 3- 26

P

Privilege tree 8- 90

Privilege, Assign Roles to Tables/Views 8- 90
Privilege, Assign Tables/Views to Roles 8- 90

Q

queries
deleting 6- 76
renaming 6- 76
query categories
changing 6- 72
changing access to 6- 70
copying 6- 73
creating new 6- 68
definition 6- 66
deleting 6- 71
granting access 6- 80
moving 6- 74
removing from role 6- 78
renaming 6- 69
revoking access 6- 80
roles 6- 67
roles/privileges 6- 70
types 6- 66
uncategorized 6- 67
Query Categories tree 6- 67
Query Category Privileges dialog box 6- 80
query category roles 6- 77
query priority
setting 6- 76

R
record lock settings, specifying 5- 61
record locking

definition 5- 59

disabling 5- 61

enabling 5- 61
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Record Locking Detail dialog box 5- 64
Record Locking dialog box 5- 61

record locking properties 5- 61

record locking status reminders 5- 61, 62
regional info 3- 14

Role, assigning to Tables/Views 8- 92
role, dropping from database 7- 88

Role, removing from Tables/Views 8- 94
role, revoking from user 7- 88

S

schema

change properties 3- 26

dropping from the database 3- 18

exporting 3- 19

owner 3- 18
schema database settings, changing 3- 26
schema validation

category 3- 21

errors 3- 21

log 3- 22

test 3- 21
security management, definition 7- 81
Security tree 7- 82
Select privilege, definition 8- 89
spatial table

deleting columns 9- 112

editing columns 9- 108

modifying columns 9- 110
spatial table, dropping 9- 105
spatial table, validating 9- 106
spatial tables

adding columns 9- 108
structure and interface 2-1 5
system model tables 3- 21

T
Table/Views, assigning Roles 8- 96
Table/Views, removing Roles 8- 98
Tables/Views tree

overview 9- 100
Tables/Views tree 9- 99
temporary tablespace 3- 16

U

unlocking locked objects 5- 65
Update privilege, definition 8- 89
User Details dialog box 7- 84
user properties, changing 7- 86
user, dropping existing 7- 87

\Y
Validation Log, spatial table 9- 106
validation, spatial table 9- 106
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